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1 Basic information 

 

  

Welcome to the SAP Enable Now Manager! 

The Manager is your centrally available platform for collaborative content creation and content rollout to learning 
groups. 

It assists you to share the content you created in Producer or Instant Producer easily with other authors, align the 
content production along predefined workflows and based on unified settings available for every author. Thus, 
especially large content scenarios can be produced much more precisely with no need of sending archive file and no 
worries about whether you really have the most recent version of the content.  

Nevertheless, you will need you to know some basic concepts of the Manager for working in a collaboration 
scenario. Please read the chapter basic knowledge before starting with content production to understand what 
permissions are and how versioning will help you in your content creation. 
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1.1 Technical Support 

Please use the SAP Incident Wizard on the SAP Service Marketplace to submit your incidents on the following 
components: 

• KM-SEN // Enable Now 

• KM-SEN-PRO // Enable Now – Producer 

• KM-SEN-IPR // Enable Now – Instant Producer 

• KM-SEN-MGR // Enable Now – Manager 

• KM-SEN-NAV // Enable Now – SAP Companion for desktop 

• KM-SEN-APR // Enable Now – Application Profiles 

• KM-SEN-SMI // Enable Now – Solution Manager Integration 

• KM-SEN-WAC // Enable Now - Author content related SAP Companion issues 

If you are not familiar with the SAP Service Marketplace, read the following information: 

• To access the SAP Support Portal, you need an S-user ID and password. You can request access data from 
your SAP Super Administrator or register online on the SAP Service Marketplace page under ‘Registration‘. 

• With this user, you have read-access to all the contents of the SAP Support Portal, you can use the SAP 
Community Network and SAP Help Portal, and you can also book courses under SAP Education. 

• If you want to work with the support applications (Incident Wizard, license key request, system data 
maintenance, manage remote connections, software download and so on), you need the corresponding 
authorizations, which your SAP Super Administrator can give you. 

• You can find information for new users and about support applications on the Support Portal Homepage 
under "Learn More". There you can also register for a personal overview demonstration of the SAP Support 
Portal. 

• In case of problems with SAP Service Marketplace contact your local Customer Interaction Center.  
An online web form is available here. This web form should be used for all written communication with your 
local Customer Interaction Center. More Details about Incident Processing, Support Addresses and Hotline 
Numbers can be found here. 

 Note 
The Producer diagnosis function can also be used to check the technical data of the installation on your computer 
(version, operating system, browser, etc.). Open Producer and select Diagnosis… over the Help menu. The 
Producer transmits the required information automatically and lists this in a corresponding dialog box. This 
information can also be saved as a text file and sent as an email attachment to SAP Support. 

http://support.sap.com/contactus
http://service.sap.com/sap/support/notes/560499


SAP Enable Now Manager, Cloud Option 
Basic information 

 
 CUSTOMER  7 

 

1.2 Additional Documentation 

You will find further information about SAP Enable Now on: 

  

 
 

SAP Help Portal 

Find the most recent versions of product documentation,  
manuals and guides in the SAP Help Portal. 

 

InfoCenter 

Find interactive training material, best practices,  
conceptual knowledge and more in our Info Center. 

 

SAP Enable Now Community 

Connect with peers and collaborate on in-depth topics, 

find expert content and join our webinars in SAP Enable Now Community. 

 Note 
Some documentation may require you to enter your SAP customer login. 

https://help.sap.com/viewer/p/SAP_ENABLE_NOW
https://enable-now.sap.com/ic/auth/ext/index.html?show=group!GR_F8BA0FC968CD2EB9
https://community.sap.com/topics/enable-now
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1.3 Browser Requirements 

The following browser requirements are to be considered to ensure an error-free use of the Manager interface. 

Browser Version Operating system 

Microsoft Edge 107 Windows 10, 11 

Mozilla Firefox 106 Windows 10, 11 or macOS 12.x 

Google Chrome 107 Windows 10, 11 

  

1.4 Learner Settings 

A few changes are required to the settings of your browser to work perfectly with SAP Enable Now functionalities. 

Independently of your preferred browser the playback functionalities require the following settings: 

Requirement Why? 

Enabled JavaScript 
All functionalities are based on the use of JavaScript. 
You must enable it. 

Deactivated pop-up blocker 

No matter which pop-up blocker you use, you must 
disable the blocking of pop-ups for the location you load 
your contents from. Read browser-specific chapters to 
find instructions on how to disable built-in pop-up 
blocker functionalities. 

Activated cookies 

The attributes and settings for displaying and executing 
library, trainer, and book reader are stored in cookies. 
You should therefore activate cookies in your browser to 
ensure that these functionalities run accurately. 
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1.4.1 Browser Requirements 

Consider the following requirements to ensure that the trainer, library, and book reader functionalities work without 
errors, thereby ensuring that contents are played back successfully. 

Browser Version Operating system 

Microsoft Edge 107 Windows 10, 11 

Mozilla Firefox 106 Windows 10, 11 or macOS 12.x 

Google Chrome 107 Windows 10, 11 

Supported mobile platforms 

Content playback has been tested for the system built-in browsers of the following mobile device platforms. Keep in 
mind that playback on mobile devices usually requires an online connection to published contents (Manager or 
shared network storage). 

Note 
The playback on mobile devices is supported for tablets. 

Platform OS Version Browser 

Apple iOS 15 Safari Mobile 

Google Android 8  
Stock Browser (AOSP) 

(with deactivated Desktop View) 
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1.4.2 Settings for Mozilla Firefox 

The following settings are required for a flawless playback experience in Mozilla Firefox. 

Changes in the settings dialog 

Select the Settings item in the Tools menu in the open browser. Now go to the Content item in the settings dialog to 
see the required options.  

Setting Set to 

Block pop-up windows Deactivate 

Activate JavaScript Activate 

Advanced JavaScript settings 

Select the Advanced button to open Advanced 
JavaScript settings. Activate the following options: 

1. Position window before or after other windows 

2. Hide status bar 

3. Change status bar text 

Settings using about:config 

Additional browser configuration settings are available to you in Firefox. You can access these settings by entering 
about:config in the address bar and confirming with Enter. 
Enter setting name into Search field. A setting can be activated by double-clicking on it. It is then displayed in bold 
text and the value true is set. 
The following settings are to be set to the value true: 

Setting What does it do? 

dom.allow_scripts_to_close_windows  This setting allows browser windows to be closed. 

signed.applets.codebase_principal_support 
This setting displays browser windows in fullscreen 
mode. 

dom.disable_window_open_feature.resizable 
 

This setting prevents the size of an open browser 
window from being changed. 

security.fileuri.strict_origin_policy 
This setting allows links to be executed if an HTML page 
is launched from a local drive. 

Printing the stop page 

To print the stop page of the trainer correctly you have to allow the print of background elements. Go to File -> Page 
setup and activate the setting Print background (Colors and Images). 
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 Note 
• Caused by the settings that have been activated, you will face a security message when starting the library or a 

content in the trainer. Confirm this message with Allow.  
Activate the option Remember this decision so that the security message will not be displayed each time the 
library starts. 

• The default bubble audio effects in simulations and in the book reader actions are in WAV format. A Windows 
Media Player plugin is required in order to be able to play back the files in Firefox. 
You will find further information on the subject at: https://addons.mozilla.org/en-US/firefox/browse/type:7 

1.4.3 Settings for Google Chrome 

The following settings are required for a flawless playback experience in Google Chrome. 

 Note 
The security model of Google Chrome prevents the playback of content from a file system. Content can only be 
played back from a Web server. 

Changing the settings 

Choose the Customize and control Google Chrome button in the open browser. Choose the Settings menu 
entry. Scroll to the bottom of the screen, choose Show advanced settings... and in the Privacy category, choose 
the Content settings... button. 

Setting Set to 

Cookies Allow local data to be set 

JavaScript Allow all sites to run JavaScript 

Pop-ups Allow all sites to show pop-ups 

1.4.4 Settings for Safari 

The following settings are required for a flawless playback experience in Safari. 

Playback settings 

Open the browser's settings dialog using the Edit -> Preferences menu. In this menu, select the Security area and 
apply the following settings: 

Section/Setting Set to 

Security   

Activate JavaScript Activate 

https://addons.mozilla.org/en-US/firefox/browse/type:7
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Section/Setting Set to 

Block pop-up windows Deactivate 

Privacy   

Block cookies From third parties and advertisers 

Printing the stop page (OS X only) 

To print the stop page of the trainer correctly you have to allow the print of background elements. Activate the 
option Print background in print dialog. 

1.4.5 Settings on iPad 

Specific browser settings are required for trouble-free display on an iPad. Tap Settings > Safari to change settings: 

Section/Setting Set to 

Privacy   

Accept Cookies  Always or From visited 

Security   

Block Pop-ups Disable 

 Note 
• To use the trainer, library, and book reader functions on an iPad, you need an active Internet connection with 

access to a central server hosting the published content. 

• Playback performance relies on connection speed. If the connection is too slow, images might not be loaded in 
time. 

1.4.6 Settings on Android Devices 

Specific settings are required for trouble-free display on an Android device. 

Section/Setting Set to 

Keyboard Settings   

Predictive text 
(Name depends on device) 

Avoids an automatic input of text in a text field. 

Disable 
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1.4.7 Settings for e-Mails 
When using the Send Content function of the library it is required that the e-Mail program uses UTF-8 character 
encoding. This prevents incorrect display of the e-Mail text in a specific language. 

Microsoft Outlook 

For Microsoft Outlook UTF-8 can be activated in the Outlook Options: 

Section / Setting Set to 

Advanced -> International options   

Allow UTF-8 support for the mailto: protocol Activate 

1.5 Browser settings for Single sign-on 

To gain browser-sided support of single sign-on functionality you have to adapt your browser settings. Please 
read the instructions for your favorite browser.  

Settings for Mozilla Firefox 

1. Open the advanced browser configuration by entering about:config in the address bar.  

2. Confirm the warning message. 

3. Search for the setting network.negotiate-auth.trusted-uris and add the location of your Manager instance as 
one of the following URL schemes:   

1. Full path to the Manager instance, affecting this instance only: 
https://yourservername_or_ip_address/Manager 

2. For the server, affecting any instance provide by this: https://yourservername_or_ip_address 

3. For the domain the server is part of, including all other servers and instances in it - using wildcards: 
https://*.yourdomain.com  
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2 Basic knowledge 

Working in a collaborative production scenario based on the Manager might be new to you, thus it slightly differs 
from working just by your own on your local machine. Read the following chapters to get an insight into the most 
important things you should know and to be ready for becoming part of a collaborative production scenario. 

Also check out the training materials and tutorials in the SAP Enable Now Info Center to get an understanding of 
basic terminology and best practices for using the Manager in your scenario. 

2.1 Training Available  

 

This content is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

2.2 Collaborative content creation 

 

Editing in a Manager-based environment allows multiple users to edit and create content within a centrally stored 
workarea, the Manager workarea, to which their local running Producer or Instant Producer is connected to. 
Furthermore, this workarea can be maintained and edited from the Manager interface as well. 

https://enable-now.sap.com/ic/auth/ext/index.html?case=documentation&source=manager_manual&show=group!GR_F8BA0FC968CD2EB9#group!GR_16F1B622ADF165AA
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The consistency of the content in the Manager workarea is managed by editing states, which are given to each user 
individually. Once a user started to edit an object, it is locked for all other users. 

Editing states 

The editing state of objects managed by the server is displayed as an additional icon attached to the object icons. 
Hence, by the display of these additional icons you can identify if an object in your workarea is connected to the 
server. 

Three different icons display the current editing state of an object: 

1.  Locked (default): The object is connected to the server and part of the Manager workarea. 

2.  Editing: You started editing mode of the object and are able to modify it. 

3.  Kept for Offline-Editing: You kept the object for offline editing (suppresses automatic finishing of editing). 

4.  Modified: The object has been edited and needs to be saved to the server. 

Notes on the editing state 

Working with server managed objects you should also keep these facts in mind: 

• Location binding: The editing state of an object is not only specific to a user but also the location the user 
started editing from. Hence, you cannot modify an object on your local machine, continue to modify it on 
another one without finish editing it on first machine. 

• Discard of editing states: In case a user starts editing without finishing it for an exceptional time (in case of 
hard drive crash, long sick leave or else) administrative users can discard the editing state for the user 
currently editing the object. As a result of this, the object in the Manager workarea will stay in its last saved 
state and other users will be able to edit it again. In this case, the local modifications made by the user holding 
the discarded editing state cannot be saved to server anymore. 

2.2.1Training Available  

 

This content is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

https://enable-now.sap.com/ic/auth/ext/index.html?case=documentation&source=manager_manual&show=group!GR_F8BA0FC968CD2EB9#group!GR_A6A869EB2A3AD38B
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2.3 Private authoring 

The Manager keeps your work private.  

As long as you are editing content objects in the Manager or in a client desktop application all changes you save 
back to the server are invisible for other authors. Once you are done with editing and you finish editing the object, 
your changes will become visible for other authors.  

This provides you privacy in working on content and using the advantage of steadily saving back your changes to 
the safe server storage without being worried that other authors might misinterpret your current editing state.  

 Recommendation 
In case you want to make your changes visible to other authors while still editing the content, you can save your 
content to the server with activated option Force new version. This will make your changes visible.  

2.4 Version control 
 

 

Editing content in a Manager-based scenario you take advantage of the server-sided version control. This means 
that every time you send modified content to the server a new version of this content will be created, like a 
breakpoint on a time scale. Thus, you can revert to any editing state of the content at any time - worth a lot in case 
your content becomes malfunctioning somehow or you are unsatisfied with the changes you did since last saving. 

But versioning of content provides even more comfort. In case you publish your content directly from the Manager 
itself, you can decide which version is to be published. You can publish one version of your content and proceed 
with editing and saving to server with no worries that the unfinished content may be visible to end users. Once you 
have finished enriching or revising the content, you can publish the most recent version of your content replacing 
the previously published version. 
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Notes 

Keep in mind the following facts on content versioning: 

○ Server-sided publishing of content can be done only once per object 
You can decide which version to publish, but you cannot have two versions of a single object published at the 
same time. 

○ Version control setup parameters 
New content versions are created based on the setup parameters. A new version may not be created every 
time you save content to the server depending on the configuration. By default, a new version is created if: 

○ the time between last content check in and current check in is more than 30 minutes 

○ significant changes have been made to the content itself 

○ you manually force version creation on check in. 

Manual force of version creation 
When saving content to server, independently if from Manager interface or from Producer you can force the 
creation of a new version to ensure your current editing state becomes revertible. 

2.5 Identity management 

 

The Manager uses a hierarchical concept to manage so called identities, a term collecting users as well as groups 
users can be part of. Three kinds of these identities exist: 

1. Organizational units 
An organizational unit (acronym: OU) depicts a part of an organization, mostly a department or a task team. 
With organizational units the whole structure of a company can be depicted, displaying the unique position of 
each user or role within the company. Organizational units can be inherited to each other; thus, each unit can 
contain other subordinated organizational units, roles, or individual users.  
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2. Roles 
A role is a group collecting multiple users and other, subordinated roles with the target to unify the 
permissions assigned to the members of the group. Roles can contain users and other roles but no 
organizational units. 

3. Users 
Users are the smallest identity unit, standing for one individual person each. They can be part of multiple roles 
and single organizational units but they can not contain any subordinated identity items. 

2.5.1 Training Available  

 

This content is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

2.6 Access control 

 

The Manager is a permission-based server application. All application sections and the corresponding 
functionalities to view, modify or delete data are protected by individual (user) permissions. Hence each user needs 
an individual collection of permissions to do what their individual task description requires them to do. 

To simplify the permission management in a multi user environment users with same task requirements are 
collected within roles (user groups) which hold a specific set of permissions. By adding a user to a role, the user 

https://enable-now.sap.com/ic/auth/ext/index.html?case=documentation&source=manager_manual&show=group!GR_F8BA0FC968CD2EB9#group!GR_487D47AC4CA88890
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inherits the permissions assigned to this role, granting the user the same access rights all other members of the 
role have. 

Permissions can be combined 

Each user is an individual end of permission inheritance. Thus, permissions and roles can be individually combined 
to extend the access range of a user. This results in following possibilities on creation of user access levels: 

• each user can be member of multiple roles, granting the user a combination of all permissions provided by all 
roles the user is member of 

• user permission sets can be extended by individually assigned user permissions to allow the user special tasks 
additionally to their permissions set provided by their role membership 

• roles can be inherited to create different user groups owning the same permission level, e.g., you can create 
roles authoring team A and authoring team B as members of the parent role Authors providing you with the 
possibility to create individual teams with different tasks 

User permissions versus workarea permissions 

To differentiate the user access to multiple workareas held by the Manager there is an additional permission gate 
controlling the access to the existing workareas each - the workarea permissions. These permissions control which 
users and roles can access, view, or modify data within each workarea individually. This enables you to run various 
production and learning scenarios within one single Manager instance allowing users to access specific content 
only, e.g., referring to the previously mentioned role inheritance, authoring team A only to first workarea and 
authoring team B to second workarea only. 
 

 Note 
Setting up a production scenario you must specify the workarea permissions for both users and roles. 

2.6.1 Training Available  

 

This content is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

https://enable-now.sap.com/ic/auth/ext/index.html?case=documentation&source=manager_manual&show=group!GR_F8BA0FC968CD2EB9#group!GR_487D47AC4CA88890
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2.7 Workflows 
 

 

Workflows align statuses along a defined object lifecycle and provide the possibility of multiple transitions from one 
status to another, independently of the status order and the direction of the object lifecycle. These transitions 
restrict the possibilities of status changes to a more efficient and logic way. Additionally, transitions provide the 
option to send automatic email notifications to users responsible for its destination status, e.g., a reviewer. 

Using defined workflows will make your production processes more efficient and error-free. Especially in large 
production scenarios with many participating users and a wide range of user task descriptions they will help you to 
avoid timing losses due to missing user information on the next production step and its responsible contacts as well 
as they will enable you to have a detailed overview about the overall production state by forcing according status 
changes. 

Requirements 

The more detailed you plan your needs of Statuses and the more detailed you define the task descriptions for users 
and user groups, the more detailed you can setup workflows. This increases the information flow in your production 
scenario and hence the production overall performance. 

What does a workflow improve? 

Usage of workflows provides more comfort in content production due to the following facts: 

• Forcing of status changes enables a detailed production overview in the status report where you can identify 
problems and "hanging" tasks. 

• The provision of a small set of transitions simplifies the status switch for all users participating in production 
process. 

• The automatic notification to specified users enables each user to quickly react on the need of their 
participation. 
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2.7.1 Training Available 

 

This content is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

2.8 Central content provisioning 

 

The Manager assists you to ensure all authors produce aligned content by using common templates, images, and 
text items. 

How it works 

Create a content structure providing assets for common usage like logos, legally approved images, book page 
templates or else. Mark the groups available for all authors as Must Have (Protocol > Must Have) and save the 
content to the Manager. 

From now on, this structure will be automatically downloaded to the local workarea of each author which connects 
to the Manager. 

What is the benefit? 

Providing common content ensures highly consistent content with minimal file redundancy. Hence less traffic has 
to be transferred as well as e.g., images can be replaced or removed easily in case their legal usage time has ended. 

Furthermore, global content changes to book page templates or company logos can be enrolled with minimum 
efforts. 

Increase the awareness 

To increase the awareness of structures provided this way you can additionally display them as shortcuts on root 
level. Thus, they are visually separated from the content structure (1) and clearly identifiable. 
Just check the option Create Shortcut (Protocol > Create Shortcut) to do so. 

https://enable-now.sap.com/ic/auth/ext/index.html?case=documentation&source=manager_manual&show=group!GR_F8BA0FC968CD2EB9#group!GR_857F492ECDBB85AA
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Manager structures provided as root level shortcuts 

2.8.1 Training Available 

 

This content is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

https://enable-now.sap.com/ic/auth/ext/index.html?case=documentation&source=manager_manual&show=group!GR_F8BA0FC968CD2EB9#group!GR_6FA99C9DCB9DEBF
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2.9 Content distribution 

 

Once you have finished content production, the Manager offers several ways to distribute your published learning 
contents to the learners. Depending on your scenario and your plans about when to involve the learners, the 
following options are available: 

User creation 

The initial method to distribute contents to your learners is a notification e-mail on user creation. Once you create a 
user, an e-mail with the corresponding credentials will be sent out to the user. This notifies the user about the 
availability of a learning scenario on the Manager instance. If assignments have already been set, the learner will see 
them immediately after logging in. 
However, you should note that this notification is only sent when a user has been created manually in the Manager 
interface. Importing user structures by Excel or LDAP import does not send out notification e-mails. 

Messages 

Once you have created contents and assignments, you can use the messages function to notify your users about 
the new learning contents. Just go to Administration > Messages, write a message containing the address of your 
Manager instance and select users, roles, or organizational units as recipients. You can also use this function to 
notify your users about content updates or anything else. 

QR Code 

This function generates QR codes that can be easily read with a suitable reader on a mobile device. This enables 
your users and authors to share content links easily and, moreover, to access learning contents at the exact 
location where the knowledge is required, for example, when they have to use a newly purchased industrial 
machine. Just display the QR code for an object by clicking the QR Code button (top of the object editor displayed 
on the right) or in the relevant course in the learner view. Print it out and stick it on the new machine and every user 
will be able to access the relevant learning contents for the machine on their mobile device. However, you should 
first verify that contents propagated by QR codes have been already published. 
Finally QR codes will assist you as an author to check your contents which you prepared for mobile playback. It is 
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not necessary to type in a long address on the virtual keyboard - simply scan the code and your contents will be 
displayed or played back.  

2.9.1 Training Available 

 

This content is available as interactive training in the SAP Enable Now Info Center. 

Enable Now 

https://enable-now.sap.com/ic/auth/ext/index.html?case=documentation&source=manager_manual&show=group!GR_F8BA0FC968CD2EB9#group!GR_D6E18EDA939D8688
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3 Working with the Manager 

The following chapters describe processes and workflows for configuring the Manager and working in a 
collaborative scenario.  

3.1 First server settings 

Once you have installed the Manager you should initially specify at least some server settings according to the 
needs of your scenario. 

1. Go to Administration > Server Settings. 

2. Specify at least the following settings: 

1. Notifications and Email 
To reduce the mail income of automatically generated emails, clarify which type of automated 
notification might be useful for your scenario and set all other notification types to never. 
An example for reduced, but efficient notification would be as follows: 

1. Notification at assignment > User-defined 

2. Notification at comment > User-defined 

3. All other > never 

2. Security and Passwords 
Apply existent company security policies to the server by modifying the settings for minimum password 
length and mandatory password elements. 

Set the Email address for password recovery: enter an email address users can contact in case of logon 
issues. 

3. General 
Specify or modify at least the following values: 

1. Caching lifetime: starting with the content production you can reduce the caching time to allow the 
authors to approve their content on the server without any delays.  
Note: rolling out the final content to learners we highly recommend increasing the caching time 
again to reduce the server load. 

2. Compress server response: in case you are using protocol HTTP 1.0, please ensure to deactivate 
the gzip option, since it is not supported by this protocol version. 

3. Valid time of a session (s): In case you expect a large number of users we recommend reducing the 
time before session time out to avoid unused sessions unnecessarily filling the server memory. 

3. For detailed information on server settings, see the Server Settings chapter of this guide. 
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 Caution 
We highly recommend not to deactivate the setting Block content access for administrative users in section 
Security since will put your collaboration scenario to the risk that malicious code or files can be run using 
administrative permissions. Nevertheless, we highly recommend to actively scan the base directory continuously 
by a virus scanner to detect and eliminate malicious content. 

3.2 Before you begin to produce 

Before you start with the collaborative content production, we highly recommend planning the details for your 
scenario as exactly as possible. This will help you to simplify setup and configuration of the environment as well as it 
will increase the organization and speed of the content production itself.  

The following questions will help you to plan your scenario and hence to simplify the setup of your environment. 

1. Which requirements do you have for the user management? 
Clarify the question on how many users will participate in your scenario and where you will get the user 
information from. 

2. Which task descriptions do you have in your scenario? 
Identify user relations by their individual task description (e.g., shall they learn, create, or manage?) or their 
membership of different departments. Create user groups based on this information. 

3. Do these groupings interfere with your plans on content creation? 
Maybe you want to create content for more than one scenario, thus the task description of your user groups fit 
in more than one scenario but some users should access one scenario only. 
Split your groups by these scenario differentiations (e.g., Learners A, Learners B,..) and note down the details 
by which these groups should vary. 

4. What are the group task descriptions in detail? 
Identify what each user group shall be able to do in detail and identify single users which might have additional 
tasks. Use the user permissions of the Manager to determine the variations between those groups. See 
chapter Permissions. 

5. How the scenario shall be accessed? 
Specify the details on the location of users they are accessing the scenario from to identify possibly necessary 
additional security settings (e.g., IP range restriction), configuration needs (e.g., Single Sign-on or SSL 
encryption / https) and exceptions (e.g., external employees eventually facing certificate issues or self-
registering users). 

6. Which requirements do you have for the content creation? 
Which types of meta information you will need to accurately watch the production process at any time and to 
straighten the content lifecycle from creation until rollout. The Manager provides several meta information 
types like status, milestones, task types and priorities to assist you in your content production. Furthermore, 
you can define specific workflows depicting the individual lifecycle of content objects and automatically 
notifying the according users responsible for specific lifecycle sections (e.g., review or translation). 

7. Are there content requirements strongly varying? 
A workarea centrally provided by the Manager unifies the playback and recording settings for all connected 
users. In case you identify multiple content requirements varying strongly in questions like recording sizes, 



SAP Enable Now Manager, Cloud Option 
Working with the Manager 

 
 CUSTOMER  27 

 

templates or even availability for authoring teams (e.g., for confidential content) you should think about 
creating separate workareas on your instance. 

8. How the finalized content shall be rolled out? 
Identify the needs you have for rolling out the content to learners. Think about the best size of courses to gain 
best training success. Also determine if the learning progress of users shall be tracked for reporting 
possibilities. Keep in mind, that tracking even will help you to determine not well formed trainings 
and resulting loss of learning performance, hence it provides an inactive learner feedback. 

3.2.1 Build up user structure 

The user structure can be built up in slightly different ways. See the following questions to determine the way best 
fitting to your needs.  

1. How users shall be created and updated? 
Manual creation of users should be an exception for single user creation needs.  
Rather users should be imported using a source to be used for future user creation and profile updates. 
The Manager provides the possibility to import user profiles from an existing Active Directory server, 
managing your companies user structure, or via Microsoft Excel file in case your identity management is 
based on another user service or such an option doesn't exist. 
Please refer to the Operations Guide for detailed information on the user import functionality and the 
necessary configurations. 

2. How many user groups did you identify and how detailed do they vary? 
In case you already own an organizational structure, depicting organizational units and user roles, you can use 
this structure even within the Manager.  
The Manager comes up with pre-defined roles you should use to create your roles from or to apply their 
permission set on organizational units and imported roles. This simplifies the permission management a lot, 
thus you just have to add individual permissions to roles inheriting their base set of permissions from one of 
the default roles. 

3.2.1.1 Create roles 

Since the role concept of the Manager is based on inheritance we highly recommend using the default roles the 
Manager comes with as a base for your role concept. This simplifies the permission management extremely, thus 
you just have to add single permissions individually to extend the task range of a role. 

Creating a role manually 

To create a new role, follow these steps:  

1. Open the role management interface under Administration > Roles. 

2. In the Selection area expand the tree by clicking the arrow symbol prepended to each organizational unit. 

3. Select the organizational unit the new role shall be created in. 

4. Within Quick add enter the desired name for the new role into the mandatory field Name. 
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5. Optionally enter a 4-10 digit registration code the role will be available by for the self-registration feature. Find 
out more in the chapter Self-registration 

6. Click on the Add button. 

7. The new role appears in the roles list. 

Inheriting permissions from role 

To use an already defined set of permissions for a manually created or imported role proceed as follows: 

1. In the Selection area select the organizational unit the parental role is located in. In case the parental role shall 
be one of the Manager default roles, select the organizational unit root > system. 

2. Select the parental role in the roles list. 

3. Click Add.... 

4. In the dialog, select the organizational unit the role you want to append is located in. If you are sure the name 
of the role is unique you can also select root. 

5. Type in the name of the role into the text field of the Filter. 

6. Click Search. Alternatively, you can click show all to display all identities in the selected organizational unit. 

7. Select the role to be append. 

8. Click Save. 

9. The role appears in the membership list of the parental role and by now owns the same permission set. 

3.2.1.2 Create Organizational Units 

You can depict your organizational structure by creating organizational units your users are located in. These 
organizational units can be nested into each other in any depth of levels. 

Nevertheless, we highly recommend using the user import functionality to import existing organizational 
structures. Manual creation of organizational should be exceptional, e.g., to create a container for self-registration 
the users are located in. 

Creating an organizational unit 

To create a new organizational unit, follow these steps:  

1. Open the management interface under Administration > Organizational Units. 

2. In the Selection area expand the tree by clicking the arrow symbol prepended to each organizational unit. 

3. Select the organizational unit the new role shall be created in. 

4. Within Quick add enter the desired name for the new organizational unit into the mandatory field Name. 

5. Optionally enter a 4-10 digit registration code the organizational unit will be available by for the self-
registration feature. Find out more in the chapter Self-registration. 

6. Click on the Add button. 

7. The new role appears in the roles list. 
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3.2.1.3 Create users manually 

Manual user creation allows you to quickly add individual user profiles to the Manager. Nevertheless, manual 
creation should be exceptional in addition to the user import functionality, e.g., for testing purpose or in case some 
users need a secondary account when splitting between content access and administration permissions has been 
activated. 

Note, that manually created user accounts are not capable to use Single sign-on. 

Creating a user account 

To create a new role, follow these steps:  

1. Open the user management interface under Administration > User. 

2. In the Selection area expand the tree by clicking the arrow symbol prepended to each organizational unit. 

3. Select the organizational unit the new user shall be created in. 

4. Within Quick add enter at least the mandatory Logon ID, the email address of the user (necessary for 
automated mail sending) and a password matching your password security settings. 

5. Select the roles the user shall be member of in the dropdown Roles. 

6. Click on the Add button. 

7. The new user appears in the user list. If a valid email address has been provided the user will receive an 
automated activation mail containing the path to the Manager and individual credentials. 

 Note 
The automatic sending of an activation mail requires you to have a valid email address set for your own user 
profile.  

3.2.1.4 Self-registration of users 

The Manager has the functionality to let users register themselves with a code you have provided them with. With 
this code the user will be assigned automatically to a certain role and a certain organizational unit. 

Notes 

• Do not use roles or organizational units imported by LDAP for self-registration. 

• Self-registered users are not capable of using Single sign-on. 

• Self-registration codes provide registration for a single role only.  
Additional memberships have to be applied manually later on. 

Preparing self-registration 

Follow these steps to build up a self-registration scenario: 

1. Open the organizational units management interface under Administration > Organizational Units. 

2. In Quick add enter the Name for the organizational unit the users shall be auto-assigned to. 

3. Enter an individual code with 4-10 characters (digits or capital letters only) into the field Registration-Code. 
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4. Click Add. 

5. Repeat steps for multiple self-registration based organizational units.  

6. Now open the roles management interface under Administration > Roles. 

7. In Quick add enter the Name for the role the users shall be auto-assigned to. 

8. Enter an individual code with 4-10 characters (digits or capital letters only) into the field Registration-Code. 

9. Click Add. 

10. Repeat steps for multiple self-registration based roles. 

To use existing organizational units or roles just modify its property Registration-Code. 

Providing registration codes 

Follow these steps to enable user to self-register themselves: 

1. Go to Administration > Registration-Codes. 

2. In the table search the intersection of according role (columns) and according organizational unit (rows). The 
code at this intersection represents the self-registration scenario you need. 

3. Copy the full code (displayed as ORGUNIT - ROLE) and provide it, together with a link to the logon page of the 
Manager, to users, who shall register themselves for according role and organizational unit. 

3.2.1.5 Assign users to a role 

Once you have created all necessary identities you will have to assign users or (imported) roles to the Manager 
roles.  

Adding users to roles  

Proceed as follows to add identities to a role: 

1. Open the role management interface under Administration > Roles. 

2. Select the role you want to add identities to from the roles list. 

3. Click Add... right below the members list. 

4. In the dialog, select the organizational unit the identities are located in. Alternatively, you can also select root. 

5. Click show all next to the Filter or type in a search phrase matching one or more identities and click Search. 

6. Select one or multiple identities (hold CTRL for multiple selection). 

7. Click Save. 

8. The identities appear in the members list of the role. 

3.2.1.6 Allow content access for administrative users 

By default, the server setting Block content access for administrative users prevents users with any administrative 
permission from viewing or editing content. This is necessary to avoid these users running malicious code or 
uploading files to the server.  
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How can administrative users edit content? 

In case users with administrative permissions need to view or edit content, it is required to create an individual 
secondary user account without any administrative permission. 

For editing these users have to logout and use the secondary credentials to logon. 

See chapter Create users manually for steps to create a secondary user account manually. 

 Caution 
We highly recommend not to deactivate the setting Block content access for administrative users to grant affected 
users access to content. It will put your collaboration scenario to the risk that malicious code or files can be run 
using administrative permissions. Nevertheless, we highly recommend to actively scan the base directory 
continuously by a virus scanner to detect and eliminate malicious content. 

3.2.2 Create workflows 

Workflows assist you in the content production process, hence they pretend a sequence of statuses defining 
different states of the content lifecycle. Additionally, they pretend which users are allowed to change the content 
lifecycle and can automatically notify users responsible for the next period. 

Creating a workflow 

Proceed as follows to create one or multiple workflows: 

1. Open the workflow management interface under Administration > Workflows. 

2. Within Quick Add enter a conclusive Name and optionally a brief Description. 

3. Click Add. 

4. Repeat steps in case you want to create multiple workflows. 

Adding steps to a workflow 

Newly created workflows are empty. You need to add steps defining different lifecycle periods and the transitions 
between these steps. To simplify the creation of nested workflows with multiple transitions we highly recommend 
the usage of the graphical workflow editor as it will be described in the following steps. 

Proceed as follows to add steps: 

1. Move your mouse cursor above the workflow you want to modify. 

2. Click the action link edit graphically in the last column. 

3. Within Quick add select the first status of your planned content lifecycle from the dropdown Status. 

4. Click Add. 

5. A visual box appears displaying the name of the status. 

6. Repeat steps 3 - 5 in the same sequence the statuses shall accompany the content lifecycle. 

7. Now you will have multiple status boxes depicting the content lifecycle from left to right. 

Now you can add transitions between the status boxes. These can be specified as skipping many statuses in 
between as well as moving along the lifecycle or opposite to. 
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Proceed as follows to specify the transitions: 

1. Click the status box the transition shall start from. 

2. Click the destination status box the transition shall jump to. 

3. A new transition appears displayed as yellow box with arrows displaying the direction of the transition. 

4. Click the transition box. 

5. Enter a conclusive transition name into the appearing prompt. 

6. Click OK. 

7. Repeat these steps for each transition you need. 

8. After you have defined all transitions for your workflow, click save changes. 

9. Click back to go back to the workflow management interface. 

To create duplicate transitions to be used for another team select the same start status and the same destination 
status as before. You can define as many parallel transitions as you require. Consider naming the transitions 
according to their purpose. 

Refining the transitions 

Once you have graphically created the workflow as best for your purposes, you still need to set the properties for 
each transition. 

Proceed as follows to refine the transitions: 

1. Click the workflow list item you want to modify. 

2. The workflow appears as flat list displaying the defined statuses and transitions. 

3. Click the first transition entry in column Transitions. 

4. In the dialog box you now can edit the transition properties. 

5. For better identification enter a brief description. 

6. Click Edit... at the Permissions field. 

7. Expand the identity tree in the Selection area or enter a search phrase into the Filter field and click Search. 

8. Select one or multiple identities (hold CTRL for multiple selection) who shall have permission to see and 
trigger the transition. 

9. Click Add. 

10. Having added all identities to the Identities area, click OK to confirm your selection. 

11. Optionally you can specify identities to be notified automatically when a transition has been triggered. 

12. Click Edit at the Watchers field. 

13. Add the identities the same way as you did for Permissions (steps 7 - 10). 

14. If the transition defines a final step in your content production, activating the option Publish Content will 
publish the content automatically in this workflow transition. 

15. Click OK to confirm your transition modifications. 

16. Repeat these steps for each transition you have created. 

 Note 
A workflow owning transitions with no or less then minimum required properties is handled as invalid. Hence it 
won't be displayed in any workflow selection or task (if already assigned). 
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3.2.3 Prepare workareas 

Each workarea on the Manager owns an individual set of workarea permissions controlling the user access, 
independently from the user permissions a user owns. Thus, you mandatory have to specify at least these access 
permissions for each workarea to make them available at least for the according authors as well as for individual 
learner groups. The setup of Tags, Watchers and Workflows is optional. 

Creating workareas 

Proceed as follows to create one or multiple workareas: 

1. Open the workarea management interface under Administration > Workareas / Tags. 

2. Enter a conclusive workarea name into Quick Add > Name. 

3. Enter an according id into Quick Add > ID. We recommend using a conclusive acronym of the name excluding 
spaces. 

4. Click Add. 

5. The workarea will be created and added to the workarea list. 

6. Repeat these steps in case you want to create multiple workareas. 

Setting workarea permissions 

Initially only you as the creator of the workarea will have full access to the workarea, whereas every user has read 
access to published contents from the workarea by default. 
Proceed as follows to specify authors and learners the workarea will be available for: 

1. Click the link Permissions in the column Actions: Workarea of the workarea you want to modify. 

2. Optional: In case that not every user shall be able to see published content from the workarea, select the 
identity root in the Selection area. Then click Remove. 

3. Click Add. 

4. In the Identity Selection dialog expand the identity tree until you see the identities you want to add.  
Alternatively, you can enter a matching phrase into the Filter and click Search. 

5. Select one or multiple identities to be added (hold CTRL for multiple selection). 

6. Click Select. 

7. Now select a newly added identity in the Selection area. 

8. Select allow for the according permission level in the Permissions area. Note that workarea permissions are 
interdependent in displayed order. Thus, you just need to select Create, Edit and Delete Content to apply View 
All Content and View Published Content as well. 

9. Repeat steps 7 - 8 for other newly added identities. 

10. Click OK. 

Specifying workarea tags 

Tags will help you to mark unique object versions as a state fulfilling special content requirements. Thus, they 
simplify to allocate this version within multiple versions of an object. Furthermore, you can display the whole 
workarea depicting the content at this state. 
Proceed as follows to create workarea tags: 
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1. Click the link Add Tag... in column Tags of the workarea you want the tag to add to. 

2. Enter a unique ID for the tag. This will be used internally. 

3. Enter a conclusive Name for the tag. It should be unique in the workarea as well. 

4. Enter a short Description for better identification of the purpose of the tag. 

5. Click Save. 

6. Repeat steps to create multiple tags. 

Setting default workflow for a workarea 

In case you created one or multiple workflows assisting you production scenario you can specify a default workflow 
for the workarea. This will be automatically set for each new content object to be created in this workarea. 

Proceed as follows to set the default workflow: 

1. Click the link Workflow... in the column Actions: Workarea of the workarea you want to modify. 

2. Select a workflow from the dropdown list. 

3. Click OK. 

Note that only valid workflows are listed in the dropdown. If you miss the workflow you want to set, go to 
Administration > Workflow and check the workflow for issues. 

3.2.3.1 Connect workareas 

To optimize the global distribution of content rolled out from within one workarea, workareas from different servers 
can be connected to provide the content to users from a faster local instance. 

One workarea serves here as the usual place of content creation (base), whereas on one or multiple other servers a 
connected workarea can be created which regularly synchronize the structure with this base workarea.  
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Setting up connected workareas 

Firstly, you have to ensure to have activated the according server setting. If you do not have sufficient permissions 
to do so, get in contact with the administrator of your installation. 

Having this setting activated you will see the new button Connect in the upper right corner of the workarea 
administration under Administration > Workareas / Tags. 

Proceed now as follows: 

1. Click the button to open the connection dialog. 

2. In the connection dialog enter the parameters as following:   

Name* 
Enter a meaningful name by which the connected 
workarea will be displayed in your instance. 

ID* 
Enter an ID to be used in your instance. 
Note: Ensure that this ID does not already exist in your 
instance. 

URL* 

Enter the direct path to the workarea of the instance 
you want to connect to, like 
http(s)://<host>/<instance>/wa/<wa 
ID>/~tag/published/ 

Note: Ensure to use the published content only. 

Proxy URL 
If you need to bypass the connection via a proxy, enter 
the correct proxy address. 

Proxy Port Enter the port number of the proxy server. 

Username 

Enter the username to be used for connection. 
Note:- the user must be a local created user on the 
instance to connect to 
- the user must have at least workarea permission View 
workarea for the workarea to connect to 
- the user must have given consent to the privacy 
policy if the data protection feature is activated on the 
instance to connect to 

Password 

Enter the according password for the 
user.Note: consider password expiration settings on 
the instance to connect to (Administration > Server 
Settings > Security) 

3. Having connected successfully a new workarea list entry appears with the specified name and ID. 

It can be identified as connected workarea by the  banner next to it. 

In the Workareas menu dropdown it will have a same colored indicator. 
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Force fetching of meta data 

In case you want to force a fetch of the meta data from the workarea your connected workarea uses as source, 
independently from the synchronization time specified in the Server Settings, you can click the action link Fetch 
Metadata located in the workarea actions column of your connected workarea list entry. 

What to keep in mind 

• Connected workareas are to be understood as local caching workareas of another remote workarea. 

• The contents within a connected workarea cannot be edited. All editing functionalities are disabled. 

• On synchronization with the remote workarea the connected workarea only fetches the meta data, no files. 
Files are loaded from the remote workarea on first request in between two synchronization points and then 
cached until next synchronization happens. If the content in the remote workarea is not updated in short 
intervals it is highly recommended to increase the synchronization time range in the server settings to an 
appropriate value, for example to 10080 for a weekly synchronization. 

• If there are synchronization issues, you will see a warning sign next to the workarea name. The tooltip of the 
warning sign will give you more details of the error. 

3.2.3.2 Reuse content from other workareas 

To support content alignment between workareas, the workarea extensibility functionality enables you to reuse the 
content from another workarea of your instance in your workarea. As soon as you have selected a base workarea to 
get contents from, the whole content including resources will be available in your workarea as well. You can reuse 
the content from one workarea in as many workareas as you want. 

This enables you to align several workareas in use by reusing templates, resources, toolbox content in all of them 
based on one single workarea where you make you changes. These changes will be directly available in the other 
workareas as well. 

How to customize 

In case you need customizations in a workarea using extensibility, you can simply use the button Fetch data located 
at the position of the Start Editing button. Afterwards you can edit the object as usually. 

Note: Once you fetch an object from an extended workarea, it becomes a local part of the workarea you are in. It 
won't be synchronized anymore thus changes in the base workarea won't take effect in your workarea. 
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Setting up workarea extensibility 

Activated the respective server setting. If you do not have sufficient permissions to do so, get in contact with the 
administrator of your installation. 

1. Having this setting activated go to the workarea administration under Administration > Workareas / Tags. 

2. Click Edit for the workarea you want to have the extensibility for. 

3. Expand the now displayed dropdown for the property Base Workarea and select the workarea you want to 
reuse the data from. 

4. Click Ok. 

You workarea list entry will now have the  banner next to it. 

In the Workareas menu dropdown it will have a same colored indicator. 

What to keep in mind 

• The content of the base workarea is added to the workarea you selected it for. No existing content of the 
workarea will be deleted or affected by. 

• Thus, you will find the content root of the base workarea initially in the workarea node Unsorted. 

• To revert an edited and thus locally recreated object which formerly has been part of the extended workarea, 
you just need to delete it. Right after deletion the original object from the extended workarea will be available 
again. 

• To use the resources from the base workarea you have to delete your existing resources in your current 
workarea. 
To do so, select the root node Resources and click Delete Tree. 

• If there are synchronization issues, you will see a warning sign next to the workarea name. The tooltip of the 
warning sign will give you more details of the error. 
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3.2.3.3 Connect and reuse workareas 

By combining the workarea connection and the workarea extensibility scenario you can simply distribute and align 
the content of multiple workareas on multiple instances in a global context. Just create use one master workarea, 
create on each instance a connected workarea and use this connected workarea as extended for all your other 
workareas in this instance.  

This brings up multiple benefits: 

• you can ensure that each scenario will use your styles, your templates, your design and else needed from one 
master workarea to be configured. 

• updates on this master content are rolled out to all workareas automatically without the need to send archive 
files around 

• newly added content is distributed automatically as well 

 

3.2.4 Prepare structure 

The Manager enables you to create objects directly in the browser interface without using the Producer. Thus, you 
can prepare your content scenario by building up the structure in more or less detailed level and assign branches 
to different authors or authoring teams to be filled and enriched.  

See chapters Create objects and Assign objects for information on object creation and assignment. 

Why should you do this? 

Assigning newly created structures enables your authors to download only the content structures they need to 
process (by using the Producer menu item Check Out Assigned Objects or automatically on startup in the Instant 
Producer). 
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3.3 Begin to produce content 

3.3.1 Create and edit objects in the Manager interface 

3.3.1.1 Create objects 

The Manager enables you to create objects directly in the browser interface without using the Producer. Thus, you 
can prepare your content scenario by building up the structure in more or less detailed level. 

Creating objects 

To create new objects, you first have to select an object new object shall be added to. In a new workarea this would 
be the root group of your workarea.  

1. Click Start editing to switch the object to editing mode. 

2. Now click New... and select the object you want to create from the dropdown (see notes below for object type 
dependencies). 

3. A dialog appears in which you can specify the Name of the new object and optional, type-specific properties. 
The following two properties are common for each type (but not file assets): 

1. Workflow 
Set an individual object workflow. If you don't do and a default workflow has been set for the workarea, 
the default workflow will be assigned automatically. 

2. Recommended synchronization 
Specify the synchronization mode to be used automatically when the object is downloaded into a local 
Producer workarea. Use Read only for template structures or else to be modified only by you or few 
users. 

4. In case you want to create a file asset, click Browse... to select and upload a file. See supported file types in 
Notes below. 

5. Click OK / Upload to create the new object. It will be attached as last child item of the child objects. 

Notes 

Each object you create is automatically set to the language you selected for the Manager interface. 

The following objects can be created: 

• Group  

• Project (empty, without indicating the project type)  

• Book  

• Book Page 

• Text Unit  

• New file assets (using uploads)  

The available object types vary by their ability to have subordinated objects. The following matrix displays which 
object type (by row) can have which object types as children (by columns). 
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>> Group Book Book Page Project Text unit File asset 

Group       

Book       

Book Page       

Project       

Text unit       

The following file extensions are supported for file upload: 
Documents: doc, docx, dot, dotx, pdf, rtf, html, ppt, pptx, pot, potx, xls, xlsx 
Project content: js, dnt 
Images: bmp, gif, png, jpg, jpeg, tif, tiff 
Audio: wav, mp3, wma 
Video: avi, mov, wmv, swf, rm, mpg, mpeg 
 

3.3.1.2 Edit objects 

The Manager enables you to edit and save book pages directly in the browser interface without using the Producer 
or Instant Producer. 

Editing objects 

You first have to select the according book page.  

1. Click Start editing to switch the object to editing mode. 

2. Now click Edit.... 

3. The Book-Page-Editor will open enabling you to edit the book page. 

Notes 

Web-Editors are available for the following object types: 

• Book Page 
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3.3.2 Create and edit objects using cloud applications 

To start cloud applications from within the Manager interface, proceed as follows: 

1. Logon to the Manager 

2. Select the workarea you want to work with from menu item Workareas. 

1. To start the Producer, click the according link below the menu bar. 

2. To start the Instant Producer, click the according link below the menu bar. 

3. To record content for an empty project, start editing the project and click Record. 

Note 
Starting SAP Enable Now 2211, recording of web pages is done using the new Web Recording functionality. For it to 
work correctly, the latest version of Enablement Assistant browser extension is needed, and it should be visible in 
the browser toolbar to control the recording.  
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3.3.3 Create and edit objects using direct recording 

To start recording directly from within the Manager interface proceed as follows: 

1. Logon to the Manager 

2. Select the workarea you want to work with from menu item Workareas. 

1. To start the Instant Producer, click the according link below the menu bar. 

2. To record content for an empty project, start editing the project and click Record. 

 

Note 
Starting SAP Enable Now 2211, recording of web pages is done using the new Web Recording functionality. For it to 
work correctly, the latest version of Enablement Assistant browser extension is needed, and it should be visible in 
the browser toolbar to control the recording.  
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3.4 While you produce content 
Working in a collaboration environment you should keep a few things in mind to avoid unnecessary delays for other 
users involved in content production. 

1. Finish editing after work 
Keep in mind to finish editing objects after your work, thus they can be edit by other authors, who are in need 
to. 

2. Start editing only objects you really edit 
Do not start editing whole content branches for editing a few objects only. This blocks editing access for all 
other authors. In case you need to start editing objects for move or delete operations consider finishing 
editing these objects directly after you did what you needed to do. 

3. Comment your work 
When you save, finish, or assign objects we recommend that you write a short comment into the comment 
field, depicting your changes or the need of additional editing steps to be done. This simplifies the 
identification of object states for all users. 

4. Use statuses or workflows 
When you assign a correct status to an object, whether manually or automatically by a workflow, the overall 
overview of the content production scenario will be much more detailed. So the responsible production leads 
know at any time how the production develops and can react in case the production stumbles somewhere. 

5. Assign objects 
Assigning objects to other authors frees you from creating and sending additional mail instructions, thus the 
user you assigned to will automatically receive a notification mail with the object name, your 
optional comment, and a direct link to access the object. 

3.4.1 Assign objects 
Object assignment is an essential feature in a collaboration environment. It enables you to delegate object tasks as 
well as to handover object editing for further processing. 

Assigning objects 

Proceed as follows: 

1. Select an object in the object tree. 

2. Click tab Tasks. 

3. Expand the dropdown Assigned to. 

4. Select the user the object shall be assigned to. 

5. Click Save in the right top corner of the tab area. 

6. Optionally change Status in the Save dialog. 

7. Ideally write a short Comment about the reason for the assignment. 

8. If you currently edit the object, activate the Finish editing checkbox. 

9. Click Save. 

The user you assigned the object to will now receive an automated mail notifying about the object has been 
assigned to him. 
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3.4.2 Move objects 

 

Use drag & drop to move objects and rearrange your object tree.  

Notes 

Due to the availability of editing modes consider the following facts for moving object: 

• Before moving start editing the target object you want to move an object to. 

• Start editing the parental object of the object you want to move. 

• Editing mode for the object to be moved is not necessary. 

Moving an object 

1. Click the object you want to move once. Release the mouse button after clicking.  

2. Click the object again and hold the mouse button pressed (1).  

3. Move the object to the target position.  
A small arrow symbol appears beside the cursor displaying where you can drop the object (2) or not (3). 

3.4.3 Restore editing mode 

In some cases, it might happen that you need to restore the editing mode of an object, for example in case it has 
been started editing by a user, but the local device of this user faces a hard disk crash. In such a case the object is 
locked for any further processing since it is still marked on server as being edit by the user. 

Notes 

Consider the restore of an objects' editing mode as a critical step. If you do, all property and content changes which 
have been made to the object and which have not been committed to the server will get lost and the object will be 
reset to the last saved state. Objects which have been attached before commit will be moved into Unsorted objects 
(if they have been committed to the server already). 
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Restoring editing mode 

Proceed as follows to make an object available again for editing: 

1. Select the according object in the object tree. 

2. Click Restore WT as displayed instead of Start editing / Finish editing. 

3. Confirm the warning message. 

The object is available again for editing. In case the user who edit the object at this time synchronizes his workarea 
or tries to commit changes to the server, he will face an error message and the content will be reset to the current 
state on server. 

3.4.4 Revert to a previous object version 

You can revert an object to an earlier saved version undoing all changes made afterwards. 

Reverting to an earlier object version 

Proceed as follows: 

1. Select the object to be reverted. 

2. Click the dropdown arrow next to publish (right above the Start editing / Finish editing button). 

3. Select Versions / Tags. 

4. In the dialog click revert version for the version you want to revert to.  
If you are unsure, if this is the correct version, click show version instead. The object will be displayed as it has 
been saved in this version. Proceed with step 2. 

A new most recent version will be created with the properties of the version you selected for revert. You can now 
proceed to modify the object from this state on. 

3.4.5 Filter for specific objects 
You can filter the object tree for objects matching a specific criteria or criteria selection. This enables you to easily 
find objects you are searching for using simple Search or extended Filter criteria. 

Simple search 

To search for specific term, fully or partially matching, enter the search term into the field Search and hit return. 
Consider that no wildcards are supported. 

Filtering 

To search for objects matching multiple criteria proceed as follows: 

1. Click the drop down arrow right next to the Search field. 

2. Enter a Filter name. This is a mandatory step. 

3. Specify filter criteria as needed. See table below for criteria descriptions. 

4. Click Filter. 
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Reusing filters  

Each time you create a filter criterion set it is saved as a private filter set with the name you entered in Filter name. It 
is available for reuse within the drop down selection of the Search field. 

Filter criteria 

Criteria Description 

Filter name 

Specify a name for the filter to be created. We 
recommend that you use an unambiguous name so that 
you can identify the correct filter later on. This field is 
mandatory. 

Status 
Select one or more statuses from the dropdown list by 
activating the relevant checkboxes. 

Author 
Select one or more users from the dropdown list by 
activating the relevant checkboxes. 

Assigned to 
Select one or more users from the dropdown list by 
activating the relevant checkboxes. 

Priority 
Select one or more priorities from the dropdown list by 
activating the relevant checkboxes. 

Type 
Select one or more types from the dropdown list by 
activating the relevant checkboxes. 

Milestone 
Select one or more milestones from the dropdown list 
by activating the relevant checkboxes. 

Entity Type 
Select one or more entity types from the dropdown list 
by activating the relevant checkboxes. 

Workflow 
Select one or more workflows from the dropdown list by 
activating the relevant checkboxes. 

Target date 
Specify a date or date range. Clicking the input area 
displays the calendar picker to select a date. You can 
also enter the date manually in the format yyyy-mm-dd. 

Fulltext Search 
Enter a search phrase to search for. The fulltext search 
will search for this phrase within all text contents 
readable by the search index. 
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3.4.6 Display filtered object tree 

In case you defined tags to tag specific object states, you can display the object tree as it looks like in this state. 
Independently from individually defined tags you can use this to display the object tree as it looks like in published 
state. 

Notes 

• Using a filtered tree, all objects are displayed in the version flagged by the tag you selected to display. Thus, 
the tree structure may vary strongly since child / parent dependencies may have been completely different in 
this state. 

• Objects which are not part of this filtered view will appear in the tree node Unsorted objects. 

• Editing of objects is not possible in a filtered tree view. 

Displaying published object tree 

A common example for a filtered tree view is the use of the tag published which controls whether objects are visible 
to learners or not. Proceed as follows to see how your published structure looks like: 

1. Expand the dropdown - without tags - right below the menu bar. 

2. Select published. 

Displaying filtered tree in library 

You can not only use the filtered view to see the object tree in a specifically tagged state but to display this state as 
library as well. Just filter the view by a tag and click library for the object you want to start the library view from. 

 Note 
To preview a structure as filtered by a tag, the according playback resources must be tagged as well. 

3.4.7 Replace object file assets  

You can as well exchange file assets like documents or screenshots in the Manager interface without the need of a 
Producer installation. 

Replacing file assets 

Proceed as follows: 

1. Select the object you want replace files in. 

2. Click Start editing. 

3. Click tab Assets. 

4. Click the button Show streams. 

5. Now the list of all files stored for the object is displayed. 

6. Click replace file for the file you want to exchange. 

7. Click Browse... in the file dialog. 
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8. Browse to the file you want to place instead and select it. 

9. Click Open. 

10. Click Upload. 

The uploaded file will replace the selected destination file without changing the object internal file name, thus all 
object references to the file will stay unharmed.  

 Note 
You can replace object files with files of the same file type only. 

3.4.8 Finish editing an object 

In most cases more than one user is involved in the lifecycle of an object. Thus, once you finished your task on an 
object you may want to initiate the next processing step for the content you edited. Handing over the content to 
another user and changing the object status is important for a fluent content production. 

We highly recommend using statuses to depict the state of your work and to enable an overview about the object 
lifecycle for all other users involved in content production. 

Depending on your production scenario there might be two different ways to use statuses for handover: 

• Independent usage of single statuses 
Statuses provide the comfort to have a detailed overview of the content production process from the start of 
the production until rolling it out to the end users. 

• Usage of statuses defined within a workflow 
Workflows align statuses in a defined order and automatically notify users or user groups when an object has 
reached a status needing their attention. 

Handover using free statuses 

Proceed as follows: 

1. Having finished your modifications to an object, click Finish editing. 

2. In the dialog Return WT, select the user to process the object next (for further editing, reviewing or 
translation). Select the according user in the dropdown Assigned to. 

3. Select a new status from the dropdown Status. 

4. If applicable write a short comment to let the next user know what to do. 

5. Ensure that the option Send mail to watchers is checked. This will trigger an automatic notification mail send 
out to all users being involved or interested in the lifecycle of the object. 

6. Activate the option Finish editing to provide editing access to the object for the next user. 

Handover using an assigned workflow 

The usage of an automatic status change by a workflow transition only slightly differs: 

1. Having finished your modifications to an object, click Finish editing. 



SAP Enable Now Manager, Cloud Option 
Working with the Manager 

 
 CUSTOMER  49 

 

2. In the dialog Return WT, optionally select a user to process the object next (for further editing, reviewing or 
translation). Select the according user in the dropdown Assigned to. Due to automatic notification, there might 
be no need to exactly know the next processor. It is defined by the workflow. 

3. Different: The option Status now provides one or more possible individually named workflow changes. Click 
the one most applicable to your needs. 

4. If applicable write a short comment to let the next user know what to do. 

5. Ensure that the option Send mail to watchers is checked. This will trigger an automatic notification mail send 
out to all users being involved or interested in the lifecycle of the object. 

6. Activate the option Finish editing to provide editing access to the object for the next user. 

3.5 Publish finalized content 

Finalized content can be provided to end users in different ways. Thus, you should think about some questions 
regarding your rollout. 

1. Do you want to track learners success? 
In case you want to have reports available which provide information about the learner's success stories, you 
must ensure to have tracking options enabled and playback setting resources published at the moment of the 
rollout.  

2. Are all resources correctly set and published? 
Check your resources for being published correctly. Not published or wrong published resources may make 
you content not accessible or provide irritating behaviors. 

3. How do you want contribute content access? 
Specify how you want users to access content. Decide whether you want to use the Learner view as central 
access point, contribute direct access link to content branches or use QR codes to provide direct access for 
QR ready devices. This decision may affect the information detail level of learning reports, thus  assignment 
based variants cannot provide information due to missing courses. 

3.5.1 Quick publishing 

The object editor enables you to publish an object directly. This is most applicable in case you do modifications to 
an already published object.  

Quick publish an object 

Proceed as follows: 

1. Select the object to be published. 

2. Click publish right above the Start editing / Finish editing button. 

The current version of the object now has been published replacing an earlier published version of the object. 

Quick unpublish an object 

Proceed as follows to resign the publishing of an object: 
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1. Select the object the publishing shall be resigned. 

2. Click unpublish right above the Start editing / Finish editing button. 

The publishing now has been resigned. The object is not accessible for learners anymore. 

3.5.2 Publish multiple objects 

Often you need to publish more than one object. This applies especially in case you want to create a course or you 
want to publish the whole workarea at once. 

Publishing objects with all children 

Proceed as follows to publish an object with subordinated object structures: 

1. Select the object you want to publish. 

2. Expand the dropdown More... at right top side of the object editor. 

3. Select Publish (all objects). 

4. The current object and all subordinated objects now have been published in their most recent version. 

Publishing resources at once 

Proceed as follows: 

1. Select the root node Resources. 

2. Expand the dropdown More... at right top side of the object editor. 

3. Select Publish (all objects). 

4. All resources now have been published in their most recent version. 

Publishing whole workarea 

Proceed as follows: 

1. Select the root node Workarea. 

2. Expand the dropdown More... at right top side of the object editor. 

3. Select Publish (all objects). 

4. All objects and resources now have been published in their most recent version. 

3.5.3 Publish another version 

Publishing of objects is version specific. Hence you can decide which version of an object shall be visible to learners. 
This for example lets you switch back the published object to an earlier version while you modify the most current 
object version for an update of the learning content. 
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Publishing a specific version 

1. Select the object to be published. 

2. Click the dropdown arrow next to publish (right above the Start editing / Finish editing button). 

3. Select Versions / Tags. 

4. In the dialog click edit tags for the version you want to publish. 

5. Activate the checkbox published. 

6. Optionally activate the checkbox Send mail to watchers to let other authors of the object know about the 
change. 

7. Click Save. 

8. Click Close. 

You can now proceed editing the most recent version of the object. Once you are finished use the Quick 

publishing to replace the older published version with the most recent one. 

3.5.4 Create course assignments 

You can create multiple courses starting from your current object, each available for different learner groups with 
different display variants. 

Creating courses from current object 

Proceed as follows: 

1. Select the object you want to specify as start object of one or multiple courses. 

2. Click tab Course. 

3. Click Add. 

4. Specify the course properties. See chapter Assignments for detailed descriptions of the course properties and 
the assignment dialog. 

5. Click Save. 

6. Repeat steps to create multiple courses beginning with the current object. 

3.5.5 Distribute links to published content 

In some cases, you may want users to access published content directly without providing courses in the Learner 
view. This you can achieve using a filtered tree view. 

Distributing direct access to published content 

Proceed as follows: 

1. Expand the dropdown - without tag - in top right corner below the menu bar. 

2. Select published. 

3. Select the tree object which shall be the entry point to the provided content. 
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4. Click the button QR Code. 

5. Copy the link displayed above the QR code to use this in your preferred distribution channel or print the QR 
code to make the content available for mobile devices. 

Alternatively, you can use the sharing options of the library using the button library. We highly recommend starting 
the library at least once in filtered view to ensure all necessary playback resources are available and content 
playback is free of any failures. 

3.6 Process learning content 

Processing learning content you may note the following: 

1. Learner view and courses 
The availability of Learner view features as well as the display of the courses is dependent on scenario settings 
and may vary. 

2. Learner success stories 
The display of your own learning progress as well as the provision of course certifications is based on user 
tracking, which has to be activated for your learning scenario. 

3. Playback requirements 
Please see the chapter Learner Settings to ensure you have set the correct settings for your default browser. 

3.6.1 Playback of Contents 

Depending on the settings of a course you may have different options to start your learning content. See examples 
below. 

Starting the course directly 

To start the whole course, click Start (bottom right of the course description). The library function opens in a new 
window displaying all course contents. 

Starting subordinated content of the course 

If the course provides a tree view you can expand the tree levels an click a tree objects to be started directly. 
Depending on the type of tree object, either the library starts in a new window (to display the object and all 
subordinated content) or content playback starts directly (for books or lesson modes). 

Restarting subordinated contents 

You can restart your learning progress individually for each learning object discarding your current learning 
progress. 

Proceed as follows:  

1. Switch to progress view by clicking Show status.  

2. Search for the object to be restarted. 

3. Click restart. 
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Starting playback from your mobile device 

To start a course on your mobile device, proceed as follows: 

1. Click the QR Code button next to the Start button. A dialog box appears displaying a QR Code which contains 
the server address to access the course directly.  

2. Use a QR code scanner app on your mobile device to access the course without the need to type in the server 
address.  

If your colleagues do have to do the same course, you can even print out the QR code and display it at a relevant 
location (for example, a newly acquired machine you are learning about right now). 

 Note 
Your mobile device must be connected to the same network the Manager is located in. 

3.6.2 Search for content 

The search function enables you to filter the available learning content for a specific string match. According to the 
settings of your learning scenario the search will be processed on all readable text content (even documents) or on 
object names only. 

 Note 
Some of the following mentioned search options might be deactivated and not available in your learning scenario. 

Searching within the current course 

By default, the search matches only in the currently selected courses. Proceed search as follows: 

1. Select a course within your course list. 

2. Enter a search phrase in the Search field. 

3. Press return or click Search. 

4. The content area (right to the course list) will now display all matches within your selected course. 

Searching within all your courses 

Proceed search as follows: 

1. Enter a search phrase in the Search field. 

2. Activate the checkbox all courses. 

3. Press return or click Search. 

4. The content area (right to the course list) will now display all matches within all your courses in the course list. 
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Searching within all published content 

This search option will provide even matches which are not part of courses in your course list. Proceed search as 
follows: 

1. Enter a search phrase in the Search field. 

2. Activate the checkbox global. 

3. Press return or click Search. 

4. The content area (right to the course list) will now display all matches within all contents available to all 
learners. 

Searching in library 

The library provides a search functionality that allows you to search in the course content. Proceed search as 
follows: 

1. Select Start to open a course in the library. 
2. Enter a search phrase in the Search field. 
3. Press return. 

The course structure displays all matches within your selected course. 

 Recommendation 
You can use logical operators to specify your search phrase for the search. Logical operators are AND, OR, NOT. 
You also can use quotation marks to specify a search phrase. 
For example: search phrase 1 OR "search phrase 2" 
In the Settings you can specify, if you want to search in the title, description, or other attributes. Use the settings, 
to get more precise search results. 

3.6.3 The Feedback function 
The trainer enables you to feedback a comment on recent learning content. Thus, you can report errors in learning 
content, point out any comprehension problems or request more details.  

Giving feedback 

Proceed as follows: 

1. Click the Feedback button displayed in the control bar or press the key combination CTRL + F1 while playback. 

2. Select the type of your comment. 

3. Write your comment into the Description field. Note that comments support plain text only. 

4. Click Send feedback. 

Notes 

○ This function has to be activated for your course. You will see the feedback function being available by having 
the Feedback button displayed in the control bar. The availability of the function can vary between courses. 

○ CTRL + F1 is the default key combination which can be replaced by another. Note the instructions as given to 
you for your learning scenario. 
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3.6.4 View your learning progress 

Depending on your learning scenario settings you may view your individual learning progress for each learning 
object in a course. This enables you to identify your overall progress as well as items you may have missed for a 
successful course completion. 

Showing learning status 

Proceed as follows: 

1. Click Show status right above the course content area. 

2. All lesson modes and book pages contained in the course are now displayed in a list, each with its individual 
learning progress. 

3. Click an object to start it directly. 

Going back to default view 

Click Show standard to switch back to course content view, 

3.6.5 Certify your learning success 

The Manager offers you the opportunity to become certified for completed courses. If you successfully completed a 
course the additional link Certificate will appear next to the according course in your course list.  

Printing your certificate 

Proceed as follows: 

1. Click on the link to open the certificate in print view.  

2. Select in the heading area of the displayed page if the course details should be printed below the certificate. 

3. Click Print to open your browser's printer dialog box. 

 Note 
To print out the certificate without additional printing information (such as date and source), deactivate the option 
for printing out the header and footer notes in your printer settings. Check the necessary settings for your browser 
in chapter Learner Settings.  
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3.7 View learner's progress 

Activated tracking enables you to get a detailed insight into the success stories of your learners. Consider the 
following facts: 

1. Tracking is a workarea option 
The tracking option has to be activated for each workarea which shall be tracked. Thus, in case of multiple 
workareas it may happen that you have reporting data for content from a workarea but not the other. 

2. Assignment-based reporting 
Assignment-based reporting needs courses to be specified. If no courses are specified, assignment-based 
reports are no option for you. 

3.7.1 View details of report items 

All report variants but the lesson step report provide the detailed view of a single list object, displaying the 
individual learning progress of users processing a single content object or, in opposite, for content objects a single 
user has processed. 

Showing detailed report for a list object 

Proceed as follows: 

1. Open a user or lesson based report by your criteria selection. 

2. Click on the name of a list entry you want more details for. 

3. The report will display the details for the selected list entry. 

Switching back to previous report view 

To leave the detailed view proceed as follows: 

1. Right above the filter a breadcrumb trail displays the object path you are currently in. 

2. Click the first item marking your entry point for the previously selected report variant. 

3.7.2 Redefine filter criteria 

You can switch the currently displayed report data by changing the filter criteria it is based on.  

Changing filter criteria 

Proceed as follows: 

1. Click the filter field left above the report data. 
This maximizes the filter criteria field, displaying the criteria currently specified. 

2. Change the criteria as necessary. 

3. Click Filter to regenerate the report based on the new criteria. 
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3.7.3 Save reports for quick reuse 

You can save your favorite reports privately thus you can reuse them quickly in future. 

Saving reports 

Proceed as follows: 

1. Call a report variant. 

2. Specify the criteria the report will based on.  

3. Click Select.  

4. Now click Save in the upper right corner of the report area.  

5. Enter a comprehensible name into the Save Report dialog. 

6. Click OK. 

Reports are saved storing the current report variant you use. Thus, you can reuse a name for different report 
variants. 

Selecting a saved report directly within report view 

The saved reports dropdown is available right above the report area in each report variant providing quick access to 
all saved reports of all display variants. You can identify and distinguish saved reports by their naming: 
 
Report variant - Name of saved report 
 

Click a report entry to switch directly to the according report variant displaying report data based on your saved 
criteria. 

In the criteria selection dialog 

The initial criteria selection dialog for each report variant provides the dropdown Report, listing saved reports for 
the currently selected report variant only. Select an entry and click the button Select to display the report data that 
matches your saved criteria. 

3.7.4 Receive scheduled reports via email 

Saved reports can be scheduled to regularly send you emails with the most recent report data matching your 
criteria selection as Microsoft Excel attachment. 

Scheduling a saved report 

Proceed as follows: 

1. Select a saved report from the dropdown list of saved reports. 

2. Click Subscribe.... 

3. In the Scheduler dialog specify a Time the report data shall be collected and sent. Optionally specify a 
Recurrence Pattern to repeat the task at a defined interval. 
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4. Click OK to save your subscription. 

Deleting scheduling of a saved report 

Proceed as follows: 

1. Select a scheduled report from the dropdown list of saved reports. 

2. Click Unsubscribe. 

The button Unsubscribe only appears for scheduled reports; thus, you can easily identify existing subscriptions for 
each saved report. 

Notes 

• To receive reports by email, you must have a valid email address specified in your user profile. 

• Some mail servers classify Microsoft Excel attachments as generally unsecure and block them. If you do not 
receive any reports and you ensured your email address is valid, check your network and email policies. 

3.7.5 Export report data 

You can export report data in file formats *.xls (Microsoft Excel) or *.csv (semicolon-separated text file) to be 
reused in external tools or for analysis at a learner’s workplace.  

Exporting report data 

Proceed as follows: 

1. Depending on the file format you prefer, click XLS Export or CSV Export right below the report data area.  

2. The file download will start immediately. Depending on your browser you can now either open or save the 
generated file. 
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4 Interface 

This chapter and its sub chapters describe the interface sections, their controls and, briefly, available user actions 
based on their order in the main menu of the Manager.  

The UI elements of each screen are described in the following order: 

• top to bottom 

• left to right. 
 

The following picture shall give you a better understanding of the order the interface sections are described: 

 

Note, that the availability of menu items and corresponding interface sections might be reduced due to your user 
permissions. 

For detailed descriptions of processes as well as best practices see the How to's chapter. 

4.1 Home 

The My Home dashboard gives you an overview of the actions you can take within the Manager. 

The tiles are grouped into logical sections, for example, User Management section where you can find all the actions 
related to users, or Reporting section that has the tiles for managing different reports. 

The dashboard also provides you with a quick access to support, such as SAP Help Portal or SAP ONE Support 
Launchpad. 

The Home menu opens on the first login to the Manager. If you close the Manager on another page, for example, 
Settings, then on your next login this page will be opened instead of Home. To return to the Home dashboard, click 
the logo on the most left part of the sections ribbon.  

Note 
The scope of the available menu items as well as the possibility to edit within these sections depends on your 
personal user permissions. 
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4.2 Workareas 

You can access a workarea under the menu item Workareas. To see all workareas you have access to click the arrow 
to right of Workareas. The Project Explorer will open and you will see the workarea structure on the left and the 
properties of each object selected in the object tree on the right. Both interface sections, the tree view as well as the 
property sheet provide several functions to organize and edit the objects within the currently selected workarea. 
The following chapters provide detailed information.  

4.2.1 Workarea functions 

At the top right of the Project Explorer you will find the workarea specific functions. The following functions are 
available: 

Creating and editing workarea content 

Using the start links Open Producer or Open Instant Producer you can directly download and start the corresponding 
local running client applications. 

Producer: provides all functionalities to record, create and edit content as well as to edit the workarea structure 
itself. 

Instant Producer: provides a simplified, small application to record and initially enhance content. 

All downloaded client applications are directly connected to the current workarea you started them from, enabling 
you to download and upload content without any additional connection setup. 

Note: to use these functionalities your local computer needs to have the Oracle® JAVA Runtime Environment (JRE) 
installed - in version 7 at least. 

Importing content 

In case you already have exported content, resources, or content structures in archive format *.dkp, you can import 
this archive package by using the Import Archive function. Choose file you want to import and Upload it. Once the 
package has been uploaded and extracted you can find its content in the content structure under Unsorted. 

Importing content from another workarea 

In case you want to reuse content or resources already existing in another Manager workarea you can import this 
by extending the Import Archive menu and select Import from other Workarea. The import dialog appears in which 
you can select the workarea you want to import from and the corresponding workarea structure.  

Note: Objects already existing in your workarea will be overwritten (ensure to have started editing them in the 
Manager interface before), new objects will be placed automatically within the tree node Unsorted. 

Exporting content 

To export the currently selected content in shareable archive format *.dkp, you can use the Export Archive function. 
This will directly trigger the creation of the archive, containing all objects below your currently selected content 
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object. As soon as the archive is created, your browser will provide you with the browser specific download options. 
Note that depending on the number of objects the creation might take a while. 

Reverting your resources 

In case your workarea contents do not play flawlessly because of corrupted resources or settings, you can revert 
the workarea resources to their initial state. 
This does not affect your content, only the objects below the Resources node. To do so, expand the Import Archive 
and select Revert Resources. 
You can choose which resources to revert in a selection dialog that opens. 

Displaying workarea filtered by tags 

If you want to see what your published workarea structure looks like, just expand the All Tag and select published. 
Doing so, the Project Explorer will only display published objects in the version they are published. This preview 
provides additional functionalities: 

• If you now select the menu item library for any selected group, the library will display the structure as it would 
be visible for learners or other user groups processing published content. Read more about the preview of 
content in chapter Object Editor. 

• For each object the property Start Link will now provide the link to the published content. You can directly copy 
it and share with the learners. 

This filter function also applies to any other tag you individually define for the workarea. See more information on 
tags in chapter Workareas/Tags. 

4.2.2 Objects 

The tree structure of the Project explorer displays all objects of a workarea. See the following explanations of 
available workarea objects. 

Main Level Level 1 Level 2 Level 3 

Workarea 

This object is the topmost entry of the tree 
structure and contains all workarea objects. 

     

Resources 

List of all of the resources available in a workarea 
for organization and editing. 

     

  Resource group      

    Resource   

 My Unsorted Objects       
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Main Level Level 1 Level 2 Level 3 

The tree node My Unsorted Objects contains 
workarea objects that are not assigned to any 
parent object and have last been edited by you.  

Content 

The group is the base group with all of the 
workarea's available learning content. It can be 
renamed freely but not replaced by another 
group. 

      

  

 

Group 

 

Subtype: SAP 
Companion for 
desktop 

    

    

Project: Standard 

 

Simulation 

 

Quiz 

  

      

 

Modes 

 

Documents 

    
Project: SAP 
Companion for 
desktop 
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Main Level Level 1 Level 2 Level 3 

 

Context Help 

 

Guided Tour 

      

 

Mode 

  

    

Project: SAP 
Companion 

 

Context Help 

 

Guided Tour 

  

  
 

Book 

    

    

 

Book Page 

  

Subtype: Book Page 
Template 

 

Subtype: Quiz 
Template 
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Main Level Level 1 Level 2 Level 3 

Text Unit 

  

 

Master Document, 
Compound 
Document 

    

 

Unsorted 
Unsorted contains all workarea objects that are 
not assigned to any parent group.  

  

      

 

Trash 

Contains all objects which have been deleted 
from the tree. 

      

 

 Note 
The scope of the displayed objects depends on your user permissions and may therefore vary. 
 

 Caution 
For playback of navigation projects, it is required to have a local installation of SAP Companion for desktop. If you 
are starting navigation projects from project explorer view, it will be necessary to start them using view filtered by 
tag published. Read more about Filtering Objects by Tags. 
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4.2.3 Search and filter objects 

There are 3 different interface elements for searching and filtering content within a workarea: 

1. The text search 

2. The advanced filter 

3. The tag filter 

Searching for specific text 

1. Type the required phrase into the search field and press enter. 

2. The search result is shown as a flat list with objects that have your searched text within all their text contents 
(name, description, short description, keywords).  

Using the advanced filter 

You can use the advanced filter to create a set of multiple matching criteria. 

1. Click the arrow symbol to the right of the search field to display the advanced filter dialog.  

2. If no filter has been specified, the advanced filter dialog appears directly. Otherwise select New filter... in the 
dropdown to display the dialog. 

3. Specify an unambiguous name to save your filter under and determine the matching criteria (see table below 
for criteria descriptions). 

4. Select Filter to display the list of matching objects. 

The advanced filter dialog provides the following match criteria for filter creation: 

Parameter Description 

Filter name* 

Specify a name for the filter to be created. We 
recommend that you use an unambiguous name so that 
you can identify the correct filter later on. This field is 
mandatory. 

Status 
Select one or more status from the dropdown list by 
activating the relevant checkboxes. 

Author 
Select one or more users from the dropdown list by 
activating the relevant checkboxes. 

Assigned to 
Select one or more users from the dropdown list by 
activating the relevant checkboxes. 

Priority 
Select one or more priorities from the dropdown list by 
activating the relevant checkboxes. 

Type 
Select one or more types from the dropdown list by 
activating the relevant checkboxes. 
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Parameter Description 

Milestone 
Select one or more milestones from the dropdown list 
by activating the relevant checkboxes. 

Entity Type 
Select one or more entity types from the dropdown list 
by activating the relevant checkboxes. 

Workflow 
Select one or more workflows from the dropdown list by 
activating the relevant checkboxes. 

Target date 

Specify a date or date range objects have set the 
property Target date for. Click the input area to display 
the calendar picker and select a date.  

• Use the first field to specify a date from which on 
you want to search 

• Use the second field to specify a date until you 
want to search 

• Use both fields to specify a time range to be 
matched 

Fulltext Search 
Enter a search phrase to search for. The fulltext search 
will search for this phrase within all text contents 
readable by the search index. 

Filtering by tags 

Additionally, you can see what the tree looks like being filtered by a tag, e.g., the published tag. This not only enables 
you to check the correct hierarchical tagging, but since tags are assigned to a unique object version, also to display 
an older status of your tree structure. 

1. On the top right of the screen click the arrow next to the field All Tag. 

2. Select the desired tag from selection dropdown. 

3. Now the tree is displayed showing only matching objects in the version they have the specific tag assigned to. 

More information: 

Quick selection of defined filter sets 

Once you have defined a filter, it will be available as an entry in the dropdown when you click the arrow next to the 
search field. You can quickly select any defined filter as well as edit or delete it. 

Availability of filter sets 

Filters are private sets. Every defined filter set is stored user- and workarea-specific. Thus, they are only available 
for you in the workarea you created them in. 

Missing objects in tag filtered view 
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When you filter a tree view by a specific tag it can happen that objects or subtrees are not displayed. This happens 
because the view is hierarchically displayed, thus one object in a level above the objects you are missing is not 
assigned to the tag you are filtering for. Check the tags of objects in tree levels parent to the objects not being  

4.2.4 Object Editor 

The Object Editor displays the properties and actions available for the current object. To edit most of the object 
properties you need to start editing the object. 

Properties section 

The object properties are organized by using tabs. Read more in the corresponding subchapters: 

• Tab Overview 

• Tasks tab 

• Course tab 

• Assets Tab 

Actions section 

Object related actions are displayed above the properties section. Depending on the object type and your user 
permissions the number of available actions may vary. 

Control Sub control  Description 

Version   
Shows the currently displayed object version. If this version is 
published, it will be displayed next to the version number. 

Publish / Unpublish   
Enables you to publish the current object version directly with 
a single click. If the object is already published, it allows you 
to unpublish the object with a single click. 

  Versions/Tags 

Launches the dialog for managing object versions and the 
assignment of workarea tags. 

• You can display any existing object version with its 
individual object properties by clicking the 
corresponding list entry. 

• You can assign a workarea tag (e.g., published) to 
another version of the object, e.g., to publish a more 
recent version in the Learner View. by clicking edit tags 
in the corresponding list entry of the version. 

Start editing /  
Finish editing / 

Restore WT 

  

Enables you to start or finish editing the current object and is 
displayed according to the current edit state of the object.  

If the object is currently edited by another user the current 
location the object is being edited at is displayed left of the 
button, like WT at: (location/machine)\path. In case you own 
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Control Sub control  Description 

the respective user permission the button now allows you to 
restore the editing mode to be available. Before using this 
option, please read the chapter Restoring write 

token carefully. 

Preview / Play / Open   

Starts the playback environment to preview the content. 

1. Preview starts the content within the library. 

2. Play launches a book or a book page directly within the 
book reader. 

3. Open launches the according application the browser 
has the file type associated with. 

QR Code   

Displays a dialog showing you a QR code to easily access the 
current content with your QR reading device or to be printed 
out. Additionally, it provides the direct access link you can 
copy and reuse.  

Note: the URL provided will be only available for other 
authors. If you want to share the link with learners, use the 
Share functionality within trainer playback of the published 
content. 

SAP Companion for 
desktop 

  

Downloads the corresponding *.dnt file to be started by your 
local installation of SAP Companion for desktop. This button 
appears only for groups with the Subtype:SAP Companion for 
desktop. 

New...   
Provides a dropdown list of child objects to be created. The 
selection range is dependent on the current object you are 
editing. Editing mode is required. 

Delete   
Moves the current object into the trash. To have this option 
available it is required that you press Finish editing before. 

  Delete (tree) Moves the current object and all child objects into the trash. 

More   
Provides a selection of additional actions to be executed on 
current object and all child objects as well. 

  Start editing all objects Starts the editing mode for current and all child objects. 

  
Finish editing all 
objects 

Finishes the editing mode for current and all child objects. 

  
Restore all write 
tokens 

Restores the editing mode for current and all child objects to 
be available. 



SAP Enable Now Manager, Cloud Option 
Interface 

 
 CUSTOMER  69 

 

Control Sub control  Description 

  Publish (all objects) 
Publishes current and all child objects in their currently 
displayed respectively latest version. 

  Unpublish (all objects) 
Unpublishes current and all child objects in their currently 
displayed respectively latest version. 

  Select Workflow... 
Sets a specific workflow for current and all child objects. 
Optionally it can set the workflow only for objects not having 
one assigned yet. 

4.2.4.1 Tab Overview 

The Overview tab provides the object properties. Using the arrow in upper right section corner you can switch 
between two layouts: 

• Standard layout 
Displays only a basic set of properties. 

• Advanced layout 
Displays all available object properties. 

Common object properties 

Depending on the object types the amount of property controls varies, but some properties are common for all 
object types. 

Property Description 

Name  
Displayed in the object tree and optionally used as 
heading in all playback or output formats. 

Language  
The language of the object. This property is used for 
automated recording texts, automated translation as 
well as for spellcheck within the HTML Editor. 

library autostart  
Allows a particular mode, book page or document to be 
started or opened automatically when selecting the 
object in the library. 

Hide  
Hides the object in the Learner view, regardless of its 
published status. Hidden objects are displayed greyed 
out within the workarea tree. 

Short Description  
HTML input field to e.g., write a short introductory text 
to the description to introduce the readers to the 
current topic and its requirements.  
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Property Description 

Description  
HTML input field to provide enriched text information 
about the object itself or the structure underneath. 

Keywords  

Input field to provide keywords for better search 
matches within the library search. Multiple keywords 
have to be separated by using semicolon (keyword1; 
keyword2). 

Editing properties 

All properties displayed within the Overview tab can only be modified in editing mode, available by clicking the Start 
editing  button.  

4.2.4.2 Tasks tab 

The Tasks tab provides the properties of the task attached to the current object as well as the history of previous 
object / task changes committed to the server. Using these properties, you can, for example, assign the object to 
another author to finish the content or change the target date the object content has to be finished by. 

Object / task changes view shows you a list of all of the server procedures performed on the object currently 
selected. This provides you with a quick overview of which procedure was performed on the object and by whom. If, 
for example, the editor in question has commented on changes that have been made, these comments will also be 
displayed in the list.  
Entries with comments are identified with an arrow icon in the first column. Clicking on the corresponding entry or 
arrow icon opens the entry and displays the comment. 

Task properties 

See the following list for a brief description of the task properties. Note that some properties are optional and 
depend on their usage in your scenario (marked with an -o). Therefore, see the individual instructions on your 
project scenario. 

Property Description 

Created 
Displays the date the current object has been initially 
created on the server as well as the user who created 
the object. 

Title 

The title of the task attached to the object. This can be 
different to the Name of the object since it describes the 
task's nature and is intended to be read by other 
authors, thus it can be e.g., "Revise recording step 2". 

Type (-o) 
Provides the list of predefined task types to be used for 
task specification. 
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Property Description 

Priority (-o) 
Provides the list of predefined priorities to set the task's 
production priority. 

Assigned to 

Provides the list of users being able to edit the current 
object. Select an entry from the list to assign the object 
for review or further processing to the selected user. If 
the task is already assigned to a user, the current 
assignee is displayed in the field. 

Milestone (-o) 
Provides the list of predefined milestones to set the 
task's milestone dependency. 

Target date 
Allows you to specify a specific target date the task has 
to be fulfilled by. This is useful in case you assign the 
task to another user. 

Workflow (-o) 
Allows you to select or change an assigned workflow. 
Click change to select a workflow and a workflow step 
the task shall be currently at. 

Status (-o) 
Provides a list of predefined status to be set for the 
current task. If a workflow has been assigned, only 
feasible status transitions are displayed as links. 

Watcher 
Displays the list of users, who are automatically notified 
on object / task changes. To modify this list, click Edit... 
and add or remove users in the Edit watchers dialog. 

Description 
Provides a brief description of the current task's state or 
the changes you did. This simplifies finding the current 
task state within the tasks history. 

Adding a comment 

The New comment... button enables you to add a comment to the task history at any time, without the need of 
having set the object to editing state. Just type a clear, concise title and a brief comment text to be added to the 
history. Additionally, you can select if the assigned user list of watchers shall be automatically notified of your 
comment by selecting or deselecting the option Send mail to watchers. 

Viewing the history 

Below the task properties the task history displays all log entries created within the objects' current lifetime ordered 
by the most recent entry descending. Entries with a text description are prefixed with an arrow symbol. Click the 
arrow symbol to expand the text to be read.  

Exporting the history 
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Right below the task history the two buttons provide the optional export of the whole history list to be further 
processed in another application. 

• XLS Export: the history will be downloaded in format Microsoft Excel  
• CSV Export: the history will be downloaded in text file format Comma Separated Values (*.csv) 

4.2.4.3 Courses tab 

The Course tab provides a flat list of all learner view courses the object is participating in. You can create a new 
course initialized by the current object or modify existing courses initialized by the current project.  

Adding a course 

The Add button displays the dialog for course creation. Read more in chapter Course assignment and display options. 

Course assignments 

Each entry in the list displays: 

• course name 

• user group it is available for  

• display style in the learner view  

• scoring method 

• actions 

Actions: 

• Edit 
To change an existing course, click Edit. The dialog for course creation will be displayed with the current set of 
properties for the course. Read more in chapter Course assignment and display options. 

• Delete 
To delete an existing course, choose Delete. The confirmation dialog will appear. 

• Start... 
Use this action to play the course and approve its contents. 

• Link 
Use this action to distribute a course via direct URL or QR code. The share dialog with the related information 
will appear. 

Courses with missing editing capability 

If a course is missing the edit / delete actions, this course is not rooted by the current object but from an object of 
an upper level. Check the parent objects for their course list to edit the respective course or use the administration 
overview for Assignments. 

Red highlighted courses 

Courses, which have been created for objects that are not yet published, are highlighted red. The missing publishing 
prevents them from being displayed in the course list of the learner view. 
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4.2.4.3.1 Edit Assigned Content Dialog 

The Edit Assigned Content dialog enables you to set various properties on how to present content as a course in the 
Learner view. These settings have no impact on the tracking behavior of the content. 

 Note 
In case of creating a new assignment as well as selecting an unpublished root object for your assignment, a 
warning message appears. As long as your selected root object for the assignment is not published, the 
assignment won't be visible in the course list of the Learner view. 

Property Description 

Caption 
Mandatory property. Specify the name the assignment is displayed 
with in the course list of the Learner view. 

Selected Object 
Mandatory property. Select the root object of the content structure 
to be distributed by the assignment. 

Selected Identity 
Mandatory property. Select the identity (user, role, or organizational 
unit) the assignment will be displayed to in the course list. 

Display as 

Specify, if only the root object of the content or even ancillary 
objects will be displayed. Following options are available: 

1. Object only - only current object will be displayed 

2. Object and direct sub objects - current object will be displayed 
with ancillary objects of first sublevel 

3. Object and sub objects (2 levels) - current object will be 
displayed with ancillary objects of two sublevels 

4. Object and sub objects - current object will be displayed with all 
ancillary objects 
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Property Description 

 

Scoring Method  

Specify if and how the progress will be displayed in the Learner view. 
Following options are available: 

1. No Scoring - no progress will be displayed 

2. Percent Completed - progress will be displayed by a graphical 
progress bar  

3. Usage Counter - like in a ranking system, all requests of all 
users will be displayed 

 

Learning Path Mode Specify if the learners shall be forced to process the content one 
after another to follow a didactical line you considered for the 
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Property Description 

content. This option allows the learner to start the next content only 
if the current content has been finished at defined success level. 

The Learning Path Mode is available only with the following 
assignment options setup: 

• Scoring Method : Percent Completed  

• Display as: Object and direct sub objects, Object, and sub 
objects (2 levels), Object and sub objects 

The configuration options are available: 

• off - Learning Path Mode is deactivated  

• show only available - only completed and the currently 
processed content is displayed. Each time the learner 
completes a content object the next object becomes visible. 

• show all - all the content is displayed, but only completed and 
the currently processed content can be started. 

Minimum Completion (%) 
Define the minimum success rate (in %) content has to be finished 
for the next content object becoming available for processing. 

Lesson Types 

Optionally exclude lesson types from being displayed. Click on the 
corresponding lesson symbol to hide (symbol will be shown as strike 
through) or unhide (no strike through) this type in the Learner view. 

 

Weight 

Use the Weight option to influence the order of courses in the 
course list. Enter a numerical value from 1 (for top) to 500 (for last). 
If more than one course is weighted with the same value, e.g., 1, all 
of those will be grouped above next numerical value (in this case 2). 

 

Passed Tests Required (%) 
Define the minimum success rate (in %) for test modes the content 
is marked as been processed successfully. 



SAP Enable Now Manager, Cloud Option 
Interface 

 
 CUSTOMER  76 

 

Property Description 

Allow Status View 

Specify if the user is allowed to switch from standard view (1) to 
status view, displaying the progress within all content of the course 
(2). 

 

Allow Search 
Specify if the contents of this course are displayed in search results. 
If checkbox is disabled, contents are not shown in search results. 

Show Description 

Specify if the description of the course is displayed or not. 

 

Date Range 
Specify a time range the assignment will be available in. Reaching 
the end of the time range the assignment will be automatically 
hidden. 

Color 

Specify a font color as hexadecimal value (e.g., "#ffee33") the 
course name will be displayed with. 

 



SAP Enable Now Manager, Cloud Option 
Interface 

 
 CUSTOMER  77 

 

4.2.4.4 Assets Tab 

The Assets tab provides an overview of the direct child objects the current object has, as well as an optional list of 
files / streams the object folder contains.  

Viewing file streams 

Initially only child objects are displayed. Click Show streams to view the list of files the object folder contains. To 
hide the list click Hide streams, which is now placed at the same button position instead. 

Replacing file 

Files which have been added to the object, can be replaced using the Manager interface. Click replace file to display 
the dialog to browse for a new file and / or to rename the file title. 

 Note 
The replace file item action is only available in editing mode. 

4.2.5 Edit HTML contents 

You can edit all HTML based content properties using the browser-based HTML editor. This enables you to create 
visually enriched content without the need of a local Producer or Instant Producer installation. 

Starting the HTML editor 

Start editing an object. For any HTML control you click, the HTML editor pops out. 

Common HTML controls are: 

• In object properties: 

○ Description 

○ Short description 

• In book pages: 

○ Text fields for bubbles, active areas, text pop-ups and other. 

Dropdown controls 

Control Description 

 Set font family. 

 Set font size (in pixel). 

 Apply a paragraph style on selected paragraph. 
The selected style will be applied on the whole 
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Control Description 

paragraph the cursor is recently placed in (<p>-tag in 
source view).  

 

Apply an inline style on selected range. 
The selected style will be applied only on the currently 
selected range or the word which begins directly behind 
the cursor. If the cursor is followed by space nothing will 
be applied.  

 

Apply a block style the selection will be enclosed in. 
The selected style will enclose your selected range by a 
<div>-tag.  

• If you select a range, all paragraphs between 
previous block element and next block element will 
be enclosed (use to separate your content into 
different box elements).  

• If you just place the cursor in the text without any 
selection, the parental paragraph will be enclosed 
by the box element. In case you have no other box 
elements specified yet the newly created box 
element will be moved to the lower end of the text 
area. 

 

Apply a table style to insert a table based on your style 
selection. 
Selecting a table style will create a 2x2 cells table before 
the paragraph with the current cursor position or 
current selected range. 

Toolbar Icons 

Element Description 

 Toggle selected text range between bold and regular. 

 Toggle selected text range between italic and regular. 

 
Toggle selected text range between underlined and 
regular. 

 Remove formatting from selection. 

 

Set text alignment for currently selected paragraph. 

• Align Left 

• Center  

• Align Right 
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Element Description 

 

Begin list at recent cursor position or switch currently 
selected paragraph to list item. 

• Bullets 

• Numbering 

 

Set text indent. 

• Indent (move right) 

• Outdent (move left) 

 

Insert one of the following objects into text. 

• Insert Link: Provides a dialog to insert link to 
workarea object or to specify a free external link 

• Insert Placeholder: Provides a dialog to select 
common placeholders like for the name of the 
parental Book. Placeholders are dynamically 
updated on change of the source text. 

• Insert Image: Provides a dialog to select an image 
asset from within the workarea 

• Insert Image File: Provides the File upload 
assistant to load an image from local or external 
source. The uploaded image will be stored as asset 
of the current selected object 

 
Set font color for selected text range from the color 
picker. 

 

Switch text direction for selected paragraph. 

• Left to Right 

• Right to Left 

 

Extend or reduce current selected table by one column 
or row. 

• Add Column Left 

• Add Column Right 

• Add Row at Top 

• Add Row at Bottom 

• Delete Column 

• Delete Row 

• Delete Table 
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Switching between design view and source code view  

In case you want to approve or modify the HTML code itself you can display the HTML code using the buttons below 
the viewport. 

 

 Note 
The availability of HTML formatting is limited to those as given by the HTML editor controls. Embedding of other 
objects or script snippets is prohibited. Unsupported code will be automatically removed on switching back to the 
design view or closing the HTML editor.  

4.3 Administration 

The Administration menu offers access to the interface sections relevant for administrating the Manager 
application, managing the user access, server data or meta information to be reused within the workareas. Each 
section will be explained in detail in the following chapters. 

 Note 
The scope of the available menu items as well as the possibility to edit within these sections depends on your 
personal user permissions. 

4.3.1 Users 

The user management interface gives you control over user maintenance and user access. 

Adding a new user 

1. In the Quick Add section enter the user data into the fields and select role memberships from the Roles 
dropdown.  

2. Create the user with Add. 

 Note 
Consider that at least the field Logon-ID is mandatory. We highly recommend creating an initial password to be 
changed by the user themselves (consider the server security settings for password creation). 

To send new users an automated e-mail with their user data, you must enter a valid e-mail address. 

Searching and filtering 

The search and filter section enables you to search for single or multiple users within the currently displayed user 
list. 
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• Use Search field to find specific users 

• Use Filter dropdown to display active or inactive users or users depending on their email status. 

Selection 

The Selection section provides the tree view of the organizational units users are assigned to. Expand the tree items 
by clicking the arrow in front of each entry and click an entry to view the members of the unit within the user list on 
the right of the screen. Select an organizational unit to create a new user within it. 
If you select the organizational unit root, all users are displayed.  

User list 

The user list displays all members within a selected organizational unit. You can:  

• view a single user profile by clicking the corresponding list entry 

• manage a single user by selecting the relevant actions links in the last column of the currently selected list 
entry 

• manage one or multiple users by selecting the checkbox for each user to be processed. Then select the 
corresponding user action from the buttons on the bottom right of the user list. 

 Note 
To display action links available for the current entry you have to hover over the corresponding list entry. 

Action Description 

Purge All Personal Data... 

(all users action) 

Allows you to delete tracking data, session data and 
assignment scores of all users older than a certain 
number of months that you specify. 

Note: this action is for all users, it is not user-specific. 

Invalidate Global Consent... 

(all users action) 

  

Allows to remove the consent of all users. Users will 
need to consent to your updated policy with their next 
logon again. 

Export... 

Allows you to export users of the currently selected 
organizational unit and child units in a re-importable 
output format (e.g., for mass manipulation of user data 
or for transferring user data to another Manager 
instance). Opens a dialog which allows you to restrict 
the output to users of a specific source (SAML, LDAP, 
Excel) and to select the file format to be created. 

Messages... 
Opens the Messages editor with your user selection as 
the recipients list. 

Activate Activates selected users. 
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Action Description 

Deactivate 
Deactivates selected users. Deactivated users cannot 
logon anymore from any source (Manager interface, 
Producer, Instant Producer, other). 

Add Role 
Opens a dialog to specify roles to add to the selected 
users. To add multiple roles, press CTRL or SHIFT while 
selecting. 

Remove Role 
Opens a dialog listing all the roles available for the 
current user selection. Select the relevant checkboxes 
for the roles to be removed from user selection. 

Quick overview of user information 

Hover over a list entry to display the corresponding user information in the Details area. 

4.3.1.1 The user profile 

The user profile contains the information available for a selected user. 

There are the following user properties: 

Value Description 

Logon ID*  
A unique name used by the user to identify within the 
logon process. 
Maximum length: 100 Characters 

Last name  
The user's last name. 
Maximum length: 100 Characters 

First name  
The user's first name. 
Maximum length: 100 Characters 

Middle names  
The user's middle names. 
Maximum length: 100 Characters 

Email  
The user's e-mail address. Without this information the 
user will be unable to receive or send automated e-mail 
notifications. 

Phone  The user's telephone number. 

Interface language  Manager interface language for the user. 
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Value Description 

Active  

Specifies whether the user login is activated or blocked. 
Possible statuses: 

• Active (selected) 

• Inactive (not selected) 

Roles 
One or multiple roles the user belongs to. Select or 
deselect corresponding checkboxes in the dropdown list 
to add or remove role memberships. 

 Caution 
If no e-mail address has been provided, users will not receive automated e-mails as well as these cannot be sent on 
their user actions. 

4.3.2 Organizational units 

The Organizational Units section enables you to depict your organizational structure and thus to clearly assign your 
users to their organizational departments and task areas.  
You can import already existing organizational structures using LDAP or Microsoft Excel as well as you can build up 
an individual structure. Imported structures as well as individually created structures can coexist next to each other 
as sub trees of the root node. 

Adding a new unit 

1. In the Quick Add section enter a name and optionally a registration code.  

2. Create the organizational unit with Add. 

Selection 

The Selection section provides the tree view of the organizational units. Expand the tree items by clicking the arrow 
in front of each entry and click an entry to view the members of the unit within the members list on the right side of 
the screen.  
If you select the organizational unit root, all members are displayed.  

Properties 

The properties fields enable you change the name of the organizational unit currently selected in the selection tree. 
Optionally you can add a new or change the existing registration code. 

Searching and filtering 

The search and filter section enables you to search for single or multiple members within the currently displayed 
member list. 

• Use Search field to find specific units or users. 
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• Use the Active: dropdown list to display active or inactive members only.   
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Searching and filtering 

The search and filter section enables you to search for single or multiple members within the currently displayed 
member list. 

• Use Search field to find specific units or users. 

• Use the Active: dropdown list to display active or inactive members only.   

Member list 

The member list displays all members within the current organizational unit (subordinated organizational units, 
roles, and users). You can  

• activate or deactivate members by clicking the checkbox in column Active or 

• manage one or multiple members by selecting the checkbox for each required member. Then select the 
corresponding action from the buttons on the bottom right of the user list 

Action Description 

move to OU... 
Opens a dialog with the organizational units tree to 
select an organizational unit the selected members shall 
be moved to. 

Messages... 
Opens the Messages editor with your member selection 
as the recipients list. 

More information: 

• User import 

4.3.3 Roles 

The Roles section enables you to create and manage user roles you require for your scenario. 

Adding a new role 

1. In the Quick Add section enter a name and optionally a registration code.  

2. Create the role with Add. 

Selection 

The Selection section provides the tree view of the organizational units. Expand the tree items by clicking the arrow 
in front of each entry and click an entry to view the inherited roles of the unit within the roles list. 
If you select the organizational unit root, all roles are displayed.  
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Searching the roles list 

Use Search field to find single or multiple roles within the currently displayed roles list.  

Roles list 

The roles list contains all roles in the selected organizational unit and its subordinated organizational units. You can  

• view the members of the selected role in the bottom part of the screen 

• activate or deactivate roles by clicking the checkbox in column Active 

• view the Registration Code of a role in the corresponding column 

• modify the properties of the selected role clicking the button Change... 

• manage one or multiple roles by selecting the checkbox for each required role. Then select the action from the 
buttons on the bottom right of the roles list. 

Action Description 

Change... 
Opens the Edit Role dialog, where you can change the 
name, assign a registration code, and activate or 
deactivate the role. 

Messages... 
Opens the Messages editor with your role selection as 
the recipients list. 

Permissions... 

Opens the Role Permissions dialog in which you can 
specify identities who can do changes to the specific 
role. 
Available role permissions: 

1. Administrate role 
Allows to change role specific permissions. 

2. Edit role 
Allows to change or delete the role as well as to 
add / remove role members. 

Activate Activates the selected roles. 

Deactivate 
Deactivates the selected roles. All members of a 
deactivated role lose the permissions assigned to this 
role. 

Delete 
Deletes the selected roles. All previous members of a 
deleted role lose their role membership and the 
permissions assigned to this role. 

Searching and filtering the members list 

The search and filter section enables you to search for single or multiple members within the currently displayed 
members list. 

• Use Search field to find specific units or users. 
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• Use the Active: dropdown to display active or inactive members only. 

Members list 

The members list contains all members of the currently selected role. You can: 

• identify members type by the symbol in column Type (single user symbol / role symbol) 

• activate or deactivate roles by clicking the checkbox in column Active 

• manage one or multiple members by selecting the checkbox for each required member. Then select the action 
from the buttons on the bottom right of the list: 

Action Description 

Add... 
Displays the identity dialog to add users or roles as 
members of the current role. 

Remove 
Removes the selected members from the role. These 
will lose all permissions inherited from the role. 

Predefined roles 

The Manager provides a predefined set of roles within the organizational unit system. We highly recommend 
reusing these roles for building up your own role scenario. 

Role Description 

Administrators 
This role owns all permissions apart from SAP 
Companion Configuration. 

Guests 
This role is permitted to inspect the Learner view, but 
not to edit the personal settings area. 

Learners 
This role is permitted to inspect the Learner view and the 
personal settings area.  

Master Authors 
This role provides an advanced author role, which is also 
permitted to create and maintain workareas. 

Project Managers 

This role provides all necessary permissions to prepare 
and maintain the meta data types, tasks and workareas 
needed for the collaboration scenario. Nevertheless, this 
role has no content access. 

Report Viewers This role is restricted to inspect the Reporting only. 

Reviewers 
This role can inspect all content sections but is not 
allowed to edit them. It can only create/edit object 
related tasks and comment on content. 
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Role Description 

SME 
This role owns the necessary permissions to create and 
edit content but no permissions for administrative 
workarea maintenance. 

Snippet Authors 
This role allows you to create, edit and upload SAP 
Companion script snippets. 

Standard Authors 
This role owns the necessary permissions to create and 
edit content but no permissions for administrative 
workarea maintenance. 

System Workarea 

This role owns the necessary permissions to create and 
change content in the application specific workarea 
System, which provides resources and data for the 
Manager itself.  

SAP Companion Administrators 
This role allows you to view and manage SAP 
Companion configuration and script snippets. 

More information: 

For details see the following chapters of this document: 

• Create roles 

• Assign users to a role 

• Self-registration of users 

4.3.4 Permissions 

Permission management is the central tool of the Manager's role-based environment. All permissions are effective 
in Manager and, if the relevant functions are available, in connected SAP Enable Now components as well. 

 Note 
Due to a high complexity of permission dependencies, we highly recommend assigning single permissions only to 
extend individual permission set inherited from an existing role. 

Interface areas 

The permission management interface is split into three areas: 
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• Selection 
Expand the identity tree to view subordinated organizational units, roles, and users. Click an item to view its 
permissions. 

• Permissions  
Use the checkboxes to activate and deactivate permissions. Alternatively, you can use the checkbox in the 
header line to select or deselect all permissions. 

• Assigned Permissions 
View the complete set of permissions, individually assigned as well as subordinated from memberships, being 
assigned to the currently selected identity. 

Saving permission assignments 

Once you've modified permission assignment for the currently selected identity, confirm your assignment by 
clicking the Save button. 

Permission details 

The following table lists all permissions with a brief description on their influence. 

Permission Description 
Predefined roles that contain this 
permission 

Content: Cancel Editing 
Permits to force the server-sided 
recreation of a write permission 
currently held by another user. 

Administrators, Master Authors, 
SME, Standard Authors, System 
Workarea 

Content: Change Workflow 
Permits to change the individual 
workflow of content objects. 

Administrators, Master Authors, 
System Workarea 

Content: Comment 
Permits to add comments to 
content. 

Administrators, Learners, Master 
Authors, Reviewers, SME, Standard 
Authors, System Workarea 

Content: Create Permits to create content. 
Administrators, Master Authors, 
SME, Standard Authors, System 
Workarea 

Content: Delete Permits to delete content into trash. 
Administrators, Master Authors, 
SME, Standard Authors, System 
Workarea 

Content: Delete from Trash 

Permits to delete content 
permanently from the trash. In 
combination with Resources: Delete 
from trash it allows to empty the 
trash. 

Administrators, Master Authors, 
SME, Standard Authors, System 
Workarea 



SAP Enable Now Manager, Cloud Option 
Interface 

 
 CUSTOMER  90 

 

Permission Description 
Predefined roles that contain this 
permission 

Content: Edit 
Permits to modify content and save 
it to the server. 

Administrators, Master Authors, 
SME, Standard Authors, System 
Workarea 

Content: Publish 
Permits to publish contents (only, 
no resources). 

Administrators, Master Authors, 
SME, Standard Authors, System 
Workarea 

Content: Upload Active Content 

Permits to upload files with active 
content (e.g., *.(x)htm(l), *.js) to the 
server. 
Usually these files are blocked.  

Administrators, Master Authors, 
System Workarea 

Content: View 

Permits to view the content tree - 
mandatory for access to the Project 
Explorer as well as for content 
playback. 

Administrators, Guests, Learners, 
Master Authors, Report Viewers, 
Reviewers, SME, Standard Authors, 
System Workarea 

Course Assignments: Edit 
Permits to create, modify, or remove 
course assignments. 

Administrators, Master Authors, 
System Workarea 

Course Assignments: View 
Permits to view the course 
assignments tab as well as the 
course assignments overview. 

Administrators, Master Authors, 
Reviewers, System Workarea 

Editing Report: View 
Permits to view the Editing Report 
displaying objects being currently 
edited. 

Administrators, Master Authors, 
Project Managers 

Messages: Create & Send 

  

Permits to send a message using the 
messages interface or the messages 
option in the user or roles 
management interfaces. 

Administrators, Master Authors, 
Project Managers, System Workarea 

Milestones: Delete Permits to delete milestones. 
Administrators, Master Authors, 
Project Managers, System Workarea 

Milestones: Edit 
Permits to modify milestone 
properties. 

Administrators, Master Authors, 
Project Managers, System Workarea 

Milestones: View 
Permits to view milestones in tasks 
as well as the milestone 
management interface. 

Administrators, Master Authors, 
Project Managers, Reviewers, SME, 
Standard Authors, System 
Workarea 
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Permission Description 
Predefined roles that contain this 
permission 

Organizational Units: Create 
Permits to create organizational 
units. 

Administrators 

Organizational Units: Delete 
Permits to delete (manually created) 
organizational units. 

Administrators 

Organizational Units: Edit 
Permits to modify organizational 
units and their tree position. 

Administrators 

Organizational Units: View 
Permits to view the organizational 
unit management interface. 

Administrators, Master Authors, 
Project Managers, Report Viewers, 
Reviewers, SME, Standard Authors, 
System Workarea 

Permissions: Edit 
Permits to modify permission 
assignments. 

Administrators 

Permissions: View 
Permits to view the permission 
management interface. 

Administrators, Master Authors, 
Project Managers, System Workarea 

Priorities: Delete Permits to delete priorities. Administrators 

Priorities: Edit 
Permits to modify priority 
properties. 

Administrators, Master Authors, 
Project Managers, System Workarea 

Priorities: View 
Permits to view priorities in tasks as 
well as the priority management 
interface. 

Administrators, Master Authors, 
Project Managers, Reviewers, SME, 
Standard Authors, System 
Workarea 

Resources: Comment 
Permits to add comments to 
resources. 

Administrators, Master Authors, 
SME, Standard Authors, System 
Workarea 

Resources: Delete 
Permits to delete resources into the 
trash. 

Administrators, Master Authors, 
System Workarea 

Resources: Delete from Trash 

Permits to delete resources 
permanently from the trash. In 
combination with Content: Delete 
from trash it allows to empty the 
trash. 

Administrators, Master Authors, 
System Workarea 

Resources: Edit 
Permits to create or modify 
resources and save them to the 
server. 

Administrators, Master Authors, 
System Workarea 
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Permission Description 
Predefined roles that contain this 
permission 

Resources: Publish Permits to publish resources. 
Administrators, Master Authors, 
System Workarea 

Resources: View 

Permits to view the resources in the 
Project Explorer - mandatory for 
access to the Project Explorer as 
well as for content playback. 

Administrators, Guests, Learners, 
Master Authors, Report Viewers, 
Reviewers, SME, Standard Authors, 
System Workarea 

Roles: (De)Activate 
Permits to activate or deactivate 
roles. 

Administrators, Project Managers 

Roles: Administrate All 

Permits to edit roles independently 
from their individual role editing 
permissions. 
 
Caution: this is a high-level 
permission allowing to change any 
role! 

Administrators 

Roles: Delete Permits to delete roles. Administrators, Project Managers 

Roles: Edit 
Permits to create roles as well as to 
assign or remove role memberships. 

Administrators, Project Managers 

Roles: View 
Permits to view the role 
management interface. 

Administrators, Master Authors, 
Project Managers, Report Viewers, 
System Workarea 

Scheduler: Edit Jobs Permits to modify scheduled jobs. 
Administrators, Project Managers, 
Report Viewers 

Scheduler: View Jobs 
Permits to view jobs in the scheduler 
overview. 

Administrators, Project Managers, 
Report Viewers 

Server Statistics: View 
Permits to view the server statistics 
interface. 

Administrators 

Server: Edit Server Settings 

Permits to view and edit the server 
settings interface. This permission 
should only be assigned to 
administrators. 

Administrators 

Server: Housekeeping Edit 
Permits to view housekeeping 
interface and run the housekeeping 
functionality. 

Administrators 
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Permission Description 
Predefined roles that contain this 
permission 

Server: Housekeeping View 
Permits to view housekeeping 
interface. 

Administrators 

Server: User Import 
Permits access to User import 
functionalities for importing user 
structures. 

Administrators 

Status Report: View 
Permits to view the status report for 
tasks. 

Administrators, Master Authors, 
System Workarea 

Status: Delete 
Permits to remove statuses from the 
status management interface. 

Administrators, Master Authors, 
Project Managers, System Workarea 

Status: Edit Permits to modify statuses. Administrators 

Status: View 
Permits to view statuses in tasks as 
well as the status management 
interface. 

Administrators, Master Authors, 
Project Managers, Reviewers, SME, 
Standard Authors, System 
Workarea 

Tags: Create Permits to create tags. 
Administrators, Master Authors, 
SME, Standard Authors, System 
Workarea 

Tags: Delete Permits to delete tags. 
Administrators, Master Authors, 
SME, Standard Authors, System 
Workarea 

Tags: Edit Permits to modify tags. 
Administrators, Master Authors, 
SME, Standard Authors, System 
Workarea 

Tags: Set 
Permits to set individually created 
tags. This excludes the special tag 
published. 

Administrators, Master Authors, 
SME, Standard Authors, System 
Workarea 

Tasks: Delete 
Permits to delete tasks from the 
task list. 

Administrators, Master Authors, 
System Workarea 

Tasks: Edit Permits to modify tasks. 
Administrators, Master Authors, 
Reviewers, SME, Standard Authors, 
System Workarea 

Tasks: View 
Permits to view tasks as well as the 
task list. 

Administrators, Master Authors, 
Reviewers, SME, Standard Authors, 
System Workarea 
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Permission Description 
Predefined roles that contain this 
permission 

Test Data Creation: Generate Session 
ID 

Operational permission for running 
automated server test. 
Note: Do not assign this permission 
unless you are told so by SAP Enable 
Now support team. 

Administrators 

Types: Delete Permits to delete types. 
Administrators, Master Authors, 
Project Managers, System Workarea 

Types: Edit Permits to modify types. 
Administrators, Master Authors, 
Project Managers, System Workarea 

Types: View 
Permits to view types in tasks as 
well as the types management 
interface. 

Administrators, Master Authors, 
Project Managers, Reviewers, SME, 
Standard Authors, System 
Workarea 

User List: View 
Permits to view the user list - 
mandatory permission for any user 
context. 

Administrators, Guests, Learners, 
Master Authors, Project Managers, 
Reviewers, SME, Standard Authors, 
System Workarea 

User Profile: Edit 
Permits to modify the individual user 
profile and user specific settings. 

Administrators, Learners, Master 
Authors, Project Managers, Report 
Viewers, Reviewers, SME, Snippet 
Authors, Standard Authors, System 
Workarea, SAP Companion 
Administrators 

User Profile: View Permits to view user profiles. 

Administrators, Guests, Learners, 
Master Authors, Project Managers, 
Report Viewers, Reviewers, SME, 
Snippet Authors, Standard Authors, 
System Workarea, SAP Companion 
Administrators 

User: Delete Details 

Permits to purge personal user data. 
Only with this permission the 
corresponding Data Protection 
controls are visible in the user 
interface. Consider giving this 
permission only to administrators 
being responsible for data 
protection. 

Administrators 
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Permission Description 
Predefined roles that contain this 
permission 

User: View Details 

Permits to view personal user data. 
Only with this permission the 
corresponding Data Protection 
controls are visible in the user 
interface. Consider giving this 
permission only to administrators 
being responsible for data 
protection. 

Administrators 

Users: (De)Activate 
Permits to activate or deactivate 
users. 

Administrators 

Users: Create Permits to create users. Administrators 

Users: Edit 
Permits to edit user information in 
the user management interface. 

Administrators 

Users: View 
Permits to view users in identity 
selection areas as well as the user 
management interface. 

Administrators, Master Authors, 
Project Managers, Report Viewers, 
Reviewers, SME, Standard Authors, 
System Workarea 

Views: Authoring View 

Mandatory permission for any 
authoring or administration task.  
Initially activates the access to all 
interfaces required for authoring 
and administration, which are then 
individually controlled by their 
specific permissions. 

Administrators, Master Authors, 
Project Managers, Report Viewers, 
Reviewers, SME, Standard Authors, 
System Workarea 

Views: Learner View 
Enables the menu item for the 
Learner view as well as all accordant 
options. 

Administrators, Guests, Learners, 
Master Authors, Reviewers, SME, 
Standard Authors, System 
Workarea 

Views: Reporting 
Enables the menu item for the 
Reporting as well as all accordant 
options. 

Administrators, Master Authors, 
Report Viewers, System Workarea 

SAP Companion 

Configuration: Edit 

Allows to create and edit SAP 
Companion configurations through a 
dedicated menu. 

 SAP Companion Administrators 

SAP Companion 

Configuration: View 

Allows to view SAP Companion 
configurations in a dedicated menu. 

 SAP Companion Administrators 
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Permission Description 
Predefined roles that contain this 
permission 

SAP Companion Script Snippets: Edit 
Allows to create, edit, and upload 
SAP Companion script snippets 
through a dedicated menu. 

Snippet Authors, SAP Companion 
Administrators 

SAP Companion 

Script Snippets: View 

Allows to view SAP Companion 
script snippets in a dedicated menu 

Snippet Authors, SAP Companion 
Administrators 

Workarea Manager 
Enables the menu item workareas 
necessary to access the Manager 
workareas. 

Administrators, Master Authors, 
Reviewers, SME, Standard Authors, 
System Workarea 

  

Workareas: (De)Activate 
Permits to activate or deactivate 
workareas. 

Administrators, Master Authors, 
System Workarea 

Workareas: Create Permits to create workareas. 
Administrators, Master Authors, 
System Workarea 

Workareas: Delete Permits to delete workareas. 
Administrators, Master Authors, 
System Workarea 

Workareas: Edit 
Permits to modify data within 
workareas. 

Administrators, Master Authors, 
SME, Standard Authors, System 
Workarea 

Workareas: Edit Workarea 
Permissions 

Permits to change workarea 
permissions for individual workareas 
the user owns the workarea 
permission Administrate Workarea 
for. 

Administrators, Master Authors, 
System Workarea 

Workflow: Create Permits to create workflows. Administrators 

Workflow: Delete Permits to delete workflows. Administrators 

Workflow: Edit Permits to modify workflows. Administrators 

Workflow: View 
Permits to view workflows in tasks 
as well as the workflow management 
interface. 

Administrators, Master Authors, 
Project Managers, Reviewers, SME, 
Standard Authors, System 
Workarea 
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4.3.5 Messages 

Using the messages functionality you can send an email to a selection of users, roles, and organizational units to 
contribute information like upcoming maintenance operations, structural changes, or user instructions. 
The messages functionality is available from menu item Administration > Messages as well as from within the 
identity management interfaces User, Roles, and Organizational Units. 

Sending a message 

1. Click Edit to add recipients. In the Identity Selection dialog select your recipients, press CTRL to select multiple 
items. You can search for specific identities using the search field. 
In case you called the messages functionality from one of the identity management interfaces, the field is 
prefilled with your selection taken there. You can use Edit to extend the prefilled list. 

2. Enter a Subject of your mail. 

3. In case you want to reuse the text of a previously sent message, you can use the dropdown to choose the 
email body from one of the 10 last send messages. Previously sent mails can be seen as templates in this case. 

4. Enter your email Body text or modify the text from Saved messages history. 
Note: this mail supports only text, no html code. 

5. You can send the message to yourself with Send me this mail. 

6. Send your mail.  
 

Email validation 

Email addresses organized by the same domain the Manager is member of will be validated before sending and 
announced as invalid if validation returns error. 

4.3.6 Status 

The Status section enables you to create and maintain statuses. With the help of these status, you can depict the 
lifecycle of your content from creation through processing to publishing and translation. 

Adding a new status 

1. Click Add... and enter a status name.  

2. You can decide on the Order of this status within the lifecycle now or edit it later. 
Enter a numeric value or use the arrows to set the order in the status list.  

3. Create an Active status to make it available right away. You can also create some inactive status, edit their 
order, and activate them afterwards. 

4. Create the status using Add. 
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Editing an existing status 

1. Click the status name or the edit icon to start editing. 

2. Edit the Name, Order and Active state of the status in the Edit dialog. 
Note: if you deactivate an existing status, it can no longer be assigned. It will also be hidden in tasks for which 
it was used. Workflows using this status won't be displayed anymore as well, since they become invalid. 

3. Save your changes. 

You can also activate and deactivate status with a toggle in the column Active. 

Editing multiple status at a time 

1. Tick the checkboxes of all the status that you want to edit. 

2. Expand Bulk Actions. Here you can choose between Activate, Deactivate or Delete... all of the selected status.  

Deleting status 

1. Click the deletion icon for a single status or choose Delete... in Bulk Actions for multiple status. 

2. Confirm your decision in the Delete dialog that appears. 

4.3.7 Workflows 

The Workflows section enables you to create and maintain workflows. 

Workflows assist you in the content production process. They represent a sequence of status defining different 
states of the content lifecycle. You can control which users are allowed to change the content lifecycle and you can 
notify users responsible for the next step in the workflow automatically . 

Adding a new workflow 

There are 2 ways to add a new workflow: 

1. In the Quick Add section enter a Name and an optional Description for your workflow and click Add. 
You can activate this workflow using Active checkbox later. 

2. On the bottom right of the screen click New... and enter a Name, optional Description and decide if you want to 
activate this workflow right away.  

Note 
Newly created workflows are empty. You need to add steps to define the lifecycle and transitions between these 
steps.  

We recommend using the graphical workflow editing, but you can do this using the Steps action. 

For a detailed step-by-step explanation of how to create workflows, see the chapter Create workflows of this 
document. 
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Workflows actions 

The list of workflows shows all created workflows with their name, description, and active state. It also displays the 
number of steps the workflow contains as well as some actions that you can do. Actions list extends on hovering 
over a workflow. 

Action Description 

Steps 
Start the workflow editor to add / remove steps or add / 
modify / remove transitions between steps. 

Edit 
Edit the main properties of the workflow (Name, 
Description, Active). 

Clone 
Duplicate the workflow with a new Name and optional 
different Description. 

Delete Delete the workflow. 

Edit Graphically 
Start the graphical workflow editor. See sub chapter 
Graphical workflow editing.  

More information: 

For details see the following chapter of this document: 

• Create workflows 

4.3.7.1 Graphical Workflow Editing 

The graphical workflow editor enables you to visualize the workflows you are creating, simplifying the creation 
process. This will help you especially if you want to create multiple workflow transitions matching the needs of 
different authoring and reviewing teams using the same workflow. 

Adding status boxes 

1. Select a status from dropdown list Status and click Add to add it to the stage. 

2. Repeat this action for all statuses you want to add to your workflow. 

Adding transitions 

1. Click one status box to activate it. 

2. Click another status box the transition shall lead to. 

3. The transition will appear directly as visual connector. 

4. Click the transition box to enter a meaningful name. 

5. Click OK to close the prompt. 

6. Repeat procedure for any transition you want to create.  
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You can add multiple transitions of the same connection to be available for different teams and users.  

 
Image: Multiple team transitions between two statuses 

Saving the workflow 

Save Changes to save your work or Discard Changes to step back to the last saved state of the workflow. 

Post-processing 

Since the visual editor just adds status and transitions to a workflow you have to post-edit the created transitions in 
the workflow editor. 

4.3.8 Types 

Types let you specify additional meta information you can use to label tasks and filter for in the Tasks overview or in 
the Workarea view. For example, you can add information about the task nature (as the predefined examples 
suggest).  

You are free to delete these examples and use this meta information as needed for your scenario. 

Adding a type 

1. Click Add... and enter a Name and optional Description of a type. 

2. Confirm with Add at the bottom of the dialog.  
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Editing a type 
 

1. Click Edit icon or somewhere on the line of the required type to launch the Edit dialog. 

2. Change Name or Description as desired. 

3. Save. 

Deleting a single type 

1. Click Delete icon for the required type.  

2. Confirm deletion. 

Deleting multiple types 

1. Use the checkboxes to select types you want to delete. 

2. In Bulk Actions choose Delete... 

3. Confirm deletion. 

4.3.9 Priorities 

The Priorities section enables you to define different priority weightings, this way classifying tasks according to their 
priority. 

Adding a priority 

1. Click Add... and enter the Name, Weighting, and optional Description for the new priority. 

2. Confirm with Add at the bottom right of the dialog. 

Editing a priority 

1. Click Edit icon or somewhere on the line of the required priority to launch the Edit dialog. 

2. Change Name, Weighting or Description as desired. 

3. Save. 

Deleting a single priority 

1. Click Delete icon for the required priority.  

2. Confirm deletion. 

Deleting multiple priorities 

1. Use the checkboxes to select priorities you want to delete. 

2. In Bulk Actions choose Delete... 

3. Confirm deletion. 
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4.3.10 Milestones 

The Milestones section enables you to define sub or intermediate objectives for managing your projects, so-called 
milestones.  

Adding a milestone 

1. Click Add... and enter the Name, optional Description, Target Date and Active state for the new milestone. 

2. Confirm with Add at the bottom right of the dialog. 

Editing a milestone 

1. Click Edit icon or somewhere on the line of the required milestone to launch the Edit dialog. 

2. Change Name, Description, Target Date and Active state as desired. 

3. Save. 

 Note 
Inactive milestones can no longer be assigned and will be hidden from any place they are used. 

Deleting a single milestone 

1. Click Delete icon for the required milestone.  

2. Confirm deletion. 

 Note 
If the milestone is still used in tasks, a dialog box displays the number of linked tasks. Navigate to the Tasks section 
and delete the milestone from the linked tasks. Then you can delete the milestone itself. 

Deleting multiple milestones 

1. Use the checkboxes to select milestones you want to delete. 

2. In Bulk Actions choose Delete... 

3. Confirm deletion. 

4.3.11 Workareas/Tags 

In the Workareas section you can create and manage workareas to be available for different content creation 
scenarios and different user groups. 

Adding a workarea 

1. In the Quick Add section enter a Name and a workarea ID. 

2. Confirm with Add. 
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The workarea will be created with a predefined set of workarea permissions for these identities: 

• root - View published Workarea 
Every user will be able to see published content from this workarea 

• you -  Administrate Workarea 
As you created the workarea you gain full permissions to maintain the workarea. 

• Initial user -  Administrate Workarea 
The initial super user automatically gets full permissions for each workarea.  

Workarea list 

The workarea list displays all workareas you are permitted to manage (Workarea Permission: Administrate 
Workarea). Only the initial user (as created while setup) has the permission to view all existing workareas within this 
list. 

 Note 
The workarea list contains an already existing workarea, named System (_system). This workarea is mandatory, 
enabling us to provide a customized user interface for your needs. 
Do not delete or deactivate this workarea. 

Actions for a workarea 

The column Actions: Workarea offers actions you can take on workareas: 

Action Description 

Edit... 

This action allows you: 

• to rename the workarea  

• to add a description (to let authors better identify 
that they are using the correct workarea) 

• to define workarea specific email addresses for 
learner feedback (separated by semi-colon) 

• to specify a base workarea (requires workarea 
extensibility activated - see more information 
section below) 

• to edit the connection settings for a connected 
workarea 

Permissions... 

Opens the permission management dialog box. Here 
you can configure the permissions to view, edit, 
maintain, or delete the workarea for individual users, 
roles, or organizational units. This enables you to 
manage individual author access to different scenarios 
and workareas within a large team. 

Note: workarea permissions are superordinate to user 
permissions. This means that even a master author who 
has editing permissions cannot edit or view a workarea 
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Action Description 

unless they have the permission for the relevant 
workarea.  

Watchers 

Opens the Identity Selection dialog box where you can 
specify whether users are notified about workarea 
actions. Workarea watchers will get an email notification 
about any change to objects or tasks in the workarea. 

Workflow... 

Defines a default workflow for the workarea to be set 
automatically for any new object. Workflows for single 
objects or object trees can be changed afterwards 
individually. 

Deactivate 

Deactivates the workarea to make it inaccessible for 
users but preserves data to be activated and used later 
on. The workarea is not shown in the workarea selection 
anymore and its contents and assignments are not 
available in the learner view or other scenarios 
connected to the Manager. 

Get Metadata 

For connected workareas only. Enforces the Manager to 
load the metadata like object information, structure 
information, publishing states and other from the 
source workarea independent from the specified 
synchronization interval in the Server Settings. 

Delete 

Hover over the action area of the relevant workarea to 
display the security relevant action Delete.  

Click it to delete the workarea and confirm your choice. 
After confirmation, the workarea and its file structure in 
the base directory are deleted permanently. 

Adding a tag 

Tags are very useful because they can only be set once for each object and once for each object version. This 
enables you to "freeze" structure states individually. For example, you can display a special release version of your 
contents at any time by filtering the tree view for relevant tags. Read more in chapter Display filtered object tree. 

1. In the column Tags click Add Tag... 

2. In the Add/Edit Tag dialog box enter the ID, Name, and optional Description for the tag.  

3. Confirm. 

 Note 
It is not possible to define a tag with the "published" ID, since this is reserved for the application’s own publish tag.  



SAP Enable Now Manager, Cloud Option 
Interface 

 
 CUSTOMER  105 

 

Actions for tags 

In the column Actions (Tags) you can perform the following actions: 
 

Action Description 

Edit Tag... 
This action allows you to rename the tag and edit its 
description. 

Delete Tag 

Hover over the action area of the relevant tag to display 
the action Delete Tag.  

Note: there is NO confirmation of deletion.  

Clicking Delete Tag will delete it immediately. 

More information: 

For details see the following chapters of this document: 

• Connected Workarea 

• Prepare workareas 

• Access control 

4.3.12 Assignments 

The Assignments section lists all existing content assignments from all workareas. Thus, it enables you to find and 
modify existing assignments easily. 

Creating an assignment 

1. Select New... 

2. Specify Caption, Selected Object and Selected Identity in the Edit Assigned Content dialog that opens. 

3. Configure the rest of the properties as required. 

4. Save. 

A new assignment is created. 

For detailed information about the assignment properties see the following chapter Assignment Properties. 

Item list 

The item list shows all existing assignments with their main properties and actions. 
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Property Description 

Caption 
The name the assignment is displayed with in the course list of the 
Learner view. 

Selected workarea The workarea the content comes from. 

Selected object The root object of the content provided by the assignment. 

Selected identity The identity the assignment is displayed for in the Learner view. 

Active If the assignment is active (visible) or not. 

Weight 
The weighting value determining the position of the assignment within 
the course list of the Learner view. 

Display as 
The amount of sub levels being displayed as well as the scoring 
method of the assignment. 

Lesson Types The included/excluded lesson types. 

Item actions 

Actions for the assignment: 

• Edit... - edit the properties of the assignment 

• Delete - delete the assignment 

• Start... - start the assignment directly 

• Link - display the sharing dialog with direct access URL and QR 
code 

Editing an assignment 

1. Click Edit... action or somewhere on the line of the required assignment to launch the Edit Assigned Content 
dialog. 

2. Make your changes. 

3. Save 

Exporting assignments list 

1. Select XLS Export on top of the page. 

2. Depending on your browser, a Save As or similar dialog opens. Choose where you want to save the 
assignments list and confirm. 

The assignments list is saved as Microsoft Excel file with detailed information on each assignment. 

Highlighted list entries 

Assignments which are highlighted red are not displayed in the course list of the Learner view, since their root 
content object is not published. 
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4.3.12.1 Assignment Properties 

The Edit Assigned Content dialog enables you to set various properties on how to present content as a course in the 
Learner view. These settings have no impact on the tracking behavior of the content. 

 Note 
In case of creating a new assignment as well as selecting an unpublished root object for your assignment, a 
warning message appears. As long as your selected root object for the assignment is not published, the 
assignment won't be visible in the course list of the Learner view. 

Property Description 

Caption 
Mandatory property. Specify the name the assignment 
is displayed with in the course list of the Learner view. 

Selected Object 
Mandatory property. Select the root object of the 
content structure to be distributed by the assignment. 

Selected Identity 
Mandatory property. Select the identity (user, role, or 
organizational unit) the assignment will be displayed to 
in the course list. 

Display as 

Specify, if only the root object of the content or even 
ancillary objects will be displayed. Following options are 
available: 

1. Object only - only current object will be displayed 

2. Object and direct sub objects - current object will be 
displayed with ancillary objects of first sublevel 

3. Object and sub objects (2 levels) - current object 
will be displayed with ancillary objects of two 
sublevels 

4. Object and sub objects - current object will be 
displayed with all ancillary objects 



SAP Enable Now Manager, Cloud Option 
Interface 

 
 CUSTOMER  108 

 

Property Description 

 

Scoring Method  

Specify if and how the progress will be displayed in the 
Learner view. Following options are available: 

1. No Scoring - no progress will be displayed 

2. Percent Completed - progress will be displayed by a 
graphical progress bar  

3. Usage Counter - like in a ranking system, all 
requests of all users will be displayed 

 

Learning Path Mode Specify if the learners shall be forced to process the 
content one after another to follow a didactical line you 
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Property Description 

considered for the content. This option allows the 
learner to start the next content only if the current 
content has been finished at defined success level. 

The Learning Path Mode is available only with the 
following assignment options setup: 

• Scoring Method : Percent Completed  

• Display as: Object and direct sub objects, Object, 
and sub objects (2 levels), Object and sub objects 

The configuration options are available: 

• off - Learning Path Mode is deactivated  

• show only available - only completed and the 
currently processed content is displayed. Each 
time the learner completes a content object the 
next object becomes visible. 

• show all - all the content is displayed, but only 
completed and the currently processed content 
can be started. 

Minimum Completion (%) 
Define the minimum success rate (in %) content has to 
be finished for the next content object becoming 
available for processing. 

Lesson Types 

Optionally exclude lesson types from being displayed. 
Click on the corresponding lesson symbol to hide 
(symbol will be shown as strike through) or unhide (no 
strike through) this type in the Learner view. 

 

Weight 

Use the Weight option to influence the order of courses 
in the course list. Enter a numerical value from 1 (for 
top) to 500 (for last). If more than one course is 
weighted with the same value, e.g., 1, all of those will be 
grouped above next numerical value (in this case 2). 
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Property Description 

 

Passed Tests Required (%) 
Define the minimum success rate (in %) for test modes 
the content is marked as been processed successfully. 

Allow Status View 

Specify if the user is allowed to switch from standard 
view (1) to status view, displaying the progress within all 
content of the course (2). 

 

Allow Search 
Specify if the contents of this course are displayed in 
search results. If checkbox is disabled, contents are not 
shown in search results. 

Show Description 

Specify if the description of the course is displayed or 
not. 

 

Date Range 
Specify a time range the assignment will be available in. 
Reaching the end of the time range the assignment will 
be automatically hidden. 

Color 
Specify a font color as hexadecimal value (e.g., 
"#ffee33") the course will be displayed with. 
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Property Description 

 

4.3.13 Server Settings 

The server settings control the global behavior of the Manager application as well as its data sources and system 
security. Thus, only few users with experience in web applications should be able to access them. 

Sections  

The server settings are split into several thematically grouped sections. These sections will be explained in the 
following subsections. 

Saving modified settings 

1. Make the required changes to the server settings. 

2. Confirm them with Save button on the top ribbon of the page. 

You might need to refresh the browser page for changes to become visible. 

Reverting settings to default 

A green dot is shown next to the changed settings. This way you can always see whether a setting uses the default 
or your custom configuration. There are two ways to revert settings to default: 

1. Hover over a changed setting and use the Restore Default Configuration Value button which is shown next to 
the setting. 

2. You can also use the Revert All button on the top ribbon to completely reset your existing configurations to 
default. 
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4.3.13.1 General settings 

The general settings section contains configuration parameters for the behavior of your Manager installation. 

Setting Description 

Configuration 

Fallback interface language 

Specify which language is used if an interface string 
(such as menu identifier) is not available in the currently 
selected interface language. If the string is also not 
available in selected fallback language, it is displayed in 
English (master fallback). 

Date format 
Individualize the date format to be used by the Manager 
and automated email notifications. 

List entries per page 

Specify the maximum number of displayed list items for 
all sections displaying multipage lists, for example, User, 
Tasks, Reporting and other. The number of displayed list 
objects has direct impact on server and interface 
performance. Hence you can increase performance by 
decreasing this value. Recommendation: In case you 
need to do bulk operations, for example, on thousands 
of users, you can increase this value temporarily to the 
value you need to show all users on one list page. Please 
expect the corresponding interface load time and do not 
forget to decrease the value afterwards again. 

Compress server response 
Select if data will be sent compressed (as gzip) to 
reduce data traffic. 

Base path 
Read-only parameter displaying the directory path the 
workarea related file content is stored in. To modify this 
setting, please use the server installation wizard. 

Download path for cloud installation 
Define the local path for end user machines in which the 
application files of the portable applications shall be 
downloaded and stored. 

Caches & Timeouts 

Caching lifetime (s) 

Determine the time the browser will keep objects in 
browser cache (in seconds). Optionally you can enter -1 
to force a permanent revalidation of objects. Since this 
will increase server traffic dramatically you should avoid 
that in a productive scenario. 
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Setting Description 

Caching lifetime for static resources (s) 

Determine the time the browser will keep static objects 
in browser cache (in seconds). Optionally you can enter 
-1 to force a permanent revalidation of objects. Since 
this will increase server traffic dramatically you should 
avoid that in a productive scenario. 

Caching lifetime for entity files for authors (s) 

Determine the time the browser will keep files accessed 
by authors in browser cache (in seconds). Optionally 
you can enter -1 to force a permanent revalidation of 
objects. Since this will increase server traffic 
dramatically you should avoid that in a productive 
scenario. 

Timeout of SQL server request (ms) 
Enter the time in milliseconds (ms) after which database 
server queries are timed out. 

Timeout of recovery email (min) 
Specify the time in minutes after which the individual 
code sent with an automatic recovery email will be 
invalidated. 

Timeout of server request (s) 

Specify the maximum time for a server request. Default 
value is 600 s (10 minutes).If you face timeout error 
messages on intensive requests you may fix them by 
increasing this value. 

Valid time of a session (s) 
Set how long a session will be valid. Default value is 
3600 s (1 hour). 

Valid time of user scores before recalculation (min) 
Set the time period the server automatically revaluates 
the scores of all users. Default is 1440 min (24 hours). 

Search 

Allow global search in learner view 
Activate the ability to search within content that is not 
part of learner's assignments. 

Show learner view search 
Set whether the search functionality is displayed in the 
Learner view. (De)activation of the search function is a 
global option. 

Addons 

Install Google Chrome extension 
Decide whether the Google Chrome Extension shall be 
installed automatically on download of the On-Demand 
applications. 
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4.3.13.2 User Management Settings 

The user management settings section contains configuration parameters for user creation, export, and 
deactivation. 

Setting Description 

Automatic User Creation 

Organizational unit for automatic user creation (dn) 
Specify the organizational unit that users will be created 
in on first access via SAML provider. 

Role for automatic user creation (dn) 
Specify the role users will be created in on first access 
via SAML provider. 

Automatic User Deactivation 

Enable automatic user deactivation 
Activate the checkbox to enable automatic user 
deactivation. 

Deactivate after (interval type) 
Select the time interval type the interval shall be based 
on, e.g., week. 

Deactivate after (interval unit) 

Enter a number specifying how many units of the 
interval type the interval shall include, e.g., 5 for 5 weeks 
according to previous example. Thus, users would be 
automatically deactivated after a period of 5 weeks 
inactivity. 

Email address for reports 
To automatically receive an email with a report 
spreadsheet (*.xls) on automatic user deactivation 
enter a valid email address. 

Automatic Excel Import 

Enable automatic Excel import 
Activate the checkbox to enable the automatic Excel 
import. 

Automatic Excel import file path 
Enter the path to the Excel file. Note that the file storage 
must be available to the server. 

Automatic Excel import scheduler 
Specify the start time and the recurrence pattern the 
Excel import shall run.  

Append roles 

Select this option if you want the roles you specify in 
your Excel file to be appended to already existing ones. 
If you do not select this option, the roles will be 
overwritten with the newly defined roles. 



SAP Enable Now Manager, Cloud Option 
Interface 

 
 CUSTOMER  115 

 

Setting Description 

Enable password policy 
Apply the password settings from the Security settings 
section to the passwords within the Excel file as well. 
File entries violating the policy will not be imported. 

Email address for report 
Enter a valid email address to receive emails with a 
report spreadsheet (*.xls) about automatic Excel import 
automatically. 

Role for automatic user creation via Microsoft Excel 
import 

Specify the role users shall be created in when they do 
not own a role specification in the Excel source to be 
imported. 

Data Protection & Privacy 

In this section you can configure the settings to comply with the European General Data Protection Regulation 
(GDPR). The data protection feature is enabled by default. We highly recommend keeping it activated at all times. 
Before deactivating this option, get in contact with the Data Controller or similar role responsible for the processing 
of personal data. Acting nonconform to legal regulations can result in remarkably high penalties!  

Enable data protection feature 
Select whether to have the functionalities supporting 
the requirements of the General Data Protection 
Regulation (GDPR) activated or not.  

Request consent from users 

In case your users have already given their consent to 
your privacy policy in another system in your 
environment, deactivate this option to not display the 
consent request to users on logon. All other 
functionalities for reporting, purging, or deleting 
personal data will stay available. In case the data 
protection feature has been disabled, this setting has no 
effect. 

Schedule deletion for personal data change log 
You can schedule the deletion of users' personal data 
change logs. If you turn this function on, the next two 
settings become available for editing. 

Delete after (interval type) 
Select the time interval type to base the deletion on, for 
example, week. 

Delete logs older than (interval unit) 

Enter a number specifying how many units of the 
interval type the interval shall include, e.g., 5 for 5 weeks 
according to previous example. The logs older than 5 
weeks will be deleted automatically. 
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4.3.13.3 Notifications and Email Settings 

The notifications and email settings section contains configuration parameters for the events of which the 
administrators are notified. 

Setting Description 

Email Settings 

Application name 
Set a name for the Manager installation which will be 
shown in automatic emails. This parameter is useful to 
distinguish between multiple Manager instances. 

Email address for learner feedback 

Enter the email address to which user comments on 
content (trainer, library, book reader) will be sent. You 
can enter multiple email addresses separated by 
commas. 

Email language of learner feedback Select the language for automatically generated emails. 

Reply email address 

Enter a valid email address to be provided with server-
side sent emails as reply address. This enables your 
users to reply to these mails as well as it enables your 
project leads to identify absent users by receiving 
automatic replies (e.g., Out-of-Office notifications). 
Ensure that the corresponding users have access to this 
generic email account. 

Reply name 
Enter a name to be used as sender name for server-side 
send emails. This helps your users to identify server 
emails faster. 

  

Setting Setting 

Notify me at 

Consider which notifications are really necessary for running your scenario. Setting too many notification triggers 
to always might result in spamming your authors. 

Activation Milestone change 

 

Assignment Priority change 

Check in Finish of editing 
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Setting Setting 

Comment Version revert 

Commit Tag set 

Commit with new version Status change 

Commit as new version Target date change 

Object deletion Type change 

Tag deletion Workflow change 

Start of editing   

4.3.13.4 Features Settings 

The features settings section contains parameters for advanced Manager configuration. 

Setting Description 

Versioning 

Timeout for new version at commit (min) 

Specifies the time during which an object (after having 
already been generated in a new version) can be edited 
without forcing a new version to be created. Input a 
number of minutes. The maximum permitted number of 
digits is 50. 

Force new version increment 
A new version will be created automatically on commit 
of object changes. 

Force new version on finish editing Forces a new version of an object on Finish Editing. 

Connected workarea 

Enable workarea extensibility feature 
Activate the workarea extensibility feature to be able to 
reuse data from the caching workarea or another 
workarea of this server. 

Enable connected workarea feature 
Activate the connected workarea feature (no 
extensibility) to be able to determine a read-only 
caching workarea. 
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Setting Description 

Connected workarea synchronize time (min) 

Determine the time range the connected workarea 
feature requests and update of meta data from the base 
workarea.  

Note: this is the time interval when cached file assets 
will be outdated and newly requested assets from base 
workarea will be updated in case they are touched. 
Hence, a decrease of the time range to a low value might 
have negative effects. 

SAP Companion for Manager 

Enable SAP Companion 

Activates SAP Companion in the Manager interface. The 
context help will provide you with contextual help for 
interface elements as well as with guided tours, 
explaining best practices and workflows to boost your 
experience working with the Manager. For each 
interface section having contextual help available you 
will see the help icon appearing next to the logout 
button. 

Path to SAP Companion framework 

Defines the source SAP Companion framework is loaded 
from. 

Do not change.  

In case you experience performance issues with SAP 
Companion, please contact the customer support for 
further instructions. 

Location of SAP Companion content 

Defines the source SAP Companion loads the help 
content from. 

Do not change. 

In case you experience performance issues with SAP 
Companion, please contact the customer support for 
further instructions. 

Path to initialization script 

Defines the source SAP Companion loads its 
initialization script from. 

Do not change.  

In case you experience performance issues with SAP 
Companion, please contact the customer support for 
further instructions. 
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Setting Description 

Machine translation for SAP Companion 

Client secret 

Enter the details of your SAP Translation Hub license.  
Service URL 

Token URL 

Client ID 

4.3.13.5 Security and Passwords Settings 

The security and passwords settings section contains parameters to configure security based on your specific 
requirements. 

Setting Description 

Login Behavior 

Allow self-registration 

Activate the possibility for users to register themselves 
on the logon page.  

Note: the logon page must be available by users, hence 
other authentication methods like SAML have to be 
configured not to come up in advance. 

Authentication method 

Specify the authentication method to be used to access 
the Manager and the published content. Do not change 
this parameter unless you are told so by support team 
or SAP HANA Operations. 

Enable brute force protection for authentication 

Enable this setting to protect Manager against brute-
force attacks. When activated, you can specify 
Maximum number of login attempts before blocking and 
Maximum lockout time in seconds. It is highly 
recommended have this feature enabled. 

Maximum number of login attempts before blocking 

Set the number of subsequently failed login attempts 
after which the users get blocked. This feature can only 
be set when Enable brute force protection for 
authentication is active. 

Maximum lockout time (s) 
When the Maximum number of login attempts before 
blocking is exceeded, every logon attempt will be 
delayed by an increasing time counter, beginning with 1 
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Setting Description 

minute and ending at your specified time, after which 
the user account will be locked. This feature can only be 
set when Enable brute force protection for authentication 
is active. 

Security 

Allow anonymous access to snippet repository 

Allow access to the snippet repository without 
credentials to be able to update the snippets from 
central snippet repository to target server as 
anonymous user. 

Block content access for administrative users 

This setting denies access to objects and content for 
users with any administrative permission and is enabled 
by default. Thus, it prevents these users from being able 
to execute malicious code implemented in content. To 
access content, these users will need a secondary user 
profile without admin permissions. 

Note: if you deactivate this setting, you need to logout 
and login again (after saving the settings) to get access 
to content related interface sections. 

Enable trusted script upload 

Allows to upload trusted scripts. When enabled, the 
Trusted Scripts section becomes visible in the 
Administration menu. See the Manager Security Guide 
for more details. 

Single Sign-On 

Enable Single Sign-On 
In the cloud environment Single Sign-On is activated by 
default. Deactivate this setting if you want to force 
manual login via credentials input. 

Create user on SAML login 

By default, users are automatically created on their first 
login via SAML (Single Sign-On). Deactivate this option 
if you want to handle your users via cloud connector or 
Excel import. 

Single Sign-On with Kerberos This is the default method for on-premise installations. 

Single Sign-On with SAML 
SAML is the default Single Sign-On method in the cloud 
environment and cannot be changed. 

Activate SAML user on login automatically 
Users logged in via SAML can be automatically 
activated. 
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Setting Description 

CORS 

Enable CORS Enable CORS functionality.  

CORS allowed sites 
Enter URLs for CORS enabled sites to interact with SAP 
Companion.  

Password Settings 

Password expiration for unchanged initial password 
(days) 

Set the number of days after which the initial password 
is invalidated, if it has not been changed. 

Force password change at first login 

Force users who have been created manually or by Excel 
import to change their password on first login. This 
enables you to use standard passwords for manually 
created users without breaking the security concept. 

Force password change at login for reset passwords 
If an administrator resets a user's password, the next 
time the user logs on, the user is prompted to specify a 
new password. 

Password expiration (time type) 
Select the time type to be used for user-specific 
password expiration calculation (starting from 
password creation / change), e.g., week. 

Password expiration (time unit) 

Enter a numeric value determining how many units of 
the selected time type can pass at maximum before a 
password expires, e.g., 6 to set a period of 6 weeks 
(according to previous example).If you enter 0, no 
password will expire. The new password has to be 
different than the last 5 passwords. 

Enable password invalidation and expiration notification 

Activate a notification that tells users that their 
password is expiring and suggests them to change it. 
Users with expired passwords will need to contact 
administrators to reset password and activate their 
accounts.  

Inform about expiring password (days) 
Specify the number of days before password expiration 
to show a notification to users. 

Minimum password length 
Specify the minimum length of passwords. This 
parameter can be within range of 6-127 symbols. 

Maximum password length 
Specify the maximum length of passwords. This 
parameter can be within range of 13-255 symbols. 
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Setting Description 

Password must contain numbers 
A valid password has to contain at least one number (0-
9). 

Password must contain special characters 
A valid password has to contain at least one special 
character ($,_,@,...). 

Password must contain lower- and uppercase letters 
A valid password has to contain at least one upper-case 
letter and one lower-case letter. 

Restricted words for passwords 
Create a list of not allowed passwords, you can use a 
comma or a semicolon to separate them. 

4.3.14 Trusted Scripts 

The Trusted Scripts enable you to define script fingerprints for scripts to be treated by server as safe scripts. 

You will find a set of default scripts in the Trusted Scripts management. These scripts are used within the standard 
document output. We do not recommend deleting them as it will prevent your authors from uploading generated 
html documents to the Manager anymore.  

More information: 

Please read the Manager Security Guide for detailed information. 

4.3.15 Server Housekeeping 

The Server Housekeeping functionality enables you to automatically clean up your Manager instance by removing 
old and obsolete data. 

More information: 

Please read the Manager Operations Guide for detailed information. 

4.3.16 User import 

The User Import start page allows you to specify sources for user import. You require administrator permissions to 
import user data. 

Options for user import 
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There are the following options: 

1. Excel - start the import wizard to import users from a Microsoft Excel file 

2. Close Wizard - close the wizard page and return back to the Manager interface 

More information: 

Please read the Manager Operations Guide for detailed information on each User Import wizard and configuration 
details. 

4.4 Tasks 

The Tasks section provides you with a quick, object-related summary of allocated tasks and how they are being 
dealt with. Additional filter options enable users to search specifically for all tasks and responsibilities within all 
workareas. 

By default, the task list shows you all of the tasks assigned to you in a list view, i.e., by clicking on the Tasks menu 
button it is always filtered according to tasks that have your user name in Assigned to. Clicking a list entry will open 
the corresponding task in the detailed view.  

Filtering the list 

You can apply filter criteria to restrict the number of tasks displayed. To do so, proceed as follows: 

1. Select Filter button on the top left of the screen. 

2. In the displayed menu, select the filter criteria you want using the drop-down lists. 

3. Confirm. 

Saving filters 

You can save filter criteria collections as a personal filter, for example for frequently used queries.  

1. Filter the list by some filter criteria. 

2. The result list is now updated. Select Save on the top right of the screen. 

3. Specify a Name for the filter set. 

4. Confirm. 

You can now select the saved filter set at any time from the dropdown on the top right. Additionally, the saved filter 
set is added as menu item to the Tasks menu dropdown, thus you can select it directly from the menu. 

 Note 
Unfiltered task list will display the tasks of all the workareas available on the Manager. 

Use the filter option workarea to view the tasks from a specific workarea. 
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Deleting filter sets 

Proceed as follows to delete a saved filter set: 

1. Select your filter set from the filter dropdown or from the Tasks sub menu. 

2. Select Delete next to the filter dropdown. 

3. Confirm the deletion. 

Creating a new task 

To create a new object-independent task, proceed as follows: 

1. Select New... at the bottom of the screen. 

2. Select the parameters required for this task in the detailed task view that opens. 

3. Save the task. 

Exporting task list  

1. Filter the list as required. 

2. Select XLS Export or CSV Export on the bottom of the page. 

3. Depending on your browser, a Save As or similar dialog opens. Choose where you want to save the task list and 
confirm. 

The task list is saved in your selected format with detailed information on each task. 

Reloading the task list 

Select Reload at the bottom of the page to update the list and see the newly created tasks. 
 

4.4.1 Detailed view 

Clicking a task launches the detailed task view. Here you can inspect or modify all properties associated with the 
task.  

The task history on the bottom half of the page lists all associated events, users and, if available, comments. 

Editing a task 

You can add comments, change target date, and title of a task and adjust the properties using dropdowns. The 
values in the dropdowns are the settings that were made for each property previously. 

For example, to adjust the lifecycle status of the task, some status have to be created in the menu Administration -> 
Status. You will see this status in the dropdown. See the corresponding sections of this manual for details. 

1. Edit the task as required. 

2. Save your changes. 
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4.5 Reporting 

The Reporting enable you to check the learning progress made by single learners, roles, or whole organizational 
units. Thus, you can measure the progress made by the learners, identify problems in understanding the learning 
material and compare the learning progress of different learning groups. 

Note: deactivated users are not included in the reports. 

Prerequisites 

Activate tracking options in the Playback Settings of each workarea you want to track to enable the collection of 
data for the learning reports.  

You will need a local Producer installation connected to your Manager instance and the permission to edit 
resources.  

Activating tracking 

1. In the Project Explorer tree view of the Producer, go to Resources > Adaptable Resources > Playback Settings 
and select the resource item. 

2. Start Editing if you are not already editing the resource. 

3. Double-click the resource item to open the settings in the Settings dialog. 

4. Click the sub node trainer - Global. If you only want to activate tracking for a specific content type, select the 
required sub node: book reader, Demo Mode, Practice Mode, Test Mode, or Concurrent Mode. 

5. In the overview of available parameters (on the right of the screen), expand the parameter group Tracking 
(General) for the selected sub node. 

6. Activate the following parameters by clicking the relevant green lamp symbol and configure them as 
required.   

1. Tracking back end 
Click the dropdown list to expand it. Select Manager or, if you want your workarea to be compatible to 
with other tracking scenarios, select Automatic. 

2. Manager detail tracking 
Specify how detailed you want the tracking information to be. Three options are available:   

• topics 
Only topics and objects itself are tracked. No data will be available for the report type Lesson step 
reports. 

• topics, macros 
In addition to topics and objects, macros are tracked as well. This option retrieves data for the 
Lesson step reports as well. 

• topic, macros, actions 
Highest level. Very detailed tracking that includes user actions to be reported in the Lesson step 
reports. 

7. Save your settings with Ok. 

8. Finish editing to upload your changes to the Manager. Alternatively, you can synchronize your workarea to 
send changed resources to the server. 
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Note 
It is mandatory to publish the Playback settings resource after activation of tracking. 

  Training available 
This content is available as interactive training in the SAP Enable Now Info Center. 

 

4.5.1 Reports Overview 

Reporting helps you understand various aspects of user activity with your learning contents. 

There are the following reports: 

Report Description Interface type 

Engaged Unique Users 
Shows the users who have engaged 
with content. 

Graphic 

Delivery Channel Report 
Displays from which channel the 
learning content was started. 

Graphic 

Content Visits 
Gives an overview of which content 
was mostly consumed. 

Graphic 

SAP Companion Usage Report 
Shows the usage and sharing of SAP 
Companion content. 

Graphic 

SAP Companion for desktop Usage 
Report 

Shows the usage and sharing of SAP 
Companion for desktop content. 

Graphic 

Guided Tour Playbacks 
Shows the interactions with guided 
tours in SAP Companion and SAP 
Companion for desktop. 

Graphic 

Guided Tour Dropouts 
Displays how often guided tours 
have been left before the last step. 

Graphic 

Context Help Visits 
Displays the usage of help tiles and 
hotspots in SAP Companion. 

Graphic 

User Report 
Shows the learning progress made 
by users. 

Classic 

User by Assignment 
Shows the learning progress made 
by users within a specific 
assignment.  

Classic 

https://enable-now.sap.com/ic/auth/ext/index.html?case=documentation&source=manager_manual&show=group!GR_F8BA0FC968CD2EB9#group!GR_487D47AC4CA88890
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Report Description Interface type 

User by Progress 

Helps track the average overall 
learning progress within all assigned 
content for users, roles, or 
organizational units. 

Classic 

Lesson Report 
Displays the learning progress made 
by users in specific lessons. 

Classic 

Lessons by Assignment 
Displays the learning progress made 
by users in lessons of a specific 
assignment. 

Classic 

Lesson Step Report 
Helps you identify lesson steps and 
macros with a low user success rate 
to be optimized. 

Classic 

Objects in Editing 
Shows how often a certain object 
was edited, and by how many users. 

Graphic 

Learner Feedback 

Enables you to export the feedback 
users have given using the feedback 
functionality of the trainer or SAP 
Companion. 

Classic 

Status Report 
Gives an overview of the statuses 
that tasks are currently in (object-
related and free tasks).  

Classic 

Server Statistics 
Shows an overview of user 
registrations in your instance. 

Classic 
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4.5.2 Classic Report Interface 

Navigating to a report with the classic interface, the initial selection dialog will appear where you can specify criteria 
the report shall be based on. The range of criteria slightly varies by report type. 

Control Description 

Report 

If you have already saved one or more filters for the 
selected report type, you can select it from the 
dropdown list. The relevant criteria will be loaded 
automatically. 

Lesson Types 
Exclude content types from report by clicking the 
appropriate symbol. Excluded content types will be 
displayed crossed out. 

Time Period 

Define a time period for the report data that you want to 
display. Select the preferred time period definition using 
radio buttons. 3 options are available: 

• Time period by date 
Specify a time period using from date to date. Click 
the date fields to display the calendar picker and 
select a date. 

• Time period of last time units 
Specify a time period as a number of time units 
until now (for example, the last five days). Select 
the time unit from the dropdown list and enter a 
digit into the input field to define the number of 
time units. 

• All time  
Select to display all data without specifying a time 
period. 

Assignment 
Select an assignment for the report from the dropdown 
list. 

Workarea Select a workarea for the report from the dropdown list. 

Selected Object 
Click Change... to select an object including its child 
objects for the report. 

Selected Identity 
Click Change... to select a user, role, or organizational 
unit for the report. 
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Filtering report results 

1. Select Filter:... button on the top left. 

2. Adjust the criteria. 

3. Confirm. 

Saving reports 

Saved reports allow you to save the current filter set and quickly switch between already saved reports. You can 
switch between different report types without navigating to them through the Reporting menu and setting filters 
again. This works only with classic reports. 

1. Navigate to a report and adjust the filters as required. 

2. Select Save on the top right of the screen. 

3. Specify a Name for the report. 

4. Confirm.   

Exporting reports 

1. Navigate to the required report. 

2. Select XLS Export or CSV Export on the bottom right of the screen. 

3. Depending on your browser, a Save As or similar dialog opens. Choose where you want to save the report and 
confirm. 
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4.5.3 Graphic Report Interface 

Graphic reports have 3 ways for displaying report data: 

• Chart view 
Displays a bar chart of the results and a legend beside it. 

• Table view 
Displays a table with the report results in a more classic way. You can sort the contents ascending or 
descending by selecting a column header. 

• Chart and Table view 
Displays a combined view including chart and table.  

On top of the graphic reports there are special values showing totals and averages.  

Filtering report results 

The range of filter criteria varies by report type. Filters can be shown directly as dropdowns or behind the Filter... 
button. 

For any graphic report you can choose Workarea.  

 Note 
• If you want to see a combined report for all workareas, select All Workareas.  

• The _system workarea is not included in the drop-down list. 

• Deactivated workareas are also not shown in the drop-down list. 

• You can only see the workareas you have permissions for. 

See specific report chapters for more details. 

Exporting reports 

1. Navigate to the required report. 

2. Select Export and choose one of the options: 

• Data as Excel Sheet 

• Data as CSV File 

• Chart as Image 

3. Depending on your browser, a Save As or similar dialog opens. Choose where you want to save the report and 
confirm. 
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4.5.4 Engaged Unique Users 

The Engaged Unique Users Report displays the users who have engaged with content. Hover over the graphic or 
open the table view to see the details. 

You can set the following filters for the report:  

• Date Range 

• Interval 

• Workarea 

• Channel 

• User, for example, individual users, roles, or organizational units 

On top of the report there are aggregated numbers for: 

• Total Users 

• Low - the lowest number of users within the selected timeframe  

• Peak - the highest number of users within the time frame 

• Delta Users - the difference in number of engaged users from the start of your selected timeframe to the end 
of it 

• Trend - the change of engaged users within the timeframe in percentage 

You can also adjust the filters on the ribbon above the graph area once you specify them. 

 Note 
This report only supports GMT time zone. This restriction also affects the XLS export.    

4.5.5 Delivery Channels 

The Delivery Channel Report shows from which channel the learning content was started. 

A line chart shows the number of users and content interactions depending on the dimension that you chose to 
display. Hover over the graphic or open the table view to see the details. 

You can set the following filters for the report: 

• Workarea 

• Date Range 

• Interval to set the granularity of the results 

• Delivery Channel, for example, SAP Companion for desktop 

• Interaction Type (learning content events), for example, Simulation (Demo Mode): Started or Book Page 
Opened 

• Language of the learning content 

• User, for example, individual users, roles, or organizational units 
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You can also adjust the filters on the ribbon above the graph area once you specify them. 

There are the following dimensions for the chart: 

• Users in Chart 
Shows the number of users for different channels. 

• Interactions in Chart 
Shows the aggregated number of interactions for different channels. This includes all interaction types that 
you select in the filter.  

• Totals in Chart 
Shows the totals of users and interactions.  

You can combine the dimensions to display, for example, users and the total number of users, or users and 
interactions on the graph at the same time. If you select all 3 dimensions, you will see the number of users, 
interactions and their totals displayed. To deselect a dimension, click it again. 

4.5.6 Content Visits 

The Content Visits Report shows which content was mostly consumed from SAP Companion and trainer. Hover 
over the graphic or open the table view to see the details. You can change the number of results on the graphic by 
readjusting the filters. 

You can set the following filters for the report: 

• Workarea 

• Date Range 

• Interaction Type (learning content events), for example, Simulation (Demo Mode): Started or Book Page 
Opened 

• Language of the learning content 

• User, for example, individual users, roles, or organizational units 

• Limit the number of results on the graphic   

You can also adjust the filters on the ribbon above the graph area once you specify them. 

4.5.7 SAP Companion Usage 

The SAP Companion Usage Report displays the usage and sharing of SAP Companion content. 

To evaluate the adoption of the target application it is important to know how often SAP Companion and its content 
have been started and shared with other users.  

 Note 
The SAP Companion tracking has to be activated before gathering consumption data. Please read the document 
SAP Companion Integration Guide on SAP Help Portal. 

https://help.sap.com/viewer/product/SAP_ENABLE_NOW
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There are the following controls: 

• Workarea drop-down: 
In the first drop-down box you can choose for which Workarea you want to see the report. Select the workarea 
and click Apply Ranges  for the changes to take effect. 

• In the second drop-down you can decide to display the object usage count in ascending (Show Top) or 
descending (Show Last) order.  
In the third drop-down box you can determine the number of entries to be displayed in the chart view and the 
table view. 

• Apply Ranges: 
Select the button to refresh the data of the report after changing the entries in the drop-down boxes. 

4.5.8 SAP Companion for desktop Usage 

The SAP Companion for desktop Usage Report displays the usage and sharing of SAP Companion for desktop 
content. 

To evaluate the adoption of the target application it is important to know how often SAP Companion for desktop 
and its content have been started and shared with other users.  

 Note 
The SAP Companion for desktop Usage Report has to be activated for SAP Companion for desktop in the Producer 
settings. Activate the SAP Companion for desktop Tracking setting under SAP Companion for desktop Playback 
Settings -> General -> Advanced. 

There are the following controls: 

• Workarea drop-down: 
In the first drop-down box you can choose for which Workarea you want to see the report. Select the workarea 
and click Apply Ranges  for the changes to take effect. 

• In the second drop-down you can decide to display the object usage count in ascending (Show Top) or 
descending (Show Last) order.  
In the third drop-down box you can determine the number of entries to be displayed in the chart view and the 
table view. 

• Apply Ranges: 
Select the button to refresh the data of the report after changing the entries in the drop-down boxes. 

• Show Shares: 
Select the button to display how often the corresponding object was shared on the graph. 
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4.5.9 Guided Tour Playbacks 

The Guided Tour Playbacks shows the interactions with guided tours in SAP Companion. Hover over the graphic or 
open the table view to see the details. 

You can set the following filters for the report: 

• Workarea 

• Date Range 

• Delivery Channel, for example, SAP Companion for desktop 

• Language of the learning content 

• User, for example, individual users, roles, or organizational units 

• Limit the number of results on the graphic   

You can also adjust the filters on the ribbon above the graph area once you specify them. 

The Average KPI on the top ribbon shows the number of average playbacks per user. 

To see further details, you can click the required column in the chart view or select Show details in the table view. 

4.5.10 Guided Tour Drop Outs 

The Guided Tour Dropouts displays how often guided tours of SAP Companion have been left before the last step. 
Hover over the graphic or open the table view to see the details.  

You can set the following filters for the report: 

• Workarea 

• Date Range 

• Delivery Channel, for example,  

• User, for example, individual users, roles, or organizational units 

• Product - the application for which you want to see the results 

You can also adjust the filters on the ribbon above the graph area once you specify them. 

The Average Rate KPI on the top ribbon shows the average dropout rate based on all the individual attempts. These 
individual attempts come from the backend and are not displayed in the UI.  

To see further details, you can click the required column in the chart view or select Show details in the table view. 

4.5.11 Context Help Visits 

The Context Help Visits shows the usage of help tiles and hotspots in SAP Companion. Hover over the graphic or 
open the table view to see the details.  

You can set the following filters for the report: 

• Workarea 

• Date Range for the desired timeframe  
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• Language of the learning content 

• User, for example, individual users, roles, or organizational units 

• Product - application for which the help is shown 

• Limit the number of results on the graphic      

You can also adjust the filters on the ribbon above the graph area once you specify them. 

4.5.12 User Report 

The User report displays the learning progress made by a single user or the members of a role or of an 
organizational unit during a specific timeframe. 

Click the name of a user to display the assigned lessons and the individual progress in detail.  

If you selected a single user, the report would display the detailed view directly. 

Notes 

• This report shows only users with existing activity. Users who have not started or processed any of their 
assigned lessons within the specified time period are not shown. Use the report User by assignment to get the 
data of inactive users as well. 

• The overall number of attempts summarizes the number of attempts taken for particular contents. The 
following example will help you better understand the displayed number of attempts: 
 
A user has 10 lessons assigned to them. One of these lessons has been completed.  
If they completed this lesson in one attempt, the number of overall attempts is shown as 0.10. 
However if they took 10 attempts, the overall number of attempts is displayed as 1.00. 

4.5.13 User by Assignment 

The report User by assignment displays the learning progress made by a single user or the members of a role or an 
organizational unit within a specific assignment. 

Click the name of a user to display the assigned lessons and the individual progress in detail.  

If you selected a single user, the report would display the detailed view directly. 
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4.5.14 User by Progress 

The report User by progress displays the average overall learning progress within all assigned content for individual 
users or all members of a role or of an organizational unit. 

Notes 

• This report variant only calculates results from user assignments with Percent Completed as Scoring Method 
since these assignments are intended to be used as individual learning scenarios.  

• The results display the total of all trackable contents in all relevant assignments for each user. The column 
Assigned Lessons (Tests) displays the total number of contents in all relevant assignments for the user. In 
addition, the total number of Tests is shown in brackets.  

• Referenced contents occurring more than one time within user assignments are calculated only once.  

• Only lesson modes that are activated in assignments are used for calculation. 

• The values in column Completed Lessons (Tests) are based on the following rules: 

• Books 
Books are completed when all the pages in the book have been viewed. 

• Lessons 
Lessons are completed when all lesson steps have been processed or when the last lesson step has been 
reached. 

• The values in column Passed are based on the following rules: 

• Lessons 
To pass lesson modes Practice and Test user needs to achieve the amount of points the author has 
specified. The displayed value indicates the percentage of available lessons that have been successfully 
completed. 

4.5.15 Lesson Report 

The Lesson report displays the learning progress made by specific users or the members of a role or of an 
organizational unit in selected learning contents. 

Click the name of a lesson to display users and their individual progress in detail.  

If you selected a single lesson, the report would display the detailed view directly. 

Notes 

• This report shows only lessons with existing activity. Lessons which have not been started or processed within 
the specified time period are not shown. Use the report Lessons by assignment to get the data of lessons with 
no activity as well. 
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4.5.16 Lessons by Assignment 

The report Lessons by assignment displays the learning progress made by specific users or the members of a role or 
of an organizational unit in the lessons of an assignment. 

Click the name of a lesson to display users and their individual progress in detail.  

If you selected a single lesson, the report would display the detailed view directly. 

4.5.17 Lesson Step Report 

The Lesson step report displays the average progress of all users in steps and macros of one or more lessons. This 
will help you to identify lesson steps and macros with a low user success rate to be optimized. 

Notes 

• This report variant displays the overall success rate of all users in the lesson steps and macros. The columns 
Result and Time Needed display the average value of all users who have processed the step. Thus, the 
displayed values can vary strongly depending on the number of users in your identity selection. The higher the 
number of users, the more valuable the results might be in identifying difficulties in learning contents or the 
learning behavior of users.  
The following table shows a very simplified example for the dependency of the user amount: 
 

Total number of users Users passed Users not passed Success rate 

2 1 1 50% 

100 99 1 99% 

• To gain information about the number of active users for specific lessons, check the results of the report 
variant Lesson reports. 

4.5.18 Objects in Editing  

The Objects in Editing Report provides an overview of objects being currently edited by users. This enables you to 
easily identify how many objects each user has in editing mode. You can also contact users directly from this report 
to remind them to finish editing objects in time. Hover over the graphic or open the table view to see the details. 

You can set the following filters for the report: 

• Workarea 

• Users, for example, individual users, roles, or organizational units 

You can also adjust the filters on the ribbon above the graph area once you specify them. 

To see further details, you can click the required column in the chart view or select Show details in the table view. 

When you are in the detailed view, you can Show object in workarea and send a message to the editors. 
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Prerequisites 

The Objects in Editing Report requires the permission Editing Report: View, per default available for: 

• Master Authors 

• Project Manager 

• Report Viewers 

• Administrators 

4.5.19 Learner Feedback 

The Learner Feedback report enables you to export feedback that users have given using the feedback functionality 
of the trainer or SAP Companion. 

 Note 
Note that scheduled subscription for automatic data creation might fail due to the size of the file attachment 
created. Per default most mail services only accept attachments of a size from 10 to 30MB.  

This result set is not displayed in the browser interface. 

It is meant to be exported only. After confirming the initial filter dialog, please select in which format you want to 
export the data. 

The generated data file contains the following data columns: 

• Title 
Either caption of the object the feedback is on (when feedback comes from trainer) or string "Learner 
Feedback" when feedback comes from Learning / SAP Companion. 

• Comment 
The feedback comment of the user. 

• Rating 
The user rating (Learning / SAP Companion only). 

• Type 
The type of the commented object. 

• UID 
The unique id of the commented object. 

• Caption 
The caption of the commented object. 

• Product 
The "Product" property of the object (if defined). 

• Version 
The "Version" property of the object (if defined). 

• System 
The "System" property of the object (if defined). 

• Language 
The object language. 
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• User 
The authentication and the full name of the user who has given the feedback. 

• Time 
The time the feedback has been sent to server. 

• Source 
The playback engine in which the feedback has been given (trainer or Learning / SAP Companion). 

These columns contain all feedback comments which have been made and may be restricted only by the filter 
criteria you selected in the initial filter dialog. 

4.5.20 Status Report 
The Status report provides an overview of the statuses that tasks are currently in (object-related and free tasks). 
You can check whether the planned timeframe for content creation and/or project phases can be adhered to or in 
which status specific tasks are currently "stuck".  

However, this requires a productive use of statuses in your Manager instance (independent or with the usage of 
workflows). 

There are 3 levels of status report you can drill down to: 

1. Status report by workareas 

2. Workareas by object types 

3. Details of object types. 

Status report by workareas 

The initial list shows the aggregated number of tasks having specific status per workarea. Free tasks are shown on a 
separate line. To get more details on a specific workarea, select the required row. 

Workarea by object type 

Once you have selected a workarea, the list displays the amount of object types having specific status within this 
workarea. To get more details on an object type, select the required row. 

Details of object type 

Once you have selected an object type from previous sub list, all tasks connected with this object type are listed. 

You can see the task Title, Object Title, and the Status of this task. This is the last level and there is no further drill-
down. 

Exporting report data 

On each report level you have the options to export currently displayed result set as Microsoft Excel or CSV file. 

1. Navigate to the report level as required. 

2. Select XLS Export or CSV Export. 

3. Depending on your browser, a Save As or similar dialog opens. Choose where you want to save the report and 
confirm. 
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4.5.21 Server Statistics 

The Server Statistics report shows an overview of user registrations in your Manager instance. 

These statistics are based on database information, so they are independent from Manager version updates. 

The availability of categories depends on your system's statistics. 

Note 
To have statistics on Learners' activity, you need to activate tracking in Producer. See Reporting chapter for 
details. 

Category Description 

Registered users The number of users registered in the users area. 

Active users The number of users flagged as Active. 

Number of users having write permissions  The number of users with the Content: Edit permission. 

Authors within last month 
The number of users who edited contents within the last 
month (last 30 days). 

Authors within last quarter 
The number of users who edited contents within the last 
quarter (last 90 days). 

Authors within last year 
The number of users who edited contents within the last 
year (last 365 days). 

Number of users having read permissions 
The number of users with the Content: View permission. 
This also includes users with the Content: Edit 
permission. 

Learners within last month 

The number of users who accessed contents within the 
last month (last 30 days). 

*Only shown if Tracking is activated. 

Learners within last quarter 

The number of users who accessed contents within the 
last quarter (last 90 days). 

*Only shown if Tracking is activated. 

Learners within last year 

The number of users who accessed contents within the 
last year (last 365 days). 

*Only shown if Tracking is activated. 

Producer usage within last week 
The number of times Producer was opened through the 
Manager interface within the last week. 
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Category Description 

Producer usage within last month 
The number of times Producer was opened through the 
Manager interface within the last month. 

Producer usage within last year 
The number of times Producer was opened through the 
Manager interface within the last year. 

Instant Producer usage within last week 
The number of times Instant Producer was opened 
through the Manager interface within the last week. 

Instant Producer usage within last month 
The number of times Instant Producer was opened 
through the Manager interface within the last month. 

Instant Producer usage within last year 
The number of times Instant Producer was used within 
the last year. 

Instant Recorder usage within last week 
The number of times Instant Recorder was used within 
the last week. 

Instant Recorder usage within last month 
The number of times Instant Recorder was used within 
the last week. 

Instant Recorder usage within last year 
The number of times Instant Recorder was used within 
the last week. 

SAP Companion for desktop usage within last week 
The number of times SAP Companion for desktop was 
played back through the Manager interface within the 
last week. 

SAP Companion for desktop usage within last month 
The number of times SAP Companion for desktop was 
played back through the Manager interface within the 
last month. 

SAP Companion for desktop usage within last year 
The number of times SAP Companion for desktop was 
played back through the Manager interface within the 
last year. 
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4.5.22 Report Scheduler 

The Report Scheduler provides an overview of all automated reporting jobs you created. You can modify or remove 
jobs from the list. 

Rescheduling 

1. Select Reschedule... for the required job. 

2. Adjust the Time and Recurrence Pattern in the Scheduler dialog box that opens.  

3. Confirm. 

Deleting 

1. Note: there is NO deletion confirmation. 

2. Select Delete for the required job. 

The job is deleted, but the items it is associated with stay. 

4.6 Learner view 

The Learner view is the central starting point to view and process published learning content available to you. You 
can access it from the home dashboard. Here all learning content is provided within Courses, each depicting a 
collection of learning materials which are common in their topic context or their learning target. 

Note 
• The Learner view interface is highly dependent on individual learning scenario settings. Some of the controls 

described below may not be available to you. 

• Please read the section Learner Settings of this guide to configure your browser for flawless content playback. 

Searching for content 

Use Search field to find specific content within all courses assigned to you. 

Depending on your scenario settings, the checkbox global might be available. If you activate this option, all 
published content will be searched, not assigned to you as well. 

The course list 

The course list may contain different symbols which are displayed for each course: 

Symbol Description 

 
Course without user information.  
Only the learning contents are listed without additional progress information.  

 
Course displaying your learning progress.  
Your overall progress within the course is displayed as a progress bar in the 
course list and individually for each content entry within the contents area. 
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Symbol Description 

Within the content area additionally a second bar displays the progress for 
objects of the type Test Mode. In case a list entry is a collection object like a 
group or a book the progress bar displays the progress summary 
of  subordinated objects. 

 

Course displaying the number of overall visits. 
A number is displayed next the course entry and as well next to the list entries of 
the content area representing the overall amount the item has been accessed by 
users. It is more or less a traffic counter indicating highly frequented courses 
and contents. High access frequencies may stand for popularity as well as for 
difficulty. 

The content area 

Depending on the course setup the content area may display different  scenarios: 

• Introductory description only 
In this scenario you will see only the course description with the buttons to start the course or to display the 
according QR code. 

• Introductory description with a list of contained lessons 
In this scenario you will see the course description and the buttons Start and QR Code within the upper part of 
the content area followed by the list of course contents. The structure of the list may vary as follows:   

○ Flat list 
A flat list of contents is displayed. Click an entry to start it directly or click Start to start the whole course. 

○ Expandable list 
Each list entry is prepended by an arrow symbol. Click it to expand or collapse it and access 
subordinated content levels. Click any entry to start it directly or click Start to start the whole course. 

Viewing your progress 

Optionally to the learning progress displayed in the course list you may have displayed the item show report on the 
top right of the content area. This enables you to switch the content view into a flat list displaying all content of the 
course, each with your individual learning progress. 

This enables you to check your personal state in the learning scenario as well as to search for content you may have 
missed to process.  

Furthermore, this view enables you to reset your learning progress for individual items to start them again from the 
beginning. To do so, click restart for the content to be reset.  

To switch back to normal content view click show standard. 

Focused learning by a Learning path 

It may happen, that objects which are not at the beginning of a course do not play or are not visible. In this case the 
course may be set as focused along a Learning path. This means you will have to process the course objects one 
after another beginning with the first object. Each time you have processed an object successfully you will be able 
to view / start the next object. 
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4.7 Bookpage Editor 

The integrated book page editor enables you to edit book pages directly in the browser interface of the Manager. 

Opening the book page editor 

1. Select a book page in the object tree. 

2. Click Start editing. 

3. Click Edit to open the book page in the book page editor. 

4.7.1 General 

A book page is an HTML page on which different content can be filed in different forms and accessed. 
It can accommodate various buttons for launching simulations and opening documents that can then be linked 
within a workarea. Media files for audio and video formats can also be integrated and can be presented using 
appropriate playback applications. But information in traditional form, as an image or text, can also be created on a 
book page. 

A number of book pages can be combined in a book. A book can thus be understood as a type of group. Once a book 
has been created, it can be displayed in the book reader, which the learner can use to flick through the pages and 
launch and work through content. 

Diverse, easy to create applications 

Book pages make it possible to create courses on a particular step quickly by inserting objects into the book page 
and linking them to content. 
In this way you can amalgamate the content of a number of simulations by combining different modes and 
documents. However, because of the diverse ways of presenting information on book pages, it is not absolutely 
necessary to integrate simulations into a book page. You can also design a book page using simple texts or video 
files and thus provide these to the learner in addition to the individual simulations; also, you can integrate them 
entirely independently as an extension of the step. 

Didactic benefit 

Books and book pages promote independent learning and a stronger engagement with the facts as learners are 
able to use and discover the content individually. They allow students to work with the content that is relevant to 
them and ensure variety due to different information formats. 
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4.7.2 Creating a Book 

Create a book to structure your book pages. For more information, see the chapter Creating a Content Object. 

Proceed as follows: 

1. In the Explorer select New Object . 
An overview of all objects opens.  

2. Select New Object  in the toolbar. 
An overview of all objects opens.  

3. Select Book . 
The New Book dialog box opens. 

4. Adapt the following settings:  

1. Name: 
Enter an object name.  
The default name is the object type with an ID.  

2. Language: 
Select a language from the dropdown box. 

3. Template: 
Select a template. 
Choose Change... to open a selection dialog box and select a template from the workarea. Select No 
template to create an object without a template. 
If a template has already been used, that template is selected by default. 
See the chapter Templates for Content Objects. 

5. Choose OK to create the object. 

The book is inserted into the structure. You can now insert book pages into your book. 

To structure your book, you can insert further books or groups into your book to create subchapters. For correct 
tracking of books, we recommend that you use groups for subchapters. 

4.7.2.1 Defining a Book Page as Content Page 

You can create a page containing introductory information or a table of contents for a book. Users can access the 
page at any time in the book reader, the page can be defined as a content page for the book. The book page can 
then be launched directly in the book reader using a button in the control bar. 

To specify a Content Page, select your book in the Explorer. Then go to Content Page in the object editor's 
subcategory book reader and select the Edit Link... option. You can now specify your book page in the open 
dialog. Confirm this by clicking OK. 
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4.7.2.2 Subcategory book reader 

The subcategory book reader provides settings to specify the functionality of the book reader's control bar. This 
allows you to customize them to your book's individual requirements and hide any functions you do not want. Select 
a book  in the explorer and open the subcategory in the object editor. 

 Recommendation 
You can create objects on your book page to control the book. For example, to go to the next and the previous 
page. This allows you to hide the buttons in the control bar. 

The following settings are available: 

• Hide Book Panel: 
Activate this option to hide the book panel. 

• Open Book Directly: 
If this option is activated the book will open in the book reader as soon as it is selected in the tree structure in 
the library. If the option is deactivated, the book reader is started by selecting the Open Book button in the 
content view of the library. 

• Hide Audio Controls: 
Activate this option to hide the buttons for controlling the audio and volume. 

• Hide Navigation Controls: 
Activate this option to hide the buttons for navigating through the book pages.  

• Hide Play/Pause Control: 
Activate this option to hide the buttons for pausing and starting the playback. 

• Hide Index Page Control: 
Activate this option to hide the button for opening a content page. 

• Hide Search Button: 
Activate this option to hide the button for opening the search dialog box. 

• Hide Table of Contents Control: 
Activate this option to hide the table of contents dropdown menu. 

• Hide Progress Control: 
Activate this option to hide the progress bar for displaying how the user is progressing in the book. 

4.7.2.3 Alternative Navigations on Book Pages 

Actions can be used to allow navigation on book pages independently of the control bar of the book reader. These 
are universal properties and allow the user to jump between book pages and units. 
If you would like to use such navigations, it is recommended that the objects are inserted into a book page 
template. By doing so, they can be used for the entire book and ensure consistency. 
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Actions as link targets 

To enter a link target, proceed as follows: 

1. Insert a book page object. 
For example: Image, Active Area.  

2. Select the parameter Link -> Link to... 

3. Select Edit Link... . The editing dialog box appears.  

4. Select Actions button. 

5. Select the desired action from the Actions drop-down list. 
For example: Next book page, Play audio 

More information about link actions can be found under Link Actions for trainer and book reader. 

Object actions of the page object 

To specify an object action for a page object, proceed as follows: 

1. Insert a book page object, for example Image or Active Area. 

2. Under subcategory Actions, choose an action. 
For example: On Click, On Show 

3. Select the page object from the first drop-down list. 

4. Select a behavior from the second drop-down list. 
For example: Next, Share. 

More information about actions can be found under Object Actions. 

Disabling the book navigation 

For a book page you can specify, that the book reader control bar is deactivated. This allows you, to specify 
required content. After completing the content, navigation can be enabled. 

When selecting the page object for an object action, the following behaviors are available: 

• Disable Book Navigation: 
Disables the navigation of the control bar and other navigation controls on the book page. 

• Enable Book Navigation: 
Enables the navigation of the control bar and navigation controls. 

4.7.3 Creating a Book Page 

Create a book page for your book or as single book page. For more information, see the chapter Creating a Content 

Object. 

Proceed as follows: 

1. Select a Book  or a Group  in the workarea structure to insert the book page. 

2. Select New Object  in the toolbar. 
An overview of all objects opens. 



SAP Enable Now Manager, Cloud Option 
Interface 

 
 CUSTOMER  148 

 

3. Select Book Page . 
The New Book Page dialog box opens. 

4. Adapt the following settings:  

1. Name: 
Enter an object name.  
The default name is the object type with an ID.  

2. Language: 
Select a language from the dropdown box. 

3. Template: 
Select a template. 
Choose Change... to open a selection dialog box and select a template from the workarea. Select No 
template to create an object without a template. 
If a template has already been used, that template is selected by default. 
See the chapter Templates for Content Objects. 

5. Choose OK to create the object. 

The book page opens in the book editor. Now, you can insert your content. Read the following chapters on this 
subject. 

4.7.3.1 Specifying the Design 

After creating the book page, it is opened in the book page editor having the default style. You can use the Style 
parameter to select the design you want in the object editor and customize it accordingly. 

A style defines the background design, the design of the buttons for the linked learning content as well as the 
appearance of the text box. Selecting a different skin change all of these objects. Before you select a skin, it is 
advisable to insert some objects to be able to assess the overall design. 

Customizing the background 

You can customize the chosen background design as you like. You can use an available skin as a template which 
can then be edited once it has been selected. 

Various settings are available in the book page editor for displaying the book page: 

• Image: 
This parameter can be used to define an individual background image which replaces the image of the skin 
that has been set.  

• Width and Height: 
Specifies the book page's width and height. The values are stated in pixels. 

• Page Color (Design): 
Specifies the book page's background color. It is recommended that you enter a value in this field if you 
choose not to use an image for the book page's background or if you use an image that does not cover the 
entire book page itself. 
When using the Page Color, activate the Image setting without selecting an image. This is necessary to hide 
the page image or color of the book page style.  
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• Background Color (Design): 
Specifies the color of the outer surface surrounding the book page. Select the color preview to open the Color 
Selection dialog box. Select Transparent , if you do not want to use any color. 

• Border Width (Design): 
Specifies the width of the border for the book page. The value is defined in pixels. If no border is to be 
displayed, the value is to be set to 0.  

• Border Color (Design): 
Specifies the color of the book page's border. Select the color preview to open the Color Selection dialog box. 
Ensure that you have previously specified a width for the border so that it is actually displayed.  

• Border Style (Design): 
Specifies the style of the book page's border that you can select from the dropdown box.  

You can call up the design parameters at any time while a book page is being created and amend them by selecting 
the background. 

4.7.3.2 Table of Contents for Book Pages 

A book page can have a table of contents faded in, which is displayed in the book page background independently of 
the book reader. 

The table of contents consists of a bar displaying groups or book pages belonging to the first sub level. The other 
groups and book pages can be launched from an option menu that is faded in using the button on the right-hand 
side of the book page. Clicking a group name opens a menu displaying the group content. 

The table of contents on the book pages can be used as an alternative to the table of contents in the book reader. 
This is accomplished by deactivating the book reader table of contents. 

 Recommendation 
The width of the table of contents is restricted to the width of the book page. That is why when setting up the 
groups it is recommended that short names or chapter numbers be issued, so that as many groups as possible can 
be displayed on the bar. 

Settings 

A book page table of contents can be defined using the Table of Contents subcategory. This offers you the following 
functionality: 

• Show: 
This function can be used to activate the table of contents for the book page. 

 Note 
The table of contents must be defined for each individual book page. If all of the book pages of a book are to 
receive a table of contents, then it is advisable to define the table of contents for one book page and then use this 
book page as a copy template when creating new book pages. 
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• Position: 
The table of contents bar can be faded in directly above the book page or in the window header. Use this 
parameter to select the appropriate position. 

• Menu Structure: 
These options can be used to define the way in which the content is displayed in the menu. 

○ Flat structure: 
The groups and book pages are displayed in a flat structure so that all groups and book pages are 
displayed on one level.  

○ Indented contents: 
The contents of a group are shown indented relative to the group itself. This increases clarity within a 
complex content structure.  

4.7.3.3 Hiding a Book Page in Table of Contents 

You can hide a book page in the table of contents of the control bar. This allows you to show only the main pages in 
the table of contents and to hide additional information. 

The book page is not numbered in the table of contents and is not counted in the book page progress bar. The user 
can navigate to the book page. Afterwards, the book page is shown in the table of contents. 

Proceed as follows: 

1. Select a book page in Explorer. 

2. Activate the option Hide in Table of Contents in object editor. 

4.7.3.4 Further Properties of a Book Page 

Show Navigation Arrows 

Instead of using the command bar to scroll through the book pages, you can do so using the buttons either side of 
the book page. This makes it possible to work more intuitively with the book. 
To display the buttons, activate the Show Navigation Arrows option for the book page in the book page editor. 

Display Duration 

This option allows you to determine the duration that a book page should be displayed in the book reader. Once the 
time has elapsed, the book reader will automatically jump to the next book page. This feature allows you to play 
books as a slide show or an automatic presentation. The value can be set in seconds. 

4.7.3.5 Merging Book Pages 

Merging book pages allows content from a different book page to be added to the content of the currently selected 
book page. This is sensible, for example, when applying recurring elements or to have a structure available created 
using construction lines. 



SAP Enable Now Manager, Cloud Option 
Interface 

 
 CUSTOMER  151 

 

When merging book pages, the desired objects are inserted on the book page, but with the added book page 
continuing to have its own separate existence. 

This is how you add the content of a one book page to another book page: 

1. In the book page editor, open the book page to which the content is to be added. 

2. Select the Merge Book Pages  option in the toolbar. 

3. A dialog will now be displayed with the overview of the Workarea structure in which you can determine the 
book page of your choice. The book page currently open will be shown grayed out in this structure. 
Click on the book page and then on OK to confirm. 

4. In the next step, you will be presented with a dialog displaying the objects belonging to the chosen book page. 
By selecting in the selection boxes, you can determine which objects you would like to apply to the open book 
page. Confirm your selection by clicking on OK. 

The objects are now inserted into the book page located on the same position as in the selected book page. The 
objects also receive the book page style of the book page to which they were added. 

4.7.3.6 Page Sound 

The Page Sound parameter enables background music or an audio commentary to be inserted in a book page. The 
learner can start the audio file in the book reader in the control bar. 

For information on how to add and edit an audio file, refer to the section on Editing Audio. 

4.7.3.6.1 Adding Audio to Book Pages 

You can insert audio as Page Sound to your book pages by using the Add Audio dialog box. See also Add Audio 

Dialog Box. 

To record audio for your book pages, proceed as follows: 

1. Select Add Audio  in the toolbar to open the Add Audio dialog box. 

2. Select a book page from the page list. 

3. Select Start Recording . 

4. Speak your audio text. 

5. Select End Recording . 

6. Select the next book page and record your next audio text. 

7. Once you have recorded all your audio texts, select OK to close the dialog box. 

Alternatively, you can insert text to speech in the Add Audio dialog box. Open the Text-to-Speech dialog box by 
selecting Edit Text-to-Speech... . 
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4.7.3.6.2 Importing Audio 

Importing audio files allows you to easily integrate audio files into a simulation. 

 Note 
By importing an audio file, the existing audio of a step will be overwritten. 

Proceed as follows to import an audio file: 

 Note 
During import the audio files are converted into the editing format WAV with the default audio format. 

1. Select the book page for which you want to import an audio file. 

2. In Page Sound parameter, select Import Audio File... . 
There are two options: 

• Insert Audio File... 

• Insert Audio from Workarea... 

3. A dialog box opens. Select the file. 

4. Select OK to insert the file. 

4.7.3.6.3 Recording Audio 

Audio recording allows you to narrate your own texts with the microphone. 

Requirement 

For audio recording, a microphone is necessary. Connect this first before starting to record. 

Recording audio 

Proceed as follows to execute the recording: 

1. Select Record Audio... . The audio editor and the recording dialog box opens. 

2. Select Start Recording . 

3. Read out your text. 
During the recording, a sound level meter shows the volume. You also see the spoken text as an audio track. 

4. Select End Recording . 

5. Select Ok to close recording dialog box. 

For more information, refer to the Recording Dialog Box chapter. 

 Note 
During the recording of an audio file, the existing audio of a book page will be overwritten. 

Read out the full text for your recording because it is not possible to record the text in sections. Any unwanted parts 
can be cut out afterwards. If you are not satisfied with the outcome, record the text again. 



SAP Enable Now Manager, Cloud Option 
Interface 

 
 CUSTOMER  153 

 

 Recommendation 
If the recording contains background noise, then it is recommended that you edit the audio file with the dynamic 
editor to improve the sound. 

4.7.3.6.4 Generating Text-to-Speech 

We recommend that you convert text to speech after a project has been edited. Steps should be converted 
individually. If a step contains several macros (for example, several steps are connected), then the texts will be read 
out one after the other in the order in which the macros are arranged. 
If the bubble texts of a simulation are already converted into text to speech, they are available when you open the 
editor. 

Proceed as follows to convert text to speech: 

1. Open the text to speech editor using the Edit Text-to-Speech...  button. 
Refer to the chapter Text-to-Speech Dialog Box.  

2. Insert a text in the text field or edit the available text. 

3. Specify the duration of the silence to be inserted at the beginning of the audio file. 

4. Choose the voice, its pitch and speed and preview the audio. 

5. Confirm the input. The dialog box is closed and the audio file is generated. 

 Note 
If a step contains several macros, the individual actions and associated spoken texts will run asynchronously in 
relation to one another. This is because the texts are converted into an audio file and are not linked to the actions. 
It is therefore advisable to only use one macro per step. 

 Note 
Text-to-Speech generation is not available in the web-based Book Page Editor. 

4.7.3.6.5 Subtitles for Text-to-Speech 

For the Text-to-Speech audio of your book pages, you are able to display subtitles. The subtitle is displayed in the 
footer of the book reader and shows your Text-to-Speech text. 

Subtitle settings 

The following settings are available in Settings  under Playback Settings -> book reader -> Visual properties: 

• Show subtitles: 
Activate the option to show subtitles for Text-to-Speech. 

• Design of the subtitles 
For the subtitle textbox you can specify the design with the following settings: 

○ Font family 
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○ Font size 

○ Text color 

○ Alignment 

○ Background color 

4.7.3.7 Templates for Book Pages 

 

Book page templates are special types of book pages, which define a layout and general objects for creating book 
page content. Templates are useful for saving time and for ensuring uniformity for newly created objects in a 
complex book and to support the content creation of many authors. 

4.7.3.7.1 Creating a Book Page Template 

You should create a template before creating a book. This ensures consistency and avoids the need to make 
changes afterwards. For further information, see the chapter Creating a Content Object. 

To create a book page template, proceed as follows: 

1. Select your template group  in the workarea structure to insert the book page template. 

2. Select New Object  in the toolbar. 
An overview of all objects opens.  

3. Select Book Page . 
The New Book Page dialog box opens. 

4. Adapt the following settings:  

1. Name: 
Enter an object name.  
The default name is the object type with an ID.  

2. Language: 
Select a language from the dropdown box. 

5. Select OK to create the object. 
The book page is opened in the book editor. 

6. Select a Book Style in the Style parameter. 

7. Create your standard elements of the template. 

8. Select Save and close the book page. 

9. Open the Explorer. 

10. Select Book Page Template  as Subtype for the created book page. 
The icon of the object changes and displays the template type. 
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 Note 
An existing template cannot be used to create a new template. Always create a template without using other 
templates. 

Tips for creating templates 

• Create a group for your templates. Set the group to hidden, in order to hide it during content playback. 

• Lock the position of your objects if you want to prevent objects from being changed accidentally. 

• Use guides to create a layout grid. 

• Define Text Styles for the content, to ensure consistency and straightforward adaptation. 

• Insert the layout and design relevant objects. 

4.7.3.7.2 Defining a Book Page Template 

You can use a book page template to create your book page content. There are different ways to activate a 
template for a book page: 

• Define a default template for creating new book pages 

• Select a template when creating a new book page 

• Set a template in an existing book page 

Select a default template 

You can select a default template, which is always used for creating new book pages. This can be done as follows: 

1. Open the area Producer -> Templates in the Settings  dialog box. 

2. In the Book Page parameter, select Edit Link...  
The object selection dialog box opens. 

3. Select the Book Page Template  and select OK. 

4. Confirm your changes in the Settings dialog box with Apply. 

5. Select OK to close the dialog box. 

When creating a new book page, the template is set by default. Further information is available in the chapter 
Templates for Content Objects. 

Select a template for a new book page 

When creating a book page, you can set a template in the New Book Page dialog box. If a template has been defined 
as standard, you can select an alternative template for an individual page. For further information, see the chapter 
Creating a Book Page. 

Set a template in a book page 

The Page object of a book page contains the setting Template, which displays the activated template. If you want to 
use another template, select the book page from the dropdown box. The property only displays book pages with the 
subtype Book Page Template. 
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4.7.3.7.3 Using a Book Page Template 

The objects of an active book page template have the following characteristics: 

• they are inherited from the template 

• they use the properties as default (green button deactivated) 

• they are highlighted in blue in the objects list 

• they are positioned on the layers behind the objects of the created book page 

• they cannot be deleted - the objects are hidden automatically 

Changing and resetting objects 

The template objects use the defined properties by default, if the template is used for a general book page. You can 
change the template objects for your content as required. 
To change an object, you have to select the specific property by activating the green control in front of the property 
name. 

If you have changed objects, you can reset your changes by choosing the Reset Template Objects in the Edit menu. 
Once reset, the parameters are unspecified (green control deactivated) and the default template is used. 

 Note 
Changed objects keep their status even when objects are changed in the template. Click on Reset Template 
Objects to change the objects in the book page to the current status of the template. 

Tips for using templates 

• If you do not need an object on a book page, hide the object by using the Hide property in the object editor. 

• We recommend that you keep the template objects when the template is used as a book page because the 
objects define a layout.  

4.7.4 Modeling Business Processes 

You can create models for business processes using the BPM Object. The versatility of creation supports complex 
models at several process levels. 

A BPM Object represents a process step here while the combination of several BPM Objects represents the entire 
process. You can use the Connection object to combine process steps in the form of arrows and visualize their 
sequence. 
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4.7.4.1 Creating Processes 

If you want to create a process manually, proceed as follows: 

Structure of a process step 

A process is comprised of BPM Objects that are connected with arrows. You can use text boxes to insert the actions 
and information necessary for a process step via the arrows. 

• Process step: 
Indicates the name of the process step and is displayed in the main field of the object. 

• Role: 
Indicates the role or function for the process step and is displayed in the lower field of the object. 

• Annotation: 
Additional Annotations for a process step can be entered in the respective field. The annotation is displayed by 
clicking the icon in the object. 
Icon: Bubble 

• Link to: 
A link to another book page to access more in-depth information. For example, a process can be created as an 
overview with more in-depth process steps on other book pages. 
Icon: Arrow 

• Attachment: 
Documents, projects, book pages or files can be linked by the attachment. Up to 10 attachments can be 
defined. When opened via the icon, a menu is displayed with all attachments and the selected attachment then 
opened in a new window. 
Icon: Paper clip 
The option Open link in new window allows you to define whether the attachment should open in the same or in 
a new window. The window’s appearance can be defined under New Window Properties. 

The content that is displayed via an icon can be accessed by clicking the icon. 

 Recommendation 
The icons used for the BPM Object are found in the respective book page style. If you want to use icons other than 
the standard icons, they are to be replaced in the respective folder. Make sure to keep the names and size of the 
icons. 

Design of a process step 

• Text Style Role: 
The design of the text and background for the role can be set in the Text Style Role area. 

• Design: 
The background color of the field for the process name and the border of the entire object can be changed in 
the area Design. 



SAP Enable Now Manager, Cloud Option 
Interface 

 
 CUSTOMER  158 

 

4.7.4.2 Connecting Objects 

The inserted BPM Objects can be connected using a Connection object and the process direction shown using 
arrows. A path can be created with an arrow here. This can be either a simple line or a complex structure with 
several path items. 

Defining an arrow 

An arrow object can be customized as follows: 

• Color: 
Specifies the arrow's color. Select the color preview to open the Color Selection dialog box. 

• Thickness: 
Specifies the arrow's thickness. The value is given in pixels.  

• Arrow Head 1 & 2: 
Specifies the arrow's head for each side of the arrow. 

Positioning a path point 

There are path points at the beginning and end of an arrow that allow you to adjust its length and direction. Select 
one of the points and drag and drop it to the desired position on the book page. 

Creating complex paths 

Process structures do not usually just go in a straight line but are much more complex. You can use the Connection 
object to create paths with several path points and corners. Keep in mind that the paths can only be aligned 
horizontally or vertically here. The number of path points is also limited to 10. 

Inserting a path point: 

1. Press and hold the Shift key.  

2. Select the mouse on the point where you want to add the new point.  

3. Drag this point to the position you want.  

Removing a path point: 

1. Press and hold the Alt key.  

2. Select the mouse on the point where you want to remove the point. 
Keep in mind that only points at the end or beginning may be removed. 

4.7.5 Editing Objects 

Various functions are available for the inserted objects, which you can use to edit the design and position of 
individual objects and multiple objects. 
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4.7.5.1 Inserting an Image 

The option Replace Image  of an Image parameter allows you to insert images in an Image or Page object. The 
following options are available: 

• Replace with screenshot of window: 
By moving the mouse over the screen display, specific areas will be recognized and outlined in red. Click on 
the mouse button to select the desired outlined area.  

• Replace with screenshot of object: 
By moving the mouse over the screen display, specific objects will be recognized and outlined in red. Click on 
the mouse button to select the outlined object.  

• Replace with screenshot of area: 
With the mouse, pull the red frame over the desired area and release the mouse button.  

After selecting the area, an editing window will appear where you can adjust as needed. To complete the process, 
click on Confirm Selection . The dialog box will close and the screenshot will be inserted into the HTML editor. 

• Replace with image file... 
A dialog box will open from which you can select an image from a data medium of your choice. Select the 
desired image and click on Open (in the Editor) to insert the image.  

• Replace with image from workarea... 
A dialog box will open, displaying the contents of the workarea. Select the desired image and click on OK (in 
the Editor). 

4.7.5.2 Grouping Objects 

The grouping of objects allows you to group multiple objects. A Group object is created, which can be used for 
animations or to move multiple objects as one object. The group object is also displayed in the object list. 

The following buttons are in the toolbar: 

 Group Objects 

 Ungroup Objects 

To group objects, proceed as follows: 

1. Select all required objects for the group. 
You can use the Ctrl key to select multiple objects. 

2. Select Group Objects. 

To ungroup objects, proceed as follows: 

1. Select the group object. 

2. Select Ungroup Objects. 
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4.7.5.3 Duplicating an Object 

You can use the Duplicate  function to duplicate an inserted object. Settings and shortcuts activated in this 
object are retained and can be reused.  

Select the object and select Duplicate in the toolbar. The duplicate is placed directly above the object and can then 
be positioned and edited on the book page. 

4.7.5.4 Using Guides 

Guides can be used to allow elements to be positioned and aligned with precision. You can use them, for example, 
to create design grids by drawing the guides on an empty book page then using this as a template for creating the 
remaining book pages of your book. 

Guides can be drawn both horizontally and vertically. The following buttons are available in the tool bar for inserting 
the guides 

 Insert Vertical Guide  

 Insert Horizontal Guide  

Once a guide has been inserted, the sizing handle can be used to move it on the book page using drag&drop. 
Clicking on the sizing handle displays the guide. If another object is selected, the guide is deselected. 

An object is aligned with the guide by moving it on the book page. When it is on a level with the guide, the line 
appears gray and the object is automatically positioned level with it. 

 Note 
In order to ensure that objects are properly aligned when dragging & dropping, you can activate the Snap-in-place 
options for objects from the central configuration dialog. The settings can be found under Application -> Book Page 
Editor. 

4.7.5.5 Aligning Objects 

If you have positioned a number of objects on your book page, you can arrange these on one line. The following 
functions are available to you here as a result of which the objects can be arranged on the edge in question: 

 Left Align  

 Top Align  

 Right Align  
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 Bottom Align  

These functions require a reference object to be selected on which the other objects will align themselves. Select 
the reference object and then click on the objects to be aligned while holding the Ctrl key depressed. You can then 
select the desired action in the toolbar. 

4.7.5.6 Resizing Objects 

To obtain uniform objects, you can align their dimensions with those of a reference object: 

 Same Width 

 Same Height 

 Same Size 

To this end, select a reference object with which the other objects will align themselves. Select the reference object 
and then click on the objects to be aligned while holding the Ctrl key depressed. You can then select the desired 
action in the toolbar. 

4.7.5.7 Arranging Objects 

The same spacing can be assigned to objects to arrange them in a consistent horizontal or vertical plane. To do so 
you must first align the objects horizontally or vertically on one line.  

Select at least three objects to be arranged. This is required as two reference objects define a spacing with which 
other objects align themselves.  
Select the objects by clicking on them or draw a selection mask by clicking and holding the mouse button. Then 
click on the button of the function you want. 

Arrange objects horizontally 

 

Equal Horizontal Distribution: 
The spacing between the first object and the second is used as a template for subsequent objects and customized. 

 

Distribute Horizontally: 
The first and last object retain their position. The objects in between share the space so as to maintain equal 
horizontal spacing. 
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Arrange objects vertically 

 

Equal Vertical Distribution: 
The spacing between the first object and the second is used as a template for subsequent objects and customized. 

 

Distribute Vertically: 
The first and last object retain their position. The objects in between share the space so as to maintain equal 
vertical spacing. 

4.7.5.8 Changing the Level of Objects 

If an object is concealed by another object in the view, you can modify the level of the object in question. Select the 
desired object and then click on one of the options. 

If you would like to change an object's level by one position, select the following functions: 

 Forward One Level  

 Backward One Level  

If you would like to place the object on the first or last level of all of the objects, then select the following function: 

 In the Foreground  

 In the Background  

Alternatively, you can move an object in the object list to the desired level. This depicts how the objects are 
arranged on the layers. 

4.7.6 Actions and Effects on Book Pages 

Incorporating multimedia and interactive elements by adding actions and effects will turn your book pages into a 
didactically enhanced learning environment. You can choose from a wide variety of special effects to highlight 
specific steps and objects that are sure to capture and retain the learner’s attention. By doing so, you will help your 
users better focus on the important items that should be learned, and you will simultaneously promote sustainable 
learning by creating and fostering an enjoyable, interactive learning environment in which the user can explore, 
discover, and retain new information. 
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Object actions can be used to add interactive effects to individual objects. These actions can be triggered manually 
by the user or can be configured to run automatically. In addition, with special object actions, you can use actions to 
define and control certain effects. 

4.7.6.1 Object Actions 

You can define actions for book page objects in order to trigger the behavior of an entire book's or a book page’s 
display, such as having objects automatically appear on the book page or jumping to the next page. Object actions 
give authors greater flexibility in creating interactive content. 

The actions can be defined in the object editor, in which you will find an area that is also called Actions. Specific 
actions are displayed for each object that can be used in conjunction with them in book pages. 

The components of an object action 

An object action consists of an executable action, an object that should be affected via this action, and the behavior 
to be triggered. The available actions and behaviors depend on the type of object and can be used in a variety of 
ways. You will find more information on this step below (see Overview of the Actions and Behaviors). 

The following is an example of how to insert an action into an Image object:  
On Click > Text > Show 
When the user clicks on the image, the Text object that was selected will appear.  

Multiple behaviors assigned to one action 

You can assign as many behaviors to one individual action as you would like. To trigger multiple behaviors, simply 
click on the plus icon next to the dropdown box. This allows you, for example, to fade objects in and out. You can 
remove a behavior by clicking on the minus icon next to the dropdown box. 

The following section will give you an overview of the variety of object actions that are available for enhancing your 
book pages and will describe specific use cases. 

4.7.6.1.1 Fading Objects In and Out 

A fade over effect can be used to fade objects naturally and smoothly in and out. The following actions can be 
assigned to certain types of objects, in order to obtain the desired effect: 

• Animate In 

• Animate Out 

• Animate Toggle 

or 

• Fade In 

• Fade Out 

• Fade Toggle 

Depending on the object the subcategory Animation or Fade In / Fade Out might also be available. 
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 Note 
For Animate In or Fade In actions the assigned object has to be set to Hide. 

Subcategory Animation 

The subcategory Animation contains the following parameters: 

• Show Effect: 
Defines the effect type for showing the object.  

○ Fade In 

○ Fly In - From Left 

○ Fly In - From Right 

○ Fly In - From Top 

○ Fly In - From Bottom 

○ Zoom In 

○ Bounce In 

• Hide Effect: 
Defines the effect type for hiding the object.  

○ Fade Out 

○ Fly Out - To Left 

○ Fly Out - To Right 

○ Fly Out - To Top 

○ Fly Out - To Bottom 

○ Zoom Out 

○ Bounce Out 

• Duration: Show Effect: 
Determines the length of the show effect. The value is defined in seconds. 

• Duration: Hide Effect: 
Determines the length of the hide effect. The value is defined in seconds.  

Subcategory Fade In / Fade Out 

The subcategory Fade In / Fade Out contains the following parameters: 

• Fade In/Out: 
Specifies that a fade-in effect is displayed for fade-in/out. The effect is not displayed when the setting is 
deactivated. 

• Fade In Duration: 
Determines the length of the fade-in. The value is defined in seconds.  

• Fade Out Duration: 
Determines the length of the fade-out. The value is defined in seconds.  
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4.7.6.1.2 Controlling Audio with Actions 

Actions can be assigned to individual buttons in order to control an Audio object. You can customize the functions 
to suit your specific needs. For example, you can define objects, for example, an image or a text field, to be used as 
a button. When the user clicks on the image or text button, you can define the button in such a way so that the 
corresponding audio file will automatically play. 

 Recommendation 
In the case where an Audio object should be controlled via a button, we recommend that you disable the Audio 
object’s setting Start automatically. This will allow the user to interact with the learning content and start the audio 
at the appropriate/desired time (for example, by clicking on a play button). Moreover, you should give your objects 
unique names upon inserting them into your book pages in order to create transparency and facilitate selecting 
and assigning them when creating your learning content. 

For more information, refer to the sections Overview of the Actions and Behaviors. 

Control actions 

To create an object to control an audio file, such as an image, proceed as follows: 

1. Insert and position your Image object to be used for the button. (More detailed information on objects is 
provided in a further section in this document.) 

2. From the subcategory Actions, you can define the specific actions that your Image object should execute.   

1. From the first dropdown list, select the Audio object that should be used for the action, for example, On 
Click. This will automatically create a link to the Audio object. 

2. From the second dropdown list, you can define the behavior, for example, Play. You will find a variety of 
audio behaviors listed here. 

3. You can now repeat these steps for any additional buttons that you would like to add. 

Actions in an Audio object 

Under the subcategory Actions, Audio objects can be used in combination with various object actions to control the 
audio file. 

For example, a button can be defined to switch back and forth between two different actions by clicking on it in 
order to control the audio file, just like with the standard mute/unmute or play/pause buttons. This changeover can 
be defined by inserting a second Image object and positioning this on top of the original image and then defining the 
image to fade in and out accordingly. The following is an example of how to create an Audio object for play/pause: 

• On play 
> image “pause” > show 
> image “play” > fade out 

• On pause 
> image “play” > show 
> image “Pause” > fade out 

To display or minimize the full list of behaviors to choose from for an action, click on the plus and minus icons and 
the list will appear. 
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4.7.6.1.3 Overview of the Actions and Behaviors 

The list gives you an overview about commonly used types of actions and behaviors. The available types and also 
further types depend on the used and linked elements. 

Actions 

Action Description 

On Click Describes the action that should be carried out when the object is clicked on. 

On Mouse Roll-Over 
Describes the action that should be carried out when the object is moused 
over. 

On Mouse Roll-Out 
Describes the action that should be carried out when the mouse rolls out of 
the object. 

On Show Describes the action that should be carried out when the object appears. 

On Hide Describes the action that should be carried out when the object disappears. 

On Visible 
Describes the action that should be carried out when the object is visible 
after fade in. 

On Hidden 
Describes the action that should be carried out when the object is hidden 
after fading out. 

On Play Describes the action that should be carried out when the object is playing. 

On Pause Describes the action that should be carried out when the object is paused. 

On Stop Describes the action that should be carried out when the object is stopped. 

On Finish Describes the action that should be carried out after the object has played. 

On Mute 
Describes the action that should be carried out when the sound is 
deactivated. 

On Unmute Describes the action that should be carried out when the sound is activated. 

On Volume Change Describes the action that should be carried out when the volume is changed. 
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Behaviors 

Behavior Object 

Show Shows the specified object after an action is executed. 

Hide Hides the specified object after an action is executed. 

Toggle 
Shows/hides the specified object after an action is 
executed. 

Fade In Fades in the specified object after an action is executed. 

Fade Out 
Fades out the specified object after an action is 
executed. 

Fade Toggle 
Toggles the fade in/ fade out of the specified object 
after an action is executed. 

View Link 
Views the link target of the specified object after an 
action is executed. 

4.7.6.2 Animation Objects 

Action objects can be used to add special effects and animation to your learning content to create motivating and 
interactive presentations for the learners. The action objects are found in the book page editor. Besides the basic 
actions that are available, you can define more complex actions for an object. You can influence an action’s 
behavior by configuring its settings to suit your individual needs. The objects in this case are “blank”, only serving 
as a definition for the actions and do not contain any content, such as text or images. 

 Recommendation 
Before creating an action object, you should become familiar with how actions work so that you can take 
advantage of their versatility. 

Modifying objects and their behaviors 

The following action objects are available in the book page editor: 

• Animation 

• Time Control 

• Object Visibility 

• Counter 

• Collector 
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4.7.6.2.1 Use Cases 

Action objects can be used in combination with additional book page objects, giving you a wide variety of use cases 
and plenty of room for your own creativity. The following examples will give you an idea of how action objects can be 
used: 

Animation 

Animations can be used to creatively highlight specific pieces of information. For example: 

• To attract the learner’s focus to a certain image, this image can be defined so that its size automatically 
increases when the book page is displayed. 

• Several objects can be grouped together and displayed in a smaller format to save space. The user can then 
individually click on the images to zoom in on them. In this way, the user can concentrate more on each 
individual image and the respective learning material as needed. 

• Mouse rollovers and rollouts can be used to add effects to text and important information to enhance the 
learning experience. The original state of the text will then be automatically restored. 

Time Control 

The Time Control allows you to define how long the action should take place: 

• You can use the Time control with images to create an automatic slide show in which the images automatically 
fade in and out. 

• You can sequentially start various animations to create complex processes and visualizations. 

• The gradual fading in and out of text allows you to optimally visualize a sequence of information. Such 
animated text is perfect for accompanying audio text, for example. 

Object Visibility 

The Object Visibility is ideal for sequentially selecting multiple objects. For example: 

• To create image galleries on book pages - the user can then click through the gallery at his own pace. 

• For visualizing process workflows in which individual steps can be selected. 

4.7.6.2.2 Considerations for the Creation 

When working with action objects, we recommend that you take the following guidelines into consideration prior to 
starting the creation process in order to be able to fully take advantage of their versatile functionality: 

• Before you begin, we suggest creating a storyboard to help you optimally plan which behaviors should be 
assigned to which actions and how the users should interact with them. 

• Do not go overboard with the number of effects per page. Try to limit the number so that the important 
information is highlighted, while simultaneously ensuring a transparent and user-friendly look and feel to each 
page. Simple effects, such as clicking on objects and automatically having content fade in and out can prove 
to be quite useful enhancements to your learning content as long as the page is not cluttered with so many 
animations and interactive elements that it would overwhelm the user. 
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• Always make sure you assign unique names to your objects (under the setting Name). This will make it easier 
for you when selecting objects and actions so that you can quickly find the one you are looking for. 

• When inserting animations, make sure you know which level the objects are on in order to avoid accidentally 
hiding them. On the other hand, when this technique is intentionally used, you can easily hide specific objects. 

• Animations that are used repeatedly throughout your book can be predefined on a book page template to save 
you time when creating a new book page with the same animation. 

4.7.6.2.3 Animation 

 

Animation objects allow you to change the position and size of your animations. The Animation object defines the 
final size and position for the animation. To adjust the animation's size, the Animation object can be proportionally 
scaled in height. 

Structure of an animation 

The following explains how an animation works: 

 

• Initial State 
The object to be animated (for example, an Image) is created with the same size and position as its initial 
state. 

• Final State 
When the animation is activated, the object will change to the size and position of the Animation object (red 
rectangle). 

Creating an animation 

The following is an example of how to create an animation: 

1. Create an Image object and position it as desired to serve as the initial position. 

2. Insert an Animation object (from the toolbar) and define its properties:   

1. Move the Animation object to the desired final position and adjust the frame size. If the object should be 
the same size as the image, you can enter the exact dimensions under Position. 

2. Name: 
Enter a unique name for the object to facilitate allocating actions at a later time. 

3. Target Object: 
Select the Image object as the Target Object.  
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4. Duration: 
Here you can define how long the animation should run. The value is calculated in seconds. 

3. The animation can be interactively triggered by the user or defined to run automatically by assigning actions 
to the animation. 
For each action, you have to select the Animation object from the first dropdown list, and the behavior Start 
from the second dropdown list.  
For example:   

○ Action on Click – the user clicks on an Image or Text object to start the animation 

○ Action after Loading – the animation automatically plays when a book page is opened  

○ Action after Timeout – a Time control object can be used so that the animation will automatically play 
after a defined period of time 

Once you have created your animation, you can test it out by clicking on the Preview button in the book page editor. 

Stopping an animation 

In addition to the behavior Start, you can also define the animation to automatically stop. Simply select the behavior 
Stop from the list. For example, you can add start and stop buttons to your animation by inserting and defining 
Image objects. 

Additional options 

• Easing: 
Easing effects the time duration of an object, allowing the animation a more effective and smoother transition. 
Easing can take place at the beginning, at the end or both. There are three types to distinguish between:   

○ Quadratic 

○ Cubic 

○ Sine 

• Show Debug Information: 
This setting allows an object’s status information to be displayed while the book page is playing. This will 
display additional information on the object’s action while it is being executed in test mode to give you more 
control over the action. 

• On Start (under Actions): 
When an animation starts, another action can be triggered simultaneously. For example, an additional 
animation can start, an audio file can play or a Text object can be displayed. This allows you to create 
relationships between the objects and learning content can be sequentially structured if desired. 

• On Stop (under Actions): 
An action can be defined to be executed when an animation stops. In contrast to the option Action after 
animation, this allows you to stop the animation at any time, thereby changing a button’s behavior, for 
example, a button can be defined to continue the animation. 

• On Finish (under Actions): 
Once an action has been completed, another action can be triggered, such as other animations or 
automatically jumping to the next page.  
To do so, select the desired object and the action to be allocated to it under Settings. 
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 Note 
When using images with transparency, clicking on the transparent area will trigger the animation. To prevent 
undesired actions from being performed by the user, we recommend using images without any transparency. 

 Recommendation 
If you would like to re-use an animation that you have already created, you can copy and insert the respective 
objects collectively in groups. The objects are automatically recreated and allocated without requiring any 
additional post-editing work required. 

4.7.6.2.4 Time Control 

 

A Time Control object allows you to precisely time your actions. Images can automatically fade in and out or 
animations can be combined to create sequences. 

 

To set up a Time Control: 

1. First create the object that you would like to start off with. This could be an animation, an Image object, or a 
similar object. 

2. From the toolbar, insert the Time Control object. 

3. Next, define the time intervals and the corresponding actions. 
To obtain a clear overview of your animation projects, we recommend that you arrange your objects and 
actions according to their time control settings in chronological order.   

1. Time: 
In this field, you can enter the length of time during which the action should be carried out. The value is 
calculated in seconds.  

  Note  
Time values are not automatically combined. If you would like to have multiple actions begin simultaneously, you 
have to manually summarize and enter the time values, for example, 20, 40, 60,... 

2. On Timeout: 
In this field, you can select the action that should be triggered once the defined period of time has run 
out.  
For example: Image -> Show, Animation -> Start 

4. In order to start a Time control, an action has to be triggered by the user. This can be a button, for example, 
that starts a series of images. For this example: Actions -> Action on Click -> Time Control -> Action Start. 
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4.7.6.2.5 Object Visibility 

 

With the help of the Object Visibility, you can fade objects in and out, one following another, which can be triggered 
by user actions. This allows the user, for example, to click through a series of images in any preferred order. 

 

To create an Object Visibility: 

1. Create your Image objects and position them as desired. 

2. Set all images to hidden except for the first one that should appear. This allows images to fade in one by one. 

3. From the toolbar, insert the Object Visibility and define its properties:   

1. Name: 
Enter a unique name here so that you can easily identify your Object Visibility when selecting it from the 
list at a later time. 

2. Object 1-10: 
Select the objects in the order in which they should appear, from 1-10. 

4. Next, successively select the Image objects in order to assign the Object Visibility to the images. Under 
Actions, you have to define an action for each individual image in order for it to be able to switch to the next 
image, for example, Action on Click. From the first dropdown list, choose the Object Visibility and from the 
second dropdown list, select Activate 1-10 for each object. 

Once you have created your Object Visibility, you can test it out by clicking on the Preview button from the book 
page editor. 

Additional options 

• Fade In/Out: 
This setting allows you to define a smooth transition effect for objects when they fade in and out. 

• Show Debug Information: 
This setting allows an object’s status information to be displayed while the book page is playing. This will 
display additional information on the object’s action while it is being executed in test mode to give you more 
control over the action.  
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4.7.6.2.6 Counter 

 

The Counter object allows you to specify a sequence of different actions. One or more objects can be used to trigger 
the actions of the Counter. With each action on a triggering object the Counter counts up or down and executes the 
specified actions. For the triggering object, you can specify, how many actions are required. 

For example, you can use the object to display a different image every time you click on a button. 

To create a Counter, proceed as follows: 

 Note 
The following instructions are only an example of how to use of the Counter object. 

 

1. Insert Image objects 

1. Create your Image objects. 
See also Image. 

2. Position the images as required. 

3. Set all images to hidden. This allows the images to fade in. 

2. Insert the Counter object 

1. Insert the Counter object from the toolbar. 
The object is inserted in the status bar. 

2. Specify the parameters for each count: 

1. Count: 
Enter the number of clicks required to show the object. 

2. On Count: 
Select an Image object from the first drop-down list. 
Select a behavior from the second drop-down list, for example, Animate In. 

 Recommendation 
To hide the previously shown Image object, you can specify also an Animate Out behavior for the object in the On 
Count parameter. 
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3. Start the Counter 

1. Insert an object from the toolbar, for example, a Shape. 

2. Design and position the object as required. 

3. Open the Actions subcategory.  

4. Specify an action parameter, for example, On Click.  

1. Select the Counter object from the first drop-down list. 

2. Select Count Up from the second drop-down list. 

 Recommendation 
You can assign the Count Up action to one or more objects. 

Resetting the counter 

You can allow the user to reset the current status of the Counter to the initial status. First, create a reset control and 
then specify which objects are hidden for the used Images objects. 

To create a reset control and a behavior for all required objects, proceed as follows: 

1. Insert an object as a reset control. 

2. Select the object. 
Specify the Reset action: 

1. Open the Actions subcategory. 

2. Activate the On Click parameter. 

3. Select the Counter object from the first drop-down list. 

4. Select Reset from the second drop-down list. 

3. Select the Counter object. 
Specify the Reset behavior: 

1. Activate the On Reset parameter. 

2. Select the Image object from the first drop-down list. 

3. Select Animate Out from the second drop-down list. 

4. Repeat this for all required objects. 

4.7.6.2.7 Collector 

 

The Collector object allows you to specify a sequence of different actions. You can use different objects to trigger 
the actions of the Collector. When executing an action on a triggering object the Collector executes the specified 
actions. One object can only be used once to trigger specified actions of the Collector. Afterwards, another object 
can be used to trigger the next actions. 

For example, you can use the object to display an image when you click on an assigned control. 

To create a Collector, proceed as follows: 
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 Note 
The following instructions are only an example of how to use of the Collector object. 

 

1. Insert Image objects 

1. Create your Image objects. 
See also Image. 

2. Position the images as required. 

3. Set all images to hidden. This allows the images to fade in. 

2. Insert the Collector object 

1. Insert the Collector object from the toolbar. 
The object is inserted in the status bar. 

2. Specify the parameters for each count: 

1. Count: 
Enter the number of clicks required to show the object. 

2. On Count: 
Select an Image object from the first drop-down list. 
Select a behavior from the second drop-down list., for example, Animate In. 

 Recommendation 
To hide the previously shown Image object, you can specify also an Animate Out behavior for object in the On 
Count parameter. 

3. Insert a button 

1. Insert an object from the toolbar, for example, a Shape. 

2. Design and position the object as desired. 

3. Open the Actions subcategory. 

4. Specify an action parameter, for example, On Click. 

1. Select the Collector object from the first drop-down list. 

2. Select Flag 1 - 10 from the second drop-down list. 

Using Flags 

The Flag specifies, that the Collector is started for a specific action. Specify for a different Flag from 1 to 10 each On 
Click action.  
Please note, that the number of the Flag does not indicate a specific On Count action. The On Click action of the 
objects can be executed in any order. 
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If you click on an object, the On Count action with the specified number of clicks (for example, first click) is 
executed. Afterwards the object with the specific Flag is deactivated. Click on another object to execute the next On 
Count action (for example, second click).  

You can use the same Flag (for example, Flag 1) for different objects. If an action has been used for a Flag, the other 
objects with the same Flag are deactivated. 

The use of the Flags allows you to create complex combinations and conditions to show or hide objects. 

Resetting the collector 

You can create a reset control, to allow the user to reset the current status of the Collector to the initial status. 

To create a reset control and a behavior for all required objects, proceed as follows: 

1. Insert an object as a reset control. 

2. Select the object. 
Specify the Reset behavior: 

1. Open the Actions subcategory. 

2. Activate the On Click parameter. 

3. Select the Collector object from the first drop-down list. 

4. Select Reset from the second drop-down list. 

3. Select the Collector object. 
Specify the Reset behavior: 

1. Activate the On Reset parameter. 

2. Select the Image object from the first drop-down list. 

3. Select Animate Out from the second drop-down list. 

4. Repeat this for all required objects. 

Additional options 

• Show Debug Information: 
This setting allows an object’s status information to be displayed while the book page is playing. This will 
display additional information on the object’s action while it is being executed in test mode to give you more 
control over the action. 

4.7.7 Books and Book Page View 

For the book pages view it is necessary to distinguish whether these pages were inserted in a book or placed 
individually. An individual book page is opened in the library view whereas a book is presented in the book reader. 
After they are selected, modes linked on a book page are opened in the trainer. 

 Note 
If you have inserted media files in a book page, then the corresponding playback application needs to be installed 
on the users' workstations so that these files can be displayed. 
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Books view 

Books that have been created are displayed in the book reader. This enables selection of, and scrolling within, 
pages. Once a book page has been called, objects in it can then be launched or opened so that they can be worked 
through. 

When a book is called in the library it is launched directly in the book reader. 

Book pages view 

Individual book pages are not viewed in the book reader as this is intended for scrolling through a number of pages. 
If you select an individual book page in the library it will be displayed directly in the learning content view. 

4.7.7.1 Preview in the Book Page Editor 

 

The Preview function exists in order to be able to view and use a book page during editing in the book page editor in 
the same way it is displayed to the student. If you select this in the toolbar, you will be able to test your book page's 
objects. These will then behave in the same way as they do when being presented in the library or book reader. 

In order to be able then to resume editing the objects, deactivate the button. 

4.7.8 Supported File Formats on Book Pages 

Media plug-in Supported file formats 

Audio, Page Sound *.mp3, *wav 

Video 
*.avi, *.m4v, *.mov, *.mp4, *.mpeg, *.mpg, *.qt, *.rm, 
*.wmv 

Image *.gif, *.jpg, *.png, *.bmp, *.jpeg, *.svg 

Document 
*.doc, *.docx, *.rtf, *.ppt, *.pptx, *.xls, *.xlsx, *.pdf, 
*.html, *.htm 
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4.7.8.1 Requirements for Video Formats 

The table gives you an overview of the supported video formats of SAP Enable Now and the possible operating 
systems and browsers: 

Formats  Windows 10 Apple Android 

Format Codec Desktop Mobile Safari / Webkit Webkit 

mp4 h264     

  mpeg4     

avi xvid     

  h264     

mpg mpeg2     

wmv wmv3     

  vc1     

mov       

qt       

 Supported 

 Unsupported 



SAP Enable Now Manager, Cloud Option 
Interface 

 
 CUSTOMER  179 

 

4.8 Editing Projects in Project Editor 

The project editor is used for editing the project's content. The project editor displays the screenshots and macros 
of the projects as well as settings and editing functions.  
You can edit projects of the type simulation and navigation. Each project type has individual macros and editing 
functions. In simulation projects you are able to record additional steps. 

Opening a project 

To open a project in the project editor: 

1. Choose a project in the project explorer's tree. 

2. Select Edit in the object editor. 

Further Information 

• Editing a Project 

• Editing Macros 

• Using the Project Editor 

4.8.1 Editing a Project 

Once a project has been recorded you can edit the content as well as add further macros and content. For example, 
to enhance the didactic benefit of the projects and promote a more diverse presentation of the content. 

 Recommendation 
Make sure to save the project at regular intervals by using the Save control in the toolbar. 

4.8.1.1 Positioning Highlights and Bubbles 

In the step view you can change the size and positioning of the bubbles and highlights as follows: 

Changing the position 

1. Select an object in the step view. 

2. A red line will appear around the object. Select the object again, this time holding the mouse button down. 

3. With the mouse button still pressed, drag the object to the desired position. 

4. Release the mouse button and the object is now positioned. 
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Changing the size 

1. Select an object in the step view. 

2. Dots appear around the object so that you can change its size. Select one of the dots and hold the mouse 
button down. 

3. With the mouse button still pressed, drag the dot inwards or outwards to the desired size. 

4. Release the mouse button to set the new size. 

Changing the bubble alignment 

1. Select an object in the step view. 

2. A square will appear at the spike of the bubble, which you can use to turn the object. With bubbles that do not 
have a spike, the square will appear in the middle of the bubble. Select the dot and hold the mouse button 
down. 

3. With the mouse button still pressed, pull the dot away from the bubble until you have reached the desired 
position. Pull the dot towards the middle of the bubble if you wish to hide the tip. 

4. Release the mouse button to set the new position. 

4.8.1.2 Adding a Step 

You are able to add new steps in your project. The steps can be used to add further macros. 

The Insert -> Add Step  function inserts a new empty step. The step is inserted behind the currently selected step 
in the thumbnail view. 

4.8.1.3 Form Structure 

The Form Structure function allows you to display forms realistically in practice mode or test mode. While a 
simulation is in progress, the user can fill in the interactions contained within the form structure in an individually 
chosen sequence and then confirm the inputs as a whole. This does not display a confirmation immediately after an 
action has been inputted but only once all actions have been performed. 

A Form Structure is made up as follows: 

• It is positioned under a Screen  macro. 

• It has a start and end macro. 

• The associated interactions are to be found between the two Form Structure macros. 

• A Mouse Action  can be used as confirmation action. 

At least two interactions should generally be available for a Form Structure.  
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Example Structure 

 Screen 

 Form Begin 

 Input Text 

 Select Single 

 Radio / Checkbox 

... 

 Mouse Action - used for confirmation 

 Form End 

4.8.1.3.1 Creating a Form Structure 

After recording a project, you can create a Form Structure in it: 

1. For the Form Structure the Screen  macros are to be combined in a step with the associated actions 
contained in the form. This is required as the Form Structure cannot be created in a way that spans steps.   

1. Select the Screen  macros belonging to the steps whose interactions are to be used for the Form 
Structure.  

2. Select Tools -> Bulk Changes -> Merge Selected Screens. 
The first macro Screen is retained and the others that are highlighted are deleted. The previous steps' 
macros are arranged in the merged step.  Now create the Form Structure.  

 Note 
A Mouse Action  macro is required as the last macro of a form structure in order to be able to complete the form 
correctly. For example, this can be an OK or dialog box Save button enabling the form inputs to be confirmed. 

2. Select the Screen macro of the merged step.  

3. Select Insert Structure Macro -> Create Form Structure . 

In the thumbnail view, you will now see that all of the step macros are incorporated within the Form Structure 
macros. 
Documentation macros contained within a step are also integrated into the form structure. But these do not affect 
the sequence of the simulation and the function of the form structure as they are only used for creating 
documentation. 
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4.8.1.3.2 Bubbles in Form Structure 

The bubble texts are presented in summary form in the Form Structure for the practice mode. This provides you 
with an overview that illustrates how to fill out a form and the linkages between the inputs. 

In demo mode and concurrent mode, the bubbles are displayed side by side as the processes are played back as a 
simulation meaning that there are no inputs by the user. 

The appearance of the bubbles can be edited in the Form End  macro. The individual texts accompanying the 
actions can be changed within the respective macros, as before. 

4.8.1.3.3 Removing a Form Structure 

If a Form Structure is no longer required in a project, it can be removed. Only the start and end macros of the Form 
Structure are deleted in the process; the remaining macros in the step are retained. 

 Note 
Do not remove the macros for the Form Structure using the Delete command to avoid errors in the project. Always 
remove the Form Structure using the corresponding functionality. 

This is how to remove the form structure: 

1. Select the Form Begin  or Form End  macro.  

2. Select Remove Form Structure  in the macro editor. 

4.8.1.4 Branches 

Using branches will allow the user to digress from the sequential path within a simulation. This gives the user much 
more flexibility and portrays a more realistic process workflow. Two or more branches can be added to a simulation 
so that the user has a choice of where to go to next. 

A branch consists of several macros: 

• A branch is positioned under the Screen  macro. 

• It needs a start and an end macro.  

• Between the start and end macro, there are two macros that contain actions leading to different workflows.  
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Example Structure 

 Screen 

 Branch Begin 

 Mouse Action 

 Mouse Action 

 Branch End 

 Note 
Projects with branches cannot be rerecorded. During rerecording a project will run through in a linear manner but 
branches can operate in a number of different ways that cannot automatically be followed. 
It is recommended to duplicate a project as backup, before creating the branch. The duplicate can be used for 
rerecording. 

4.8.1.4.1 Creating a Branch 

Once a project has been recorded, you can create a branch for it. To do so, proceed as follows: 

1. Screen  macros are combined into one step in which their corresponding actions should serve as buttons 
for the branches. This is important so that the buttons can be displayed properly on the page.   

1. Select the Screen  macros for the step for which the macros should be used for the branch. When 
doing so, make sure that these actions are located on the same application page.  

2. Select Tools -> Bulk Changes -> Merge Selected Screens. 
The first macro Screen will remain and all the other highlighted macros will be deleted. The macros for 
the existing step will then be merged into the step accordingly.  

2. Select the macro Screen for the merged step.  

3. Select Insert Structure Macro -> Create Branch . 
The Edit Branch dialog box is opened. 

4. For each action macro of the step specify a jump target. The order of the selection list corresponds with the 
order of the macros in the project. 
Select Ok. 

From the thumbnail view, you can see that all the macros for the step are integrated into the macros for the branch. 
All macros that have been assigned a branch target will have an arrow . When the mouse moves over the arrow, 
the corresponding step will be highlighted in blue in the thumbnail view and the name of the step will be displayed in 
a tool tip. 
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4.8.1.4.2 Editing a Branch 

Editing a branch target 

If you would like to change the target of your branch at a later time, you can open the editing dialog box by clicking 
on the button Edit Branch in the macro editor. Change the target for the respective actions and confirm the changes 
by selecting OK. 

Bubbles in a branch 

At the end of a mode, a summary of all the bubble text is displayed in one bubble within a branch. This serves as an 
overview of all the possible target steps. The individual text blocks are separated with an `or` to make it easier to 
differentiate between the different targets. 

The bubble's appearance can be edited in the macro Branch End . To do so, from the macro editor, set the Layout 
Selection to Advanced layout. The individual text blocks for the actions can be changed in the respective macro. 

4.8.1.4.3 Removing a Branch 

If a branch is no longer needed in a project, it can be removed. Only the starting and ending macros of the branch 
are deleted. The other macros will remain in the step. 

 Note 
Do not remove the macros for the branch by using the Delete command - this could cause errors in the project 
itself. Always remove a branch in accordance with its functionality. 

To remove a branch, proceed as follows: 

1. Select the macro Branch Begin  or Branch End .  

2. Select Remove Branch  in the macro editor. 

4.8.1.4.4 Branches in Documentation 

Branches will also be displayed as such in the documentation. A subheading will be inserted to indicate that there is 
a branch. Underneath the subheadings, there are additional actions which have been allocated links for the 
respective steps. 

Branches appear in Word, PDF, and HTML generated formats. Branches are displayed in the following types of 
documentation: standard documentation and work documents. 
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4.8.1.5 Playing a Mode 

You can play a simulation mode to preview the content of your project. The simulation is played back in trainer. 

• Project editor 
Select Play Mode in the toolbar to play the active editing mode. 

 Recommendation 
If you start the playback of a simulation from the project editor to check it, you can follow the progress of the 
playback by looking at the thumbnail view. This simplifies the localization of errors since it provides direct, visual 
identification of the corresponding macro and thus facilitates the user's orientation within the project. 

• Explorer 
Select a mode of your project and select Play  in object editor. 

4.8.2 Editing Macros 

A project contains macros, which specify the content and behavior of the project. Each macro has individual 
parameters which can be edited. 
Macros are created during recording of an application. You can insert further macros in your project to add content. 

The following chapters give you an overview about the available the macros. You will find information about general 
used parameters of the macros as well as specific parameters of each macro. 

Inserting a macro 

To insert a macro, proceed as follows: 

1. Select a macro in the thumbnail view. 

2. Choose a macro from the toolbar. 

3. For some macros a dialog box opens, which allows you to specify the content. 

The new macro will be inserted after the selected macro in the macro order of the thumbnail view. 

Removing a macro 

To remove a macro, select the macro in the thumbnail view and remove it by using Delete. 
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4.8.2.1 Special Macros 

The following section describes special macros, which can be inserted into simulations. 

Icon Name 

 Simulation Start 

 Simulation End 

 Intro Page 

 Intro Page Start Link 

 Imported Page 

 Form Structure 

 Branches 

 Jump to Step 

 Mode Change Start 

 Mode Change End 

 Text-to-Speech Override 

In the following chapters, you will find further information about the special macros. 
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4.8.2.1.1 Simulation Start 

 

This macro is required for the initialization of the simulation in the trainer. It is located at the beginning of a project. 
When using the recording, this macro is inserted automatically. 

Score 

The parameters Maximum Score and Required Score specify the points for the test mode. The values are calculated 
from the number of single actions (always 3 points) and the percentages that have been entered in the Explorer for 
the project. Use Update to automatic calculate and actualize the score. 

Task description 

A task may be displayed in a separate browser popup window in practice mode and test mode. This can be created 
in the Task Description subcategory and activated for the mode in question. 

The Generate Values for Task Description option is used to insert the values from the Input Text  and Select Single 
 macros into the task. This is of use, for example, so as to have the necessary data available when creating a user 

or logging in. 

The position of the task description window on the screen is set by the parameter Orientation. In addition, a 
background color for the window can be selected via Background. 

4.8.2.1.2 Simulation End 

 

This macro is used by the trainer to end the simulation correctly. It is located at the end of a project. When using the 
recording, this macro is inserted automatically. 

• Pause (seconds): 
The parameter defines the display duration of the last step during the playback of the simulation. 

Settings of the End Page 

Once a simulation is completed, an end page with a summary appears as well as the button to restart the 
simulation. 
The end page uses the preset that is defined in the Intro Page macro. 

The following parameters can be defined: 

• Show End Page: 
The parameter defines that the end page will be shown during playback. 

• Title End: 
The title will be shown for the relevant mode. 
Modes: demo mode, practice mode, test mode 
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• Description End: 
The description will be shown for the relevant mode. 
Modes: demo mode, practice mode, test mode passed, test mode failed 

For further information, refer also to the chapter Intro and End Pages. 

4.8.2.1.3 Intro Page 

 

The macro specifies that an intro page is shown in the simulation. It has to be included in the first step after the 
Simulation Start and the Intro Page Start Link macro. 

Parameters of the macro 

The following parameters are available: 

• Title: 
The parameter defines the title for the relevant mode. 
Modes: demo mode, practice mode, test mode 

• Description: 
The parameter defines the description for the relevant mode. 
Modes: demo mode, practice mode, test mode 

• Preset: 
The parameter defines the design of the start and end page. The available presets are part of the 
Configuration/Style resources. 

• Page Size (Advanced Layout): 
The parameter defines the page width and height in pixels. 

For further information, refer also to the chapter Intro and End Pages. 

4.8.2.1.4 Intro Page Start Link 

 

The macro defines a start link for the intro page. This makes it possible to jump to different steps in a complex 
simulation and to guide the learners. The link has to be included in the first step after the Simulation Start macro 
and before the Intro Page Start Link macro. To create several links, insert an Intro Page Start Link macro for each 
link. 

Parameters of the macro 

The following parameters are available: 

• Description: 
The parameter defines a description for the start link. 
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• Link Text: 
The parameter defines a text for the start link. 

• Target Step: 
The parameter defines a target for the start link. A step can be chosen from the drop-down-box. 

For further information, refer also to the chapter Intro and End Pages. 

4.8.2.1.5 Jump to Step 

 

This macro allows you to jump to a specific step in the simulation. The macro can be used to create alternative 
paths in a simulation. 

Parameters of the macro 

The following parameters are available: 

• Jump Target: 
Specifies the step for the jump. Select a step from the drop-down list. 

4.8.2.1.6 Mode Change 

The change of mode makes it possible, at a specific step, to switch to another mode while a mode is being played 
back. If the step was completed it switches back to the original mode. For example, while a demo mode is in 
progress, a step can be displayed as a test mode. This allows users to take an active part while viewing the 
simulation. 

Macros of a mode change 

There are two macros for the mode change available: 

 

Mode Change Start 
This macro forces a mode change when playing back the simulation in a certain mode. 

 

Mode Change End 
This macro terminates the mode change and changes back to the initial mode. 
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 Note 
A mode change can only be used within a step. Ensure that the Mode Change Start and Mode Change End macros 
are within the same step. 

Creating a mode change 

To create a mode change, proceed as follows: 

1. Select the Screen  macro for the step with the mode change. 

2. Insert the Mode Change Start macro using the Insert Special Macro toolbar. 

3. Select the Mode Change Start macro. 

4. Specify the target mode in the macro editor. 

5. Select the last macro of the step. 

6. Insert the Mode Change End macro using the Insert Special Macro toolbar.  

Removing a mode change 

To remove a mode change for a step, delete the Mode Change Start macro and the Mode Change End macro. 

4.8.2.1.7 Text-to-Speech Override 

 

You can use the Text-to-Speech Override macro to replace the prescribed spoken text for a step with a text of your 
own. 

Insert the Text-to-Speech Override macro in a step once you have converted the associated spoken text. The macro 
contains the bubble text as default spoken text. You can now change the text in accordance with your own ideas. 
Would you like to restore the original bubble text in the text box, then you can use the control Insert Text from 
Bubble to overwrite the current text with that. 

4.8.2.2 Interactions 

Interactions are used for the recording, display, and control of the simulation contents. They portray all the usual 
actions that a user can carry out in an application. 

Icon Name 

 Screen 

 Explanation 
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Icon Name 

 Mouse Action 

 Key Stroke 

 Input Text 

 Select Single 

 Radio / Checkbox 

In the following chapters, you will find further information about the interactions. 

 Note 
Keep in mind that, when inserting interactions manually, no object information is saved. If a new recording is to be 
made, the object is to be manually defined in its sequence or skipped. These can also not be used for SAP 
Companion for desktop projects. It is generally only recommended to create actions during a recording. 

4.8.2.2.1 Screen 

 

The Screen macro contains the recorded screenshot of the application. The macro always marks the beginning of 
each step, followed by the recorded actions. When using the recording, this macro is created together with every 
new step as soon as an action is executed. 

Parameters of the macro 

The following parameters are available: 

• Screen Title: 
Contains the recorded screen title of the application. 

• Page: 
Contains the recorded screenshot image of the application. 

 Recommendation 
If you want to edit the screenshot for the Screen macro, it is possible to open it in an external image editor. To do 

this, select Page -> Replace Image  -> External Editor... 
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4.8.2.2.2 Explanation 

 

The Explanation macro allows you to add further information to your project content. 

The macro can be inserted during recording or rerecording or from the toolbar in project editor. 

Parameters of the macro 

The following parameters are available: 

• Use Demo Bubble for Practice: 
To reduce editing time, activate the option to use the same text and settings of the demo mode for the bubble 
in practice mode. 

• Show Control (Simulation): 
Use the parameter to show navigation controls within a bubble. When activated, the simulation pauses and 
resumes when the Next button of the bubble is selected. 
The setting is recommended, if the bubble contains a long text to allow the user to read the text completely. 

Type icon 

A Type (Icon) can be assigned to the bubble, which can be selected from four different types. Each type is 
represented by an icon: 

Type Icon 

Info  

Remark  

Tip  

Warning  

The icons are also added to the documentation generated for a project. The images of the icons are located in the 
resources trainer Style and Documentation Style. You can replace these with your own images. 
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4.8.2.2.3 Mouse Action 

 

The Mouse Action macro simulates a mouse action on a button or a link. 

Parameters of the macro 

The following parameters are available: 

• Hotkey: 
If the action can also be activated by a keyboard shortcut, then the corresponding key combination may be 
entered in Hotkey. The key names are separated by spaces, for example: ctrl k.  

• Action: 
Specifies, what type of action is to be carried out with the mouse. The action is set during recording. 

• Ctrl, Alt, Shift: 
Specifies a key used for performing the action. The parameter is set during recording. 

4.8.2.2.4 Key Stroke 

 

The Key Stroke macro simulates a keystroke or a keyboard combination. The macro can require the user to press a 
key or combination of keys to continue the simulation.  

Parameters of the macro 

The following parameters are available: 

• Hotkey: 
Specifies the keyboard shortcut. The key names are separated by spaces, for example: ctrl k.  

Defining a hotkey 

To define a hotkey, proceed as follows: 

1. Select the Hotkey parameter. 

2. Click on the Edit button. 
A dialog opens. 

3. Press the key or the keyboard combination, which should be inserted. 
The text field is filled automatically. 

4. Confirm the dialog with OK. 

The key or keyboard combination is entered in Hotkey. 
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4.8.2.2.5 Input Text 

 

The Input Text macro simulates text being entered into a specific text field. 

Parameters of the macro 

The following parameters are available: 

• Input Text: 
Contains the value entered during the recording. 

• End Value: 
Supports the inputting of text in multiline text boxes. Whereas only single line texts can be entered using the 
Input Text parameter, the End Value parameter generates word breaks, thus displaying the complete text in 
the text input box. 

• Confirm with: 
Specifies the manner in which the entry is to be confirmed. Three options are available: Confirm with Tab, 
Confirm with Enter and Confirm with Button. More than one option may be selected. 
If the option Confirm with Button has been selected, then it also needs to be assigned an object position. 
It is also possible to select an entry without confirming it. In this case, all three confirmation options must be 
disabled. 

 Note 
If the Confirmation parameter for inputting a text is altered or an input is read out without being confirmed, then 
you need to align the instruction in the practice bubble for confirming the input manually. 

• Set Focus (Simulation): 
Specifies whether the focus is automatically set on the appropriate input field within the simulation page 
during playback, or if the users should define it themselves, which is closer to the behavior of a live application. 

Using a regular expression 

A Regular Expression is an exactly defined search pattern for which a match is sought (pattern matching). When 
using a regular expression with an input field, the value entered during a simulation does not need to match exactly 
the value that was originally recorded. The value needs instead to correspond to a value described by the regular 
expression and is thus valid. The regular expression must be JavaScript compliant. Examples: 

any input:/.*/ 
not case-sensitive input: /input/i 
valid alternatives:/^kg$|^kilogram$|^kilogramme$/ 
five-digit number: /^[0-9]{5} $/ 
four-digit number with 2 decimal places:/^[0-9]{4}[,\.]{1}[0-9]{2} $/ 
date:/^[0-9]{1,2}(-|/|\.)[0-9]{1,2}(-|/|\.)([0-9]{4} $|[0-9]{2} $)/ 
currency: /^-?[0-9]+$|^(-?[0-9]+)?[,\.]{1}[-0-9]{1,2} $/ 
e-mail address: /.+@\[?[a-zA-Z0-9-\.]+\.([a-zA-Z]{2,4}|[0-9]{1,3})\]?/ 
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4.8.2.2.6 Select Single 

 

The Select Single macro simulates the selection of a list box or a selection list. 

Parameters of the macro 

The following parameters are available: 

• Selected Index: 
Contains the index number of the selected value. 

• Selected Value: 
Contains the value selected during the recording. 

4.8.2.2.7 Radio / Checkbox 

 

The Radio / Checkbox macro simulates the activation of a radio button or a checkbox. 

Parameters of the macro 

The following parameters are available: 

• Selected Value: 
Contains the value selected during the recording. 

4.8.2.3 Page Macros 

Page macros can be inserted into simulations, which will allow you to create simulations with greater flexibility. 
These can be positioned directly on screenshots, images, PowerPoint slides and book pages and can be activated 
for being displayed in a specific mode. In this way, simulations can be easily enriched with additional information, 
reference material and visual aids. 

The following section describes page macros, which can be inserted into simulations. 

Icon Name 

 Arrow 

 Shape 
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Icon Name 

 Highlight 

 Text Pop-Up 

 Image 

 Icon Link 

 Text Link 

 Book Page 

In the following chapters, you will find further information about the page macros. 

 Note 
Note that page macros cannot be used for documentation and can only be used for playing simulations. The only 
macro that can be used in combination with documentation is Book Page Link, which appears as a graphic image. 

4.8.2.3.1 Arrow 

 

The Arrow object is customizable. It creates a path for which you can choose from a variety of arrow heads. The 
arrow's length, position and direction can be modified as desired. 

Positioning a path point 

There are path points at the beginning and end of an arrow that allow you to adjust its length and direction. Select 
one of the points and drag and drop it to the desired position on the book page. 

Defining an arrow 

An arrow object can be customized as follows: 

• Color: 
Specifies the arrow's color. Select the color preview to open the Color Selection dialog box. 
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• Thickness: 
Specifies the arrow's thickness. The value is given in pixels. 

• Arrow Head 1 & 2: 
Specifies the arrow's head for each side of the arrow. 
There are several types: 

Design Name 

 
None 

 
Standard  

 
Triangle - Hollow  

 
Triangle - Filled  

 
Diamond – Hollow  

 
Diamond – Filled 

 
Circle - Hollow 

 
Circle - Filled  

• Advanced (Advanced Layout): 
Specifies the width and the length of the arrow heads in relation to the arrow’s thickness. Enter a value 
between 2 and 20. 
The value defines how many times the length of the thickness should be expanded (for example, value 3 = 3x 
the arrow’s thickness). 
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4.8.2.3.2 Shape 

 

The Shape object displays a variety of shapes to choose from for the purpose of enhancing the visualization of 
learning content, process flows and sequences. Shape objects can be used in a variety of ways and can contain text. 

To insert a shape, select Insert Shape. A palette is opened in which you can select a shape type and an orientation. 
For more information, refer to the section on Shapes Overview. You can change the type with the Type and 
Orientation parameter. 

Design 

• Shape Color: 
Specifies the shapes' color. Select the color preview to open the Color Selection dialog box. Select Transparent 

, if you do not want to use any color. 

• Shape Value: 
Specifies the shape's character. Values between 0 and 100 can be entered here. The outcome will vary 
depending on the type of shape selected. For example, you can change the width of an arrow or smooth the 
corners of a square.  
Note that this setting is not available for all shapes. For more information, refer to the section on Shapes 

Overview. 

You will find descriptions on additional settings under the section on Editing Parameters. 

Effects 

Under Effects, there is a variety of settings that allow you to define the behavior and design of a shape. 

• Gradient   

○ Shape Color (Gradient) 

○ Border Color (Gradient)  

• Design Roll-Over   

○ Shape color 

○ Shape Color (Gradient) 

○ Border color 

○ Border Color (Gradient)  

• Design Click   

○ Shape color 

○ Shape Color (Gradient) 

○ Border color 

○ Border Color (Gradient)  
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4.8.2.3.3 Highlight 

 

This macro makes it possible to place an additional highlight on a screenshot. The highlight is independent of a 
bubble and can be used to support an explanation. As only one highlight can ever be used for a macro, whereas it 
may be necessary for a number of highlight frames to describe a situation, this macro can be used in addition to the 
already existing highlight frame. 

Inserting and positioning a highlight 

1. In the thumbnail view, select the macro Page to which you would like to add your highlight. 

2. Then choose Insert -> Insert Page Macro -> Highlight. 
The default position for the highlight macro is directly under the macro Screen  to ensure that it is displayed 
throughout the entire duration of the step's recording. If the highlight should be displayed with a particular 
macro, you can simply drag the highlight in front of the desired macro. 

3. From the step view, you can now position (drag & drop) the highlight on the screenshot. To adjust the size of 
the highlight, choose one of the frame's points and with the left mouse button pressed, drag the frame to the 
desired size. Release the mouse button to confirm the changes. 

Macro options 

• Display in Mode: 
You can use the various options to define the mode in which the highlight is to be displayed. 

• Hide Highlight:  
Activate this parameter if you want to hide the highlight in the simulation.  
This setting has no impact on the highlight being displayed in the documentation if the parameter Show in 
Documentation is activated. 

• Object Name: 
You can use this parameter to specify a name for the object. If you have two Highlight macros in a step, you 
will need to change the name of one of them. In the event of highlights sharing the same name, only the 
second one in the sequence will be displayed. 

• Show in Documentation: 
If you activate this parameter, the highlight you have created will be displayed in the documentation. 

• Highlight Color: 
Defines the color of the highlight border. 

• Highlight Position (Documentation): 
Defines the position (left, top) and the size (width, height) of the highlight on the screenshot in pixel. 
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4.8.2.3.4 Text Pop-Up 

 

This function inserts a text pop-up which can be opened by a button. You can insert any text you like in this box as 
well as an image. 
The text pop-up can be formatted using the Text Pop-Up Position subcategory to adjust its size and position. 

Defining type and title 

• Type: 
Different types, differentiated by a corresponding icon, can be defined for displaying the textbox. Using 
different types enables you to highlight the text box content and present it more clearly to the user. 
The following types are available and can be selected using the parameter Type:   

○ Standard  

○ More Info  

○ Tip   

• Title: 
You can use the parameter Title to specify a title for the text box. If you do not want to display a title, you 
should leave the field blank. The default setting for the Standard type is no title whereas placeholders are 
displayed for the other types. 

Further options 

• Show on Roll-Over: 
This option allows you to define whether a text pop-up should appear when the mouse cursor rolls over the 
icon. When the mouse cursor rolls out of the icon, the text pop-up will hide again. The text pop-up behaves in 
the same way as a tooltip. 

• Fade In/Out: 
This parameter defines whether the text pop-up is displayed or hidden with a fading in effect when being 
opened or closed. Deactivate the setting if you wish to avoid this effect. 

• Hide Text Pop-Up in Editor: 
The default setting is for the text pop-up to be displayed in the book page editor. Activate the parameter to 
hide it for editing. If you would like to reinstate the text pop-up in the view, deactivate the setting. 

4.8.2.3.5 Image 

 

This object allows you to insert an image file to your book page. 

Inserting an image 

To insert an image, proceed as follows: 
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1. Select Insert Image in toolbar. 
The Insert Image from Workarea dialog box opens. 

2. Select an image in your workarea structure. 
or 
Use Insert File... to import an image. 

3. Select Ok. 

You can use Replace Image  to change the image file. 

See the chapter Supported File Formats on Book Pages for supported file formats. 

Parameters of the object 

The following parameters are available: 

• Image Roll-Over: 
You can use the Image Roll-Over option to insert an image that is shown when the mouse is moved over it. 

• Image Click: 
You can use the Image Click option to insert an image that is shown when the image is clicked on. 

• Keep Aspect Ratio:  
If this parameter is activated, the aspect ratio is retained when scaling an image. Deactivate this parameter if 
you want to be free to change the size of an image. 

• Zoom: 
The Zoom option allows you to zoom in and out of images on the book page. An icon will be inserted onto the 
image. By clicking on the icon, the image will be shown in its original size. This allows you to insert an image 
into the book page and save space when scaling it. 

4.8.2.3.6 Icon Link 

 

The Icon Link allows you to link content found in the work area or to create a link to an external source, such as a 
website. An icon will then be inserted, to which a link can then be assigned. The icon is customizable. You can insert 
an image as well as a tooltip for the target link. 

The design of the icon is based on the Style selected for the simulation that can be defined in the central 
configuration dialog in Authoring Settings -> General-> Page style. 

Defining an icon 

The look of the icon will depend on what book style has been chosen, which can be defined in the Style settings. 
For your defined target link, from the option Type, you can choose what kind of icon you would like to use: 

• Demo Mode  

• Practice Mode  

• Test Mode  

• Concurrent Mode  
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• Quiz  

• Book page  

• Book  

• Document  

Alternatively, your own icon can be inserted using the option Image. It is recommended that you use your own icon 
when linking to an external source or when the icon should not have the same look as the book style itself. 

4.8.2.3.7 Text Link 

 

Text Link is a text field to which you can add texts and links. The entire surface area is actually a button that can 
easily be linked to an external Internet page or an object from the workarea. This allows you to display additional 
information if desired. 

1. To create a link, go to Insert link... function. 

2. A dialog will then open in which you can specify a link or select an object from the workarea. 
A link to a web page or similar is to be entered in the text field under Available. This should be in the format 
http:// www... 

3. Confirm your entry by clicking on OK. 

When launched, the linked page is automatically opened in a new browser window. If you would like to open the 
page in the same window, you need to deactivate the setting Open in a new window. 
If the linked page or object from the Workarea is opened in a new window, you can define properties for displaying 
the browser window that has been opened. 

4.8.2.3.8 Book Page 

 

An existing book page can be inserted into a simulation with a link using the Book Page macro. Changes made to the 
book page also affect the link in the simulation. 
Insert a book page as follows: 

1. Use the toolbar to insert the Book Page macro into the project. You can select this macro from the drop-down 
list for the book page objects. 
When the macro is inserted, a new step is automatically created. 

2. You can then link the book page you want using the Book Page parameter. Select Edit Link...  to open the 
Edit Link dialog box where you can select the book page. 

3. You can activate the book page for the mode you want under Simulation. 

Keep in mind that the objects available on the book page cannot be edited. It is only possible to add additional 
objects within the project editor or to edit the book page directly in the book page editor. 
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4.8.2.4 Quiz Items 
There is a wide range of quiz items, which can be used to create interesting, multi-layered and at the same time 
comprehensive quizzes. 
The quiz items must be created and edited individually. When using quiz items, the main focus is on learner 
interaction – answering a quiz using text input boxes, dropdown boxes or moving objects using drag & drop. 

Quiz items are an optional group of items to be input manually. The following quiz items are available: 

Icon Name 

 Multiple Choice 

 Fill in the Fields 

 Fill in the Blanks 

 Matching 

 Connection 

 Sorting 

 Slide Control 

 Grid 

 Puzzle 

 Hotspot 

 Quiz Section 

 Quiz Evaluation 

In the following chapters, you will find further information about the quiz items. 
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4.8.2.4.1 Multiple Choice 

  

Using the Multiple Choice quiz item, you have the option of creating a question with one answer or multiple answers. 
The quiz can be solved by selecting the correct answer. 

Here, you have a number of design options available, for example, whether or not to create a question that is 
answerable with just one correct answer, with multiple answers or with apparent multiple answers. 

To create a Multiple Choice quiz item, proceed as follows: 

1. First enter the individual answering options into the Answer x parameter.  

2. Then specify the correct answer using the Answer Correct parameter. You can activate this parameter for a 
number of answers as well.  
If you flag more than one answer as being correct, the possible selections are displayed as checkboxes or 
alternatively as radio buttons.  

Settings 

Further settings can be chosen for this quiz item in the Options subcategory. 

• Shuffle Solutions: 
When the Shuffle Solutions setting has been activated the answers entered are mixed individually.  

• Force Multiple Choice: 
Enable this parameter if you do not immediately want to show the user that there is only one correct answer 
for a question for which there is only one possible response. This converts the input fields manually from radio 
button type to the checkbox type.  

Quiz item on book page 

For a Multiple Choice quiz item on a book page, further settings are available: 

• Design Controls and Design (Subcategories): 
The subcategories contain parameters to specify the appearance of the quiz item. 

4.8.2.4.2 Fill in the Fields 

  

With the Fill in the Fields quiz item, you can define a question with multiple answers. These answers should be 
entered as text inputs. 

The answer has to exactly match the string entered by the author as being the correct answer - if so much as one 
character is wrong then the answer is deemed to have been incorrectly answered. 

To create the quiz item, continue as follows: 

1. You can use the Answer x parameter to set one or more answers for this quiz item. 



SAP Enable Now Manager, Cloud Option 
Interface 

 
 CUSTOMER  205 

 

2. The Input Type parameter allows the display type to be defined with which the answers are to be input. 
Overview of the types with descriptions and examples: 

Type Description 

Text The answer can be entered in any way desired. 

Text (case sensitive) 
The answer must be entered with the same 
capitalization as in the predefined answer. 

Integer 

The answer must be entered as a whole number. Here, 
mathematical characters may also be used. 

For example: 1,1-3,<4 

Floating point number 

The answer must be entered as a floating point number 
where the dots can be defined as commas or dots. 
Mathematical signs may also be used here. 

For example: 1.1;1-3.4;<4,2 

Regular Expression 
The answer must be entered as a mathematical string. 
For example: (^term$) 

Comma separated list 

The answer must be entered as a list separated with 
commas. 

For example: Answer1,Answer2,Answer3 

The answer can be entered in any way desired. 

Only one answer can be selected from the list. If 
identical answers are contained in the list, each answer 
may only be entered once. 

Comma separated list (case sensitive) 
The answer must be entered with the same 
capitalization as in the predefined answer. 

 Note 
When creating the quiz item, the answers entered and the type selection should match functionally in order to 
allow an error-free entry. 

Quiz item on book page 

For a Fill in the Fields quiz item on a book page, further settings are available: 

• Design Controls and Design (Subcategories): 
The subcategories contain parameters to specify the appearance of the quiz item. 
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4.8.2.4.3 Fill in the Blanks 

  

With the Fill in the Blanks quiz item, you can set a quiz that has text containing gaps to be filled in where words 
should be. 

To create one of these gap texts, proceed as follows: 

1. Enter a text you wish to create as a gap text.  

2. Define the gaps. 
Here you should enter 3 underscores as placeholders for the text that is to be entered. 
Corresponding to the Interaction type selected, the necessary input and selection options will be created in 
this position in the text. 
For example: This is my___text. 

3. Select an Interaction in which the answers are to be entered:   

○ Text Input  

○ Text Input (case sensitive)  

○ Dropdown List  

○ Drag & Drop   

4. Enter the answers. 
The order of the answers must correspond to the order of the defined gaps in the text. Accordingly, Answer 1 
refers to the first gap, Answer 2 to the second, and so on.  

5. There are differences when entering answers, depending on the type selected:  

○ When working with a Text Input, insert an answer in the answer field. 
You can also add a number of possible values for an answer. Separate the answers by using a comma. 
For example: Answer1,Answer2 

○ For Dropdown List and Drag & Drop options, it is necessary to define alternative answers for selection. 
That is why a number of possible answers are to be inserted in the response field. The answers are 
separated using a comma and the correct answer should be marked with an asterisk (*) before it. 

 Note 
To use a decimal value as answer, for example 1,5, add a backslash to escape the comma. 

For example: 1,1\,5,2,3,4 

 Note 
Make sure that the number of defined gaps matches the number of answers. 

Settings 

• Shuffle Solutions:  
Activate this setting to mix answers for the Drag & Drop and Dropdown List types into the corresponding 
selection for a gap.  

• Use Answer 1 Only: 
The use of just one answer list is possible in connection with the Dropdown List and Drag & Drop types if only 
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one list with possible answers is to be made available for the entire Fill in the Blanks, to which the answers 
must be allocated accordingly. The correct answers are marked with an asterisk (*). Each answer can only be 
used once for a gap. 

Quiz item on book page 

For a Fill in the Blanks quiz item on a book page, further settings are available: 

• Design Controls and Design (Subcategories): 
The subcategories contain parameters to specify the appearance of the quiz item. 

4.8.2.4.4 Matching 

  

You can create a quiz item in which texts or pictures must be matched to one another using the Matching quiz item. 

To create this quiz item, proceed as follows: 

1. Set up how the answers are to be matched. Select an Interaction:   

○ Drop-Down List: 
All available answers are listed out and must be chosen according to the question.  

○ Drag & Drop: 
All answers are available as fields in any order and are to be matched to the questions.  

2. Now define the matches. Here, a Question must be entered and the matching answer must be defined in the 
Answer field. 
To do this, you must enter the corresponding question / answer text into the text fields.  

 Note 
Make sure that the number of questions is equal to the number of answers and that an answer has been allocated 
to each question. 

Matching pictures 

Alternatively, you can add pictures to texts. This means that either the question and answer both contain pictures 
or only one of the two do. This can be done by inserting pictures using the HTML editor. You should proceed as 
follows: 

1. You may only use the drag & drop function for matching up pictures. Set up this functionality in the Type 
section.  

2. In the HTML editor of one of the questions or answers go to Insert Object  -> Insert Image File...  

3. Open the folder containing the picture you wish to insert and select the picture file. Confirm this with Open.  

4. In addition to the inserted picture, you can also add text.  

5. Repeat steps 2 and 3 accordingly for the next questions / answers of the quiz item.  
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 Note 
Do not use picture files that are too large (height, width) for Matching so that they display correctly and do not have 
to be cropped. 

 Recommendation 
Where there is an association between an image question and text response, the height of the text field in question 
aligns with that of the associated image. With images of different height, this results in different text field heights, 
which betrays the correct allocation of the answers. 
To align the text fields, you can modify the height of the text fields by using spaces (Return key). 

Quiz item on book page 

For a Matching quiz item on a book page, further settings are available: 

• Design Controls and Design (Subcategories): 
The subcategories contain parameters to specify the appearance of the quiz item. 

4.8.2.4.5 Connection 

  

This quiz item allows you to establish connections between questions and answers in text or image form. This 
involves creating a line to highlight the assignment of a selected answer to a question. 

To create a connection, select a question by clicking on it with the mouse. Then use the mouse again to specify the 
appropriate answer. 

The following is required to create a quiz item Connection: 

• Define the content to be connected. You can use both texts and images for this purpose. 
 
Enter a Question in the appropriate field and it a corresponding Answer.  

 Note 
Ensure that the number of questions matches the number of answers and that an answer is assigned to each 
question. 

When playing back the project, questions are presented in sequence and the answers out of sequence. 

Inserting images 

To define images as a question or answer, proceed as follows: 

1. In the HTML editor corresponding to a question or answer, go to the function Insert Object  -> Insert Image 
File...  

2. Call up the folder containing the image to be inserted and select the image file. Confirm this by clicking on 
Open.  
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3. You can now insert an additional text in the text box to accompany the inserted image.  

4. Repeat steps 2 and 3 for the other questions and answers in the quiz item.  

 Note 
Take care when Inserting images that you do not use image files that are too big (height, width) so that they can be 
displayed correctly when arranging the objects and do not have to be wrapped. 

Quiz item on book page 

For a Connection quiz item on a book page, further settings are available: 

• Design Controls and Design (Subcategories): 
The subcategories contain parameters to specify the appearance of the quiz item. 

4.8.2.4.6 Sorting 

  

Text responses can be sorted into the correct order using the Sorting quiz item. This quiz item can be used, for 
example, to ask questions about the order in which a process must be carried out where the individual steps must 
be sorted. 

To create a quiz item for sorting answers, proceed as follows: 

1. Use the Interaction option to select how the possible answers are to be displayed   

○ Drop Down List: 
All of the defined answers are displayed and should be selected accordingly.  

○ Drag & Drop: 
All answers are positioned as fields in any order and are to be sorted into the correct order.   

2. Select an Alignment in which the answer fields are to be sorted. Vertical and Horizontal can be chosen here.  

3. Set the answers. Enter these into the answer fields in the correct order. These answers will be mixed up on 
generation of the quiz. 
Depending on the number of answers, a corresponding drop down list or drag & drop field is created.  

Quiz item on book page 

For a Sorting quiz item on a book page, further settings are available: 

• Design Controls and Design (Subcategories): 
The subcategories contain parameters to specify the appearance of the quiz item. 
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4.8.2.4.7 Slide Control 

 

In a Slide Control quiz, you can define a range of numbers and answer value within this range. During playback, the 
learner has to choose an answer using the slide control. 

To create a slide control quiz, proceed as follows: 

1. Enter a numerical range for your slider in the Range parameter. Enter the start and end values as whole 
numbers separated by a hyphen. 
For example: 5-20 
Only one start and one end value can be defined. Additional values, for example, 2-5-9 are not permitted.  

2. Enter the Answer as a whole number. 
For example: 7 
You can only define one number as the Answer. It is not possible to select more than one number or define a 
number range for the answer. 

 Note 
Make sure that you only use integers. Using alternative numerical values or words is not permitted. 

Quiz item on book page 

For a Slide Control quiz item on a book page, further settings are available: 

• Start Value: 
Specifies a value, which is used as start position for the slider. 

• Design Controls and Design (Subcategories): 
The subcategories contain parameters to specify the appearance of the quiz item. 

4.8.2.4.8 Grid 

  

You can create tables in which questions and answers are placed opposite one another using the Grid quiz item. The 
questions can be answered by ticking one of the possible answer options. 

To create a Grid quiz item, you must create a table with rows and columns. To do so, proceed as follows: 

1. Set the possible answers in the Possible Answers section. The number of answers defines the number of 
columns. These are then displayed horizontally in the head of the table. 
When entering the answers, they must be separated by commas. 
For example: File,Edit,View,Insert  

2. Formulate the questions for the quiz item in the Question x parameter. These are then ordered vertically in the 
left rows.  
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3. You can define the answers in the Position of Correct Answer field. Here, a number value must be entered, 
which refers back to an answer from the Possible Answers parameter. 
For example, if you defined three answers and want one of your questions to have Answer 2 as the correct 
answer, then enter 2 into the answer field of the corresponding question.  

Settings  

• Shuffle Solutions: 
Activate this parameter to show the Possible Answers in any order. If this setting has been deactivated, the 
entries made under possible responses are shown in the same order in which they were input in the text field.  

Quiz item on book page 

For a Grid quiz item on a book page, further settings are available: 

• Design Controls and Design (Subcategories): 
The subcategories contain parameters to specify the appearance of the quiz item. 

4.8.2.4.9 Puzzle 

 

The Puzzle quiz item lets you create a puzzle from a picture file. The task is to reassemble the original picture 
correctly. 

Here, an uploaded picture is divided and the separate parts are mixed randomly. The degree of fragmentation can 
be set individually. The user can then use drag&drop to arrange the image components in the correct layout and 
thus generate the original image. 

The following shows you how to go about creating a Puzzle quiz item: 

1. Insert a picture file via the Image parameter. 
The file can be inserted using the Replace Image  command.  

 Note 
Note that quiz puzzles do not contain Media File parameters. The Media File area is used to display the Help Image 
and is therefore not available for use in other media files. 

2. After inserting the picture, the puzzle must be fragmented:   

○ Pieces Horizontal: 
The numerical value entered defines the number of parts into which the original image is subdivided 
horizontally.  

○ Pieces Vertical: 
The numerical value entered defines the number of parts into which the original image is subdivided 
vertically.  
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 Note 
If, when fragmenting the puzzle, two optically identical fields are found, it may be the case that it cannot be 
recognized which picture belongs to which field. For this reason, the different puzzle parts should be fragmented in 
such a way as no identical parts appear. 
Alternatively, it is possible to use an image processing program prior to this to change an optically identical picture 
by inserting a different-colored point, the size of a single pixel, into the picture. 

3. The composition of the puzzle can be set using the Interaction selection. A difference is discerned between the 
following two modes:   

○ Arrange in One Field 

○ Arrange in Second Field 

4. This selection allows you to determine whether the user works directly within the parts of the puzzle shown or 
is shown a second, empty field into which he drags the parts of the puzzle. 

 Note 
Note that the Puzzle quiz item is not produced as well on generation of the documentation as the option of doing 
puzzles is not possible in the corresponding document format. 

Further options 

• Show Help Image: 
The original picture can be shown next to the puzzle by using the Show Help Image parameter. This parameter 
is activated in the initial setup. 

Quiz item on book page 

For a Puzzle quiz item on a book page, further settings are available: 

• Fields Side by Side (Options subcategory): 
Specifies, the source field and the answer field are positioned side by side instead of below each other. The 
parameter is used for the Interaction type Arrange in Second Field. 

• Design (Subcategory): 
The subcategory contains parameters to specify the appearance of the quiz item.  

Help Image 

For a Puzzle on a book page, you can insert a help image as additional book page object. Use the Image object, to 
insert an image. 
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4.8.2.4.10 Hotspot 

 

With the Hotspot quiz item, a quiz can be created in which a pre-defined area on a picture must be specified by 
selecting it. 

To create Hotspot quiz item in a project, proceed as follows: 

1. Use the Image parameter to insert the corresponding picture file within whose area a section must be selected 
by the user.  
The file can be inserted using the Replace Image  command.   

2. After inserting the picture, it is necessary to define an area for selection. This area can only be defined in the 
shape of a rectangle. 
Select the Define Hotspot  function in the header of the macro editor.  

3. After selecting the Define Hotspot button a window will open in which the inserted picture will display. In it, you 
will find a red selection box whose size and position can be changed so that the picture section can be set.   

4. Now close the window with the Confirm Selection  button.  

Quiz item on book page 

To create a Hotspot quiz item on a book page, proceed as follows: 

1. Use the Image parameter to insert the required picture file. 
You can insert the file by using the Replace Image  command.   

2. Define an area for the hotspot selection. 
The highlight in the image box shows the current hotspot area. You can move the hotspot by drag and drop to 
another position and change the size by using the pointers on the highlighted border.  

For a Hotspot on a book page, further settings are available: 

• Hotspot: Left, Top: 
Specifies the position of the hotspot area. 

• Hotspot: Width, Height 
Specifies the size of the hotspot area. 

• Pin (Subcategory): 
The subcategory Pin offers parameters to define an individual pin to select the hotspot. You can insert an 
image. 
The image can also be a sprite image. This is an image file that combines many icons into one file. Using the 
Sprite parameters, you can define the image area of the pin on the file so that only this selection is shown. 

• Design (Subcategory): 
The subcategory contains parameters to specify the appearance of the quiz item.  
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4.8.2.5 Documentation Macros 

Documentation macros enable the compilation of extensive process documentation in addition to the recorded 
simulation. These macros are available to document the recorded project accordingly and to supplement the 
content relevant to the documentation, as well as to structure the content. 

Icon Name 

 Header Information 

 Partial Screenshot 

 Note 

 Description 

 Heading 

 Document Highlight 

 Arrow 

 Page Break 

 Document Properties 

 Revision Entry 

 Input Values 

 Logon Values 

In the following chapters, you will find further information about the documentation macros. 
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4.8.2.5.1 Header Information 

 

The Header Information macro allows you to insert a title as well as a description in the documentation. 
The macro can be used for single documents to create a document title without numbering. It is recommended to 
hide the project title in the documentation settings. 

Parameters of the macro 

The following parameters are available: 

• Title: 
You can enter a title. The title uses the text style Title in the Microsoft Word document. 

• Description: 
You can enter a description. The description can contain a subtitle or additional text and is formatted with the 
text style Paragraph in Microsoft Word. 

4.8.2.5.2 Transaction Code 

 

The Transaction Code refers specifically to recording SAP applications and is created when you select a transaction 
in SAP. 
When you generate documentation, a table with details of the transaction code and the menu path is created. 

Parameters of the macro 

The following parameters are available: 

• Transaction Code: 
Contains the recorded transaction code.  

• SAP Menu Path: 
You can enter an SAP menu path for the transaction to be able to find it in the SAP system menu.  

4.8.2.5.3 Partial Screenshot 

 

The Partial Screenshot macro allows you to create a screenshot of a specific area of the current screenshot. The 
partial screenshot can be used, to show an area of an application page in detail. 

Parameters of the macro 

The following parameters are available: 
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• Title: 
You can enter a title for the partial screenshot. 
When no caption has been entered, a consecutive image numbering system will be used in the documentation.  

• Screenshot: 
Contains the partial screenshot image. 

• Show Actions: 
Allows you to show the recorded actions as highlights on the screenshot. The parameter hides the actions on 
the screenshot of the Screen macro. 
With activated parameter you can use the partial screenshot instead of the Page macro for your 
documentation. 

Creating a partial screenshot 

To create a partial screenshot, proceed as follows: 

1. Select a Screen  macro in the thumbnail view. 

2. Insert the Partial Screenshot macro using the Insert Documentation Macro toolbar. 
An editing window with the screenshot is opened. 

3. Define the screenshot area. 
Adjust the selection border by moving the anchor points. 

4. Select Confirm Selection  to insert the screenshot. 

Editing the partial screenshot 

To edit a partial screenshot, select Manual Crop  in the object editor. Afterwards, the editing window with the 
screenshot of the Screen macro will be opened. You can change the selection border in the editor window. 

4.8.2.5.4 Note 

 

The Note macro allows you to insert important information with a highlighting icon in the documentation. 

Parameters of the macro 

The following parameters are available: 

• Text: 
Contains the note text for the macro. 

Type icon 

A Type (Icon) can be assigned to the note, which can be selected from four different types. Each type is represented 
by an icon: 
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Type Icon 

Info  

Remark  

Tip  

Warning  

The images of the icons are located in the resources trainer Style and Documentation Style. You can replace these 
with your own images. 

Creating a note 

To create a note, proceed as follows: 

1. Select a macro in the thumbnail view. 
The Note will be inserted after the selected macro 

2. Insert the Note macro using the Insert Documentation Macro toolbar. 
A dialog box is opened. 

3. Select a Type (Icon) and enter a Text. 

4. Select Ok to insert the macro. 

4.8.2.5.5 Description 

 

The Description macro allows you to insert additional information in the documentation.  

Parameters of the macro 

The following parameters are available: 

• Text: 
Contains the description text for the macro. 

• Reset Global Index Counter: 
Defines, that the numbering of the text start with '1'. Deactivate the option to use the numbering of all macros 
in the step consecutive. 
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Creating a description 

To create a description, proceed as follows: 

1. Select a macro in the thumbnail view. 
The Description will be inserted after the selected macro. 

2. Insert the Description macro using the Insert Documentation Macro toolbar. 
A dialog box is opened. 

3. Enter a Text. 

4. Select Ok to insert the macro. 

4.8.2.5.6 Heading 

 

The Heading macro allows you to insert a heading in the documentation. 
The macro can be used for single documents to create an individual document title or to insert an additional title in 
the project structure. 

 Recommendation 
Use this macro for single documents to create an additional heading. The macro is not recommended for 
compound document as the headings are based on the complete content structure. 

Parameters of the macro 

The following parameters are available: 

• Title: 
You can enter a title.  

• Format Template: 
Defines format template and heading level of the title. You can enter a value between 'h1' - 'h9'. 

Creating a heading 

To create a description, proceed as follows: 

1. Select a macro in the thumbnail view. 
The Heading will be inserted after the selected macro. 

2. Insert the Description macro using the Insert Documentation Macro toolbar. 
A dialog box is opened. 

3. Enter a Text. 

4. Select Ok to insert the macro. 
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4.8.2.5.7 Document Highlight 

 

The Document Highlight macro allows to highlight a specific area on the screenshot. 

Parameters of the macro 

The following parameters are available: 

• Text: 
You can enter additional information to the highlight. The text is sequentially numbered in the step. 

Creating a highlight 

To create a highlight, proceed as follows: 

1. Select a Screen macro in the thumbnail view. 

2. Insert the Document Highlight macro using the Insert Documentation Macro toolbar. 
An editing window with the screenshot is opened. 

3. Define the highlight area. 
Adjust the selection border by moving the anchor points. 

4. Select Confirm Selection  to insert the highlight. 

Editing the highlight 

To edit a highlight select Edit in the object editor. Afterwards, the editing window with the screenshot of the Page 
macro will be opened. You can change the selection border in the editor window. 

4.8.2.5.8 Arrow 

 

The arrow macro allows to mark a specific point on the screenshot. 

Parameters of the macro 

The following parameters are available: 

• Text: 
You can enter additional information to the arrow. An arrow icon is inserted in front of the text in the 
document.  

• Arrow Color: 
Specifies the color of the arrow.  

• Orientation: 
Specifies the orientation of the arrow. You can select an orientation from the drop-down list.  
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Creating an arrow 

To create an arrow, proceed as follows: 

1. Select a Screen macro in the thumbnail view. 

2. Insert the Arrow macro using the Insert Documentation Macro toolbar. 
An editing window with the screenshot is opened. 

3. Define the position and size of the arrow: 

1. Move the arrow by using drag&drop. 

2. Change the orientation by using the R key 

3. Adjust the selection border by moving the anchor points. 

4. Select Confirm Selection  to insert the arrow. 

Editing the arrow 

To edit an arrow select Edit in the object editor. Afterwards, the editing window with the screenshot of the Page 
macro will be opened. You can change the selection border as well as the orientation in the editor window. 

4.8.2.5.9 Page Break 

 

The Page Break macro inserts a page break in the documentation. This allows you to specify a page break at a 
specific position in the project structure. 

4.8.2.5.10 Document Properties 

 

The Document Properties macro assigns contents to field functions of a Microsoft Word document. This involves 
defining document properties and inserting these as field functions in the template. 

Parameters of the macro 

The following parameters are available: 

• Name: 
Contains the field function of the template. 

• Value: 
Contains the content for the field function to be displayed in the document. 
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Defining a field function in Microsoft Word 

A field function in Microsoft Word is defined as follows: 

1. Open the template where you want to insert the field function.  

2. Open the File -> Info page. 

3. Click on Properties -> Advanced Properties to open the properties dialog box. 

1. Navigate to the Custom tab.  

2. Insert the property into the Name field and the corresponding content into the Value field. You can use 
the same entry. 
The content will be replaced by the macro.  

3. Click on Add. 

4. Confirm the dialog box with OK. 

4. Then insert the field function into the template under Insert -> Quick Parts -> Field... 

1. Select the entry DocProperty as the Object Name. 

2. Select your defined field function as the Field Property.  

5. Now save your template.  

 Note 
If you insert the Document Properties macro for a BPP or Audit & Compliance document in your project, the field 
functions which are contained in the particular templates are read automatically and displayed in the macro editor. 
See also the chapter Process Documents. 

4.8.2.5.11 Revision Entry 

 

The Revision Entry macro allows you to document modifications in processes. For each modification a macro can be 
created and grouped below one another.  
All revision entries are created as revision history table in the documentation. 

Parameters of the macro 

The following parameters are available: 

• Revision Date: 
Indicates the date of the revision. 

• Change: 
Contains a description of the revision. 

• Changed by: 
Indicates the author of the revision. 

• Revision ID: 
Contains a reference number of the revision. 
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Documentation settings 

The revision history can be activated as fragment in Documentation Settings . In the subcategory Revision 
History, there are further settings: 

• Hide in Project Content: 
Defines, that the revision history only inserted as fragment. 
Deactivate the setting to display the revision history at the position as it is inserted in the project. 

• Sorting: 
Defines the sort order of the table if several revision entries have been created. 

4.8.2.5.12 Input Values 

 

The Input Values macro creates a table including all available entries of the Input Text macros in a project. As a 
result, they can, for example, be clearly subdivided at the beginning of a document to make them directly available 
in a work process. 

Parameters of the macro 

The following parameters are available: 

• Show Object Name: 
Inserts the content of the object name parameters as column in the table. 

• Show Value: 
Inserts the content of the value parameters as column in the table. 

• Show Bubble Text: 
Inserts the content of the bubble text parameters as column in the table. 

• Show ROC: 
Inserts the content of the ROC parameters as column in the table. 

• Show Description: 
Inserts the content of the description parameters as column in the table. 

Input values as fragment 

Instead of this macro, you can also insert the input values as fragment in Documentation Settings . In the 
subcategory Input Values, you can specify the content. 

4.8.2.5.13 Logon Values 

 

The Logon Values macro allows creating a table including the necessary data requested by a process to log on to 
the particular system. 
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Parameters of the macro 

The following parameters are available: 

• User ID: 
Defines the ID of the user. 

• Role: 
Defines the role of the user, for example, administrator, learner. 

• Application: 
Defines the application or system to log on to. 

• View: 
Defines the corresponding application page or view, which has to be selected for the process. 

4.8.2.6 Macro Parameters for Simulation Macros 

Each macro contains parameters, which define the design and the behavior for different use case like rerecording, 
playback, and documentation. You are able to adapt these parameters for a selected macro in the macro editor. 

The following section gives you an overview about the available parameters. Further information about a macro and 
specific macro parameter is available in the macro descriptions. 

 Note 
The available settings are specific for each macro. 

4.8.2.6.1 General Parameters 

In the macros, there are the following general parameters: 

• Comment: 
You can enter a general comment to assist editing in the Comment field. This is displayed in the thumbnail 
view in place of the macro text. 
You can amend the displayed comment as follows: 

○ Comment preceded by '+': Comment is appended to the macro text in brackets  

○ Comment preceded by '*': Comment is inserted in brackets in front of the macro text  

○ Comment preceded by '/': The comment is not displayed, only the macro text  

• Use Text from (Interaction macro): 
Specifies the text type used. This allows you to use different texts for demo mode and practice mode or to use 
the same text for both modes. 

○ Both Modes 

○ Demo Mode 

○ Practice Mode 

• Demo Text / Practice Text (Interaction macro): 
Contains the text for the macro to be displayed for a specific mode.  
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• Text: 
Contains the text for the macro to be displayed during playback. For some macros the parameter is mode-
specific.  

• Object Name (Interaction macro): 
Contains the name of the recorded control. 
The parameter is used in all interaction macros and is shown in the bubble text.  

• Object Image (Interaction macro): 
Contains the icon or an image of the recorded control. 
The parameter is used in all interaction macros and is shown in the bubble text. 

Editing object name and object image 

It may be necessary to edit the name or the image of the parameters. For example: 

• If a control in an application has changed but it is not worth rerecording a project. 

• If changes have been made to the highlights on a screenshot.  

Any change to the parameters is automatically incorporated in the bubble texts. 

• Editing an object name 
Change the name by entering a new name. 

• Editing an object image 
Select the Update Object Image  function in the macro editor. An editing window appears in which you can 
make the necessary changes to the icon. Drag the highlight to the desired position and confirm with Confirm 

. 
You can also use the Replace Image...  function to insert an image. The button opens an option menu with 
functions for creating or inserting an icon. Select the appropriate method. 

4.8.2.6.2 Subcategory: Bubble 

The parameters of the Demo Bubble and Practice Bubble subcategories are used for the display of the 
action macro's bubbles. 
The settings provide the possibility to define different appearances for the bubble in the different modes. 

• Style: 
Here you can choose which bubble style you would like to use. The bubble styles are saved in the Resources 

. 

• Width/Height: 
Specifies the size of the bubble in pixels.  

• Orientation: 
Here you can specify in which direction the tip of your bubble should be pointing. If you choose the option 
Center – the bubble will have no point and it will be positions in the middle of the chosen area. 

• Display Duration: 
Specifies, how long a bubble is visible during playback. The setting is defined in seconds.  

• Translate Manually: 
The option Translate Manually option ensures that customized bubble content is not replaced by text 
automatically generated by Automated Translation or a rerecording. The options are activated as soon as the 
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contents of a bubble is edited manually. In this case the contents can be exported by using Export Translatable 
(menu Tools -> Translation) in order to be translated manually by a translator. 

4.8.2.6.3 Subcategory: Simulation 

The subcategory Simulation contains parameters that specify the display of content during playback: 

• Highlight in Demo / Practice: 
Specifies, that the highlight for the control is displayed during playback. The setting is available for demo 
mode and practice mode. 

• Bubble in Demo / Practice: 
Specifies, that the bubble with the explanation is displayed during playback. The setting is available for demo 
mode and practice mode. 

• In Mode: 
Specifies, for which of the modes the object should be displayed during playback. 

4.8.2.6.4 Subcategory: Documentation 

The macro parameters required for documentation creation are found in the subcategory Documentation.  

• Show in Documentation: 
Specifies, whether this macro is to be taken into consideration during the creation of documentation. 
Disabling this parameter makes it possible to hide certain, specific actions described by macros in the 
documentation. 

Screen macro 

For the Screen  macros, there are the following parameters: 

• Show in Process: 
Specifies to show the step in the process flow of a documentation. 

• As Heading in Documentation: 
Specifies to use the Screen Title as heading in the documentation. 

• Image Size: 
Specifies the size of the screenshot in percentage. 

• Screenshot Position / Size: 
Shows the position and size of the screenshot.  

• Border Width: 
Puts a border at your defined pixel width around the screenshot. The standard color is white and can be 
changed in Documentation Settings. 
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Interaction macros 

For the interaction macros, there are the following parameters: 

• Highlight Position / Size: 
Shows the position and size of the highlight. 

 Recommendation 
Use the Document Highlight function to change the marker position. 

• Marker Orientation: 
Specifies the orientation of the marker on the screenshot. It is recommended to adapt the markers if the 
screenshot displays more than one marker. 

4.8.2.6.5 Subcategory: Rerecord 

The subcategory Rerecord contains parameters that are required for a rerecording. 

• Interactive: 
The option Interactive means that when a recording is being repeated, the rerecording will stop at this macro 
and manual recording of the macro will resume. Automatic rerecording will continue thereafter. This option is 
particularly important at those points in the project where it is known that the desired object for the action to 
be recorded is to be found in another position or a different object for the recording must be selected. 

 Note 
Do not change the parameters of the Object Type, Click Position, Recognition Method, and Object Key manually to 
allow a correct rerecording. 

4.8.2.6.6 Subcategory: Control 

The parameters describing how a control is displayed and executed in the project can be defined in the Control 
subcategory. 

• Position and Size: 
The parameter defines how a control is orientated in the screen view in relation to the upper left-hand corner 
as well as the width and height of the control. For editing the parameters select the Edit button to open an 
editing dialog box. 

Various individual parameters are available for the different interactions: 

• Macro Text Input: 
The color and text design of the Text input macro can be defined. It can also be defined whether the text entry 
is to be portrayed as a password. 

○ All Values: 
If control is a drop-down box is included, all of the drop-down box's options are saved in the parameter 
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All Values. The chosen entry is flagged with an asterisk {*}. While the project is being edited, the value 
can be changed by assigning the flag to the corresponding entry.  

• Macro Mouse Action: 
For the Mouse Action macro it is possible to define both the cursor type and the state of the button when it is 
clicked. 

• Macro Checkbox: 
For the Checkbox macro it is possible to define both the cursor type and the type of checkbox, whether the 
latter is to be used as a radio button. 

4.8.2.6.7 Subcategory: Advanced 

The subcategory Advanced contains the parameter: 

• Jump Target: 
Displays the selected jump target after the creation of a branch. You can select another target from the drop-
down list. 

4.8.2.7 SAP Companion Macros 

For SAP Companion projects, the following macros are available: 

Icon Name 

 Settings 

 Screen 

 Tile 

 Link Tile 

 Guided Tour Step 
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4.8.2.7.1 Settings 

 

The Settings macro is required for the initialization of the content and defines the project type. It is located at the 
beginning of a project. When using the recording, this macro is inserted automatically. 

Parameters of the macro 

The following parameters are available: 

• Type: 
Specifies the content type of the project. 

○ Context Help 

○ Guided Tour 

4.8.2.7.2 Screen 

 

The Screen macro defines the application page. 

Macro Parameters 

The macro contains the following parameters: 

• Title: 
Contains the name of the screen. The name of the application window is inserted during the recording. 

• Screenshot: 
Contains the screenshot of the recorded screen. 

Further Functions 

At the top of the macro editor, the following functions are available for the macro: 

•  Update Screen: 
This function allows you to update the recorded screen. 

•  Add Tile (Context Help): 
This function allows you to add a Tile for the Screen. The tile is added below the screen. 
See also Tile. 

•  Add Tile with Link (Context Help): 
This function allows you to add a Link Tile macro. 
See also Link Tile. 
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4.8.2.7.3 Tile 

 

The Tile macro allows you to add help information to be displayed in a tile. You can edit the title and the text of the 
tile in the carousel and the text of the bubble. 

The macro can be inserted using the macro editor's toolbar when a Screen  macro is selected. 

Parameters of the Macro 

The following parameters are available: 

• Tile Title: 
Contains the title of the bubble and the carousel tile. 

• Tile Text: 
Contains the text for the macro to be displayed in a tile of the carousel. 

• Bubble Text: 
Contains the text of the bubble. 

• Hotspot Size: 
Defines the size of the hotspot. Select a size from the dropdown list. 

• Bubble Size: 
Defines the size of the bubble. Select a size from the dropdown list. 

4.8.2.7.4 Link Tile 

 

The Link Tile macro allows you to add a link for further content in the tile. The content can be SAP Enable Now 
content, an external web page, or a document. Alternatively, you can display content in a lightbox as an overlay on 
the screen. 

The macro can be inserted using the macro editor's toolbar when a Screen  macro is selected. 

Parameters of the Macro 

The following parameters are available: 

• Tile Title: 
Contains the title of the bubble and the carousel tile. 

• Tile Text: 
Contains the text for the macro to be displayed in a tile of the carousel. 

• Link to: 
Specifies the link target. Select Edit Link...  to open the Edit Link dialog box. 
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• Show in Lightbox: 
Specifies that the linked object is displayed in an overlay on top of the application. Otherwise, it will open in a 
new browser window or tab. 

• Lightbox Size: 
Specifies the size of the lightbox. There are the following options: 

○ Full Screen 

○ Client Area 

○ User-Defined 

○ User-Defined (Overlay): 
The option allows you to specify a lightbox with a custom size, which will be displayed as an overlay of 
the application and the carousel. 

• Width, Height: 
Specifies the width and the height of the lightbox. The parameter is displayed for the option User-Defined. 

• Show as Splash Screen: 
Specifies that the linked object will be shown the first time in each session when the corresponding application 
is opened. Only the first tile with splash screen will be shown. 

4.8.2.7.5 Guided Tour Step 

 

The Guided Tour Step macro defines a step of the guided tour for a recorded control of the application. 

Parameters of the Macro 

The following parameters are available: 

• Bubble Title: 
Contains the title of the bubble. 

• Bubble Text: 
Contains the text of the bubble. 

• Show Arrow: 
Specifies that the bubble is shown with an arrow.  

• Center Bubble: 
Specifies that the bubble is shown in the center of the screen. If the setting is deactivated, the bubble is shown 
on the object.  

• Object Image (Advanced Layout): 
Contains the icon or an image of the recorded control. The object image will be shown in the bubble text. 
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4.8.2.8 SAP Companion for desktop Macros 

Fundamentally, there are the following macros for the SAP Companion for desktop projects: 

Icon Name 

 Context Help Style 

 Guided Tour Style 

 Application Context 

 Screen Context 

 Guided Tour Step 

 Mouse Action 

 Input Text 

 Select Single 

 Radio / Checkbox 

 Explanation 

 
Link Tile 

Available in SAP Companion mode 

 
Page Specifier 

See Recording a Page Specifier 
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Icon Name 

 
Include SAP Companion for desktop Project 

See Merging Projects 

4.8.2.8.1 Context Help Style 

 

Used for type: Context help 

The Context Help Style defines how the context help is displayed during playback. The macro is located in the first 
step of a project. 

The following settings are available: 

• Display Variant: 
The setting defines the variants for the object bubble. See also Variants of the Object Bubble. 
The following variants are available in the drop-down list:   

○ Icon 

○ Tooltip 

○ Bubble 

• Mini Icons Style: 
Specifies a style resource for the mini bubbles of the object bubbles. 

• Highlights: 
Specifies whether highlights are displayed for the objects. 

4.8.2.8.2 Guided Tour Style 

 

Used for type: Guided tour 

The Guided Tour Style defines how the guided tour is displayed during playback. The macro is located in the first 
step of a project. 

The following settings are available: 

• Bubble Style: 
Specifies the bubble style for displaying the object bubble. All available bubbles of the workarea are displayed 
in the dropdown list. 

• Mini Icons Style: 
Specifies a style resource for the mini bubbles of the object bubbles. 
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• Highlights: 
Specifies whether highlights are displayed for the objects. 

• Start from Arbitrary Step: 
Specifies that the guided tour is started from an arbitrary step and not from the beginning. 

• Focus Layer: 
Displays a gray layer to highlight the required control of the current step. 

• Restricted Mode: 
Specifies that only the current action can be executed. The other controls of the application page are blocked. 
The setting can be used if Focus Layer has been activated. 

• Interactive Mode: 
Specifies that the user has to navigate in the object bubble to the next step. No page recognition is done 
during playback. 

• Start Automatically: 
Specifies that this guided tour will be started automatically when SAP Companion for desktop is open, and the 
page key matches the current user screen for the first time. After that, the tour can be started manually from 
SAP Companion for desktop. 

Guided Tour Window 

The style and positioning of the window used for the guided tour can be customized in this area. 

This area contains the following settings: 

• Style: 
Specifies the style for displaying the window. 

• Alignment: 
Specifies the alignment of the window of the screen. Activate the Free option, to specify a Position. 

• Position: 
Specifies the position of the window on the screen. The values are specified in pixels and relate to the upper 
left-hand corner of the screen. 

• Size: 
Specifies the width and height of the window in pixels. If the amount of text to be displayed exceeds the area 
available in the window, a scrollbar appears automatically. 

Tour End 

The subcategory Tour End contains the information that is displayed at the end of a completed guided tour. 

• End Window: 
Specifies that a window is shown at the end of the guided tour. The window allows the user to close the guided 
tour manually. If this option is deactivated, the window is not shown and the guided tour closes automatically. 

• Text: 
You can enter the text to be displayed in the bubble in the text box. The text box is preset with a default text. 

• Next Project: 
You can select a project that is started after the completion of the current tour. The new tour starts 
immediately and no end bubble is displayed. 
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Advanced 

• Source: 
If a project was converted from a simulation, the parameter indicates the UID of the original project. 

4.8.2.8.3 Application Context 

 

The Application Context macro defines the application recorded for the SAP Companion for desktop project. The 
macro is always placed in the second step. 

Macro parameters 

The macro contains the following parameters: 

• Display Name: 
Defines the title which will be displayed during playback.  

• Program: 
Contains the name of the program as used by the operating system. The parameter can contain multiple 
entries separated by a semicolon. 

Further functions 

At the top of the macro editor, you will find the following functions for macros: 

•  Record Compatible Application: 
This function allows you to record an additional application. The executable name will be saved in the Program 
parameter. 

•  Insert Explanation: 
This function allows you to insert an Explanation macro with information about the application. 

4.8.2.8.4 Screen Context 

 

The Screen Context macro defines the application page. 

Macro parameters 

The macro contains the following parameters: 

• Screen Title: 
Contains the name of the application window. 

• Screenshot (Screen): 
Contains the screenshot of the recorded screen. 
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• Exclude from SAP Companion for desktop (Key): 
Specifies that the page key will not be considered for the context recognition process in the SAP Companion 
for desktop. 

• Activate Form: 
Specifies that the step is a form. All actions of the step are displayed in one bubble during playback. 

Further functions 

At the top of the macro editor, you will find the following functions for macros: 

•  Update Screen: 
This function allows you to update the recorded screen. 

•  Record Page Specifier: 
This function allows you to record a page specifier for the screen. See also the chapter Recording a Page 

Specifier. 

•  Record Object: 
This function allows you to record an object for the screen. 

•  Insert Explanation: 
This function allows you to insert an Explanation macro with information about the application. 

4.8.2.8.5 Guided Tour Step 

 

Used for type: guided tour 

The Guided Tour Step macro defines the individual steps for the guided tour. This macro can be used to define the 
tour sequence. This macro is found at the beginning of a step. 

The name of the guided tour step is defined in the Name field. This can be selected in the Next Step macro. 

4.8.2.8.6 Explanation 

 

The Explanation macro allows you to add further information to your project content. 

The macro can be inserted during recording or from the macro editor. See also the chapter Inserting an Explanation. 

Parameters of the macro 

The following parameters are available: 

• Text: 
Contains the bubble text. 
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• Type (Icon): 
A Type (Icon) can be assigned to the bubble, which can be selected from four different types. Each type is 
represented by an icon:  

Type Icon 

Info  

Remark  

Tip  

Warning  

• Force Display (Context help): 
Specifies, that the macro content is always displayed as instant help, even if instant help is disabled during 
playback of SAP Companion for desktop. 

• Focus Layer (Guided tour): 
Displays a gray layer to highlight the explanation.  

4.8.2.8.7 Link Tile 

 

The Link Tile macro is available in SAP Companion mode and allows you to add external links or content to the SAP 
Companion for desktop. It can be videos or PDF documents with further information or links to an external FAQ. The 
linked content can be displayed in a separate content window or a new browser window or tab and can also be used 
as an announcement.  
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4.8.2.8.8 Properties of the Interaction Macros 

The macros for interactions are: 

 Mouse Action 

 Input Text 

 Select Single 

 Radio / Checkbox 

The interaction macros contain the following properties, which are used for the playback of SAP Companion for 
desktop project: 

General 

• Object Name: 
Contains the recorded name of the object. You can change the text in the parameter. 

• Object Image: 
Contains the recorded icon of the object. You can change the image by clicking on Replace Image . 

• Input Text: 
Contains the input value of a text field. You can change the value in the parameter. 

• Text: 
Contains the bubble text of the object. The bubble text is a text module from the dictionaries and can contain 
the object name, object image and input text. 

Guided Tour 

• Optional: 
This option specifies whether the step is optional for the user in a guided tour. 
During playback a different icon will be shown in the step list. If the control is not visible on the page or if the 
page is wrong the step will be skipped.  

• Focus Layer: 
Displays a gray layer to highlight the required control of the current step. 

Context Help 

• Display Variant (Advanced Layout): 
The setting defines the variants for the object bubble. See also Context Help Style. 
The following variants are available in the drop-down list:   
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○ Global: 
Uses the setting from Context Help Style  macro. 

○ Icon 

○ Tooltip 

○ Bubble 

Subcategories 

• Object Bubble: 
Contains settings for the style and the behavior of the object bubble. 
See also Subcategory: Object Bubble. 

• Highlights: 
Contains settings for the style of the highlight. 

 Recommendation 
The highlights of the macros are deactivated by default. To activate the highlights, use the setting Show Highlight. 

• Next Step (Guided Tour): 
Contains settings for jumping to the next guided tour step. 
See also Subcategory: Next Guided Tour Step. 

Further functions 

At the top of the macro editor, you will find the following functions for macros: 

• Update Object : 
This function allows you to update the object. 

4.8.3 Using the Project Editor 

The project editor has different components, which allow you to edit your project. The main components are: 

• Thumbnail view 

• Step view 

• Macro editor 

You will find further information in the following chapters. 

4.8.3.1 Thumbnail View 

The thumbnail view sequentially displays the steps with their screenshots and corresponding macros. When 
selecting a macro, the corresponding screenshot is displayed in the step view with its highlights and bubbles, and 
the macros settings are displayed in the macro editor. 
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Changing the display size 

The display size of the screenshots can be adjusted by changing the size of the thumbnail view of by using the 
mouse wheel with pressed Ctrl key. 

Changing the order 

The order of the macros or the steps can be changed using drag & drop. You can even move one or more macros 
within a step or all steps as a whole as well as assign new positions to one or more steps in the project. 

 Recommendation 
Changing the order of steps or macros always results in a subsequent change to the project itself. For this reason, 
you should make sure the project is still a coherent unit. 

4.8.3.2 Steps of a Project 

A project uses steps to organize the content in sections. Generally, a step contains a screen and an interaction 
macro and can contain further macros. All steps are numbered consecutively and have a step name. 

Steps are automatically inserted into the project during recording for each new screenshot. You can add further 
steps by using the menu entry Insert -> Add Step  or during recording. 

The order of the steps can be changed in the thumbnail view. A step can be previewed in step view.  

Basic attributes 

A step has the following attributes: 

• Name: 
Contains the name of the step. In general, the name of the application window is entered during recording. 
You can change the name for your content. 

• Translate Manually: 
Specifies, that the name will be used for translation when exporting a translation file. The parameter is 
activated when a name has been changed. 
You can activate the option manually to translate the name. 

Steps in simulation projects 

The step names are displayed in the progress display of the trainer during playback in demo mode. You can hide the 
step names in Playback Settings. 

• Show in Progress Display: 
Specifies, that the step is displayed as control in progress display of trainer bar. 

• Jump Target: 
Specifies, that the step can be used as jump target for creating a branch. 
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 Note 
Within a recorded project, the first step has a special status. It generally includes only the Simulation Start macro 
in order to properly initialize the project for playback. For this reason, it is never set as a Jump Target. 

The step names can also be used as chapter title in a generated documentation. Active the use of the step name in 
Documentation Settings. 

4.8.3.3 Step View 

The step view displays the screenshot of the Screen macro and the content of the macros for a step. The view 
allows you to edit the size and position of highlights and bubbles directly on the screenshot. 

4.8.3.3.1 Showing Bubbles 

For steps with more than one macro, all bubbles can also be viewed simultaneously. This facilitates positioning 
bubbles and ensures that other areas in the application are not hidden by the bubbles by accident. 

There are two options in the toolbar: 

○ Show Bubbles for Step  

○ Show Bubble for Macro  

4.8.3.3.2 Selecting an Edit Mode 

The edit mode specifies the displayed playback mode of the step view. The active edit mode is also used for the 
preview playback.  

The Edit Mode control in the toolbar allows you to select a mode for editing. 

4.8.3.3.3 Zoom 

The Zoom functions allow you to zoom into a screen or a page of the edit view. This makes it easier for you to edit 
and to position objects. 

The following functions are available in the editor toolbar: 

•  Zoom In: 
Zooms in to the screen.  

•  Zoom Out: 
Zooms out of the screen. 

•  Show Selection: 
Zooms to display the selected object in the editor view. 
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•  Zoom to Fit: 
Zooms to display the full screen in the editor view. 

•  Zoom to 100%: 
Zooms to display the screen with a size of 100% in the editor view. 

4.8.3.4 Macro Editor 

The parameters for a macro are displayed in the macro editor and can be edited there. Select a macro in thumbnail 
view to display the parameters. 

The parameters are divided into subcategories which you can open and close by clicking on the plus and minus 
symbol. At the top of the editor, there are additional functions for editing your macros. 

Activating a parameter 

The green button located in front of each setting indicates whether the parameter is active  or inactive . Select 
the button to activate or deactivate the parameter. 
If a parameter is deactivated, then the fallback value for the parameter is used. 

Selecting a layout 

A Layout Selection in the title bar allows you to show and hide detailed parameters for a macro. You can choose 
between Standard Layout and Advanced Layout. The parameters of the Advanced Layout are recommended for 
advanced users, who need a detailed set of parameters. 

In macros that contain text the HTML editor is opened when selecting the text box. 

4.8.3.5 Layouts 

You can choose a layout to organize your standard components in the project editor. Layout changes influence the 
thumbnail view, the step view, and the macro editor. The layouts make it possible for you to change the look of your 
project editor to fit your needs. 

The following layouts are available: 

• Horizontal Layout: 
The components are aligned horizontally.  

• Vertical Layout: 
The components are aligned vertically.  

• Divided Layout - 1: 
The thumbnails and steps are aligned side by side, with the macro editor below it.  

• Divided Layout - 2: 
The thumbnail view is displayed horizontally and the macro editor and the step view appear below next to one 
another.  
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• Divided Layout - 3: 
The thumbnail view is displayed horizontally and the macro editor and the step view appear below next to one 
another. 

4.8.3.6 HTML Editor 

The HTML editor allows you to create and to edit the text of your content. The text is created in HTML format. 

Select a text field to open the HTML editor in a pop-up window. 

4.8.3.6.1 Functions of the HTML Editor 

The HTML editor offers the following functions: 

Function Description 

Text styles   

 

Paragraph Style 

Contains the paragraph and list styles of the Text Styles. 

Select a style from the dropdown box to specify a style 
for a selected paragraph. 

 

Character Style 

Contains the character styles of the Text Styles. 

Select a style from the dropdown box to specify a style 
for selected text. 

 

Block Style 

Contains the block styles of the Text Styles. 

Select a style from the dropdown box to insert a block. 

 

Table Style 

Contains the table styles of the Text Styles. 

Select a style from the dropdown box to specify a style 
for a selected table. 

Text formatting and structure   

Font Type 

Contains a list with all the available fonts that are 
installed on your PC. 

Select a font type from the dropdown box to change the 
font type of a selected text. 

Font Size Contains a list with predefined font sizes. 
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Function Description 

Select a font size from the dropdown box to change the 
font size of a selected text. 

   

Bold / Italic / Underlined 

Changes the format of a text. 
Select a button to set or to remove the format of a 
selected text. 

 

Font Color 

Changes the color of a text. 

Select the button to open the Color Selection dialog box. 
Select a color to change the font color of a selected text. 

See chapter Color Selection Dialog Box. 

 

Remove Formatting 

Resets a text back to its original format. 

Select the button to reset the format for a selected text. 

  

Numbered List / Bulleted List 

Creates a list of the selected type for a paragraph. 

The list uses the default styles for bulleted and 
numbered lists. You can also select a list style from the 
Paragraph Styles. 

Select a button to set or to remove the list of a selected 
text. 

For numbered lists, you can define a start value. Double-
clicking a list opens a dialog to determine that value. 

   

Align Left / Center / Align Right 

Changes the alignment for a paragraph. 

Select a button to set or to remove the alignment of a 
selected text. 

  

Outdent / Indent 

Increases or decreases the indent for a paragraph. 

Select a button to indent a selected text. Select a button 
again to indent the text to the next level. 

Edit and insert controls   

 

Table Operations 

Opens a dropdown menu with functions to edit a table. 

 

Cell Operations 
Opens a dropdown menu with functions to edit cells. 
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Function Description 

 

Show/Hide Outline 

Shows the structure of the content as well as of 
borderless tables for editing. 

 

Insert Object 

Opens a dropdown menu with functions to insert objects 
in a text, for example, tables, links, placeholders, or 
images. 

Further controls   

  

Left to Right / Right to Left 

Toggles the text direction for a corresponding language. 

 

Toggle Background Color 

Switches the background color from yellow to grey to 
view and edit text better with lighter or darker font 
colors as needed. 

4.8.3.6.2 Using Tables 

You can insert tables into your content. A table uses a table style that can be specified in the Text Styles . 

Inserting a table 

To insert a table, proceed as follows: 

1. Select the position for your table in your text. 

2. Select Insert Object  -> Insert Table... 
The Insert Table dialog box is opened. 

3. Specify the following parameters: 

1. Columns: 
Enter the number of columns. 

2. Rows: 
Enter the number of rows. 

3. Alignment: 
Select a text alignment: 

• Auto 

• Left 

• Center 

• Right 

4. Width: 
Enter a value and select percent % or pixel px as unit. 



SAP Enable Now Manager, Cloud Option 
Interface 

 
 CUSTOMER  245 

 

5. Header: 
Select a header type: 

• No Header 

• Header Row 

• First Column 

• Header Row and First Column 

6. Table Style: 
Select a table style. The dropdown box shows the table styles of the Text Styles. 

4. Select OK.  

The table is inserted in your text. 

4.8.3.6.2.1 Editing a Table 

To edit a table, there are the following options: 

Updating a table 

To update the parameters of a table, proceed as follows: 

1. Select a table in your text. 

2. Select Table Operations  -> Update Table...  
The Update Table dialog box is opened. 

3. Edit the following parameters: 

1. Alignment: 
Select a text alignment. 

2. Width: 
Enter a value and select percent % or pixel px as unit. 

3. Table Style: 
Select a table style. 

4. Select OK. 

The table is changed. 

Changing or removing a table style 

To change or to remove a table style, proceed as follows: 

1. Select a table in your text. 

2. Select the Table Styles dropdown box: 

• Select another style to change the style. 

• Select None to remove the table style and to keep the text only. 

The style of the table is changed. 

Deleting a table 
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To delete a table, proceed as follows: 

 Note 
When deleting a table, the content of the table will also be deleted. 

1. Select a table in your text. 

2. Select Edit Table  -> Delete Table . 

The table is removed. 

Converting a table to text 

To convert a table to text, proceed as follows: 

1. Select a table in your text. 

2. Select Edit Table  -> Convert Table to Text . 

The table is removed and each text of a cell is inserted as paragraph. 

4.8.3.6.2.2 Editing Rows and Columns 

To edit rows and columns, there are the following options: 

Inserting a column or row 

To insert a column or row, proceed as follows: 

1. Select a cell in your table. 

2. Select Cell Operations . 

3. Select a menu entry:  

•  Insert Column Left 

•  Insert Column Right 

•  Insert Row Above 

•  Insert Row Below 

The column or row is inserted next to the selected cell. 

Duplicating a row or column 

To duplicate a column or row, proceed as follows: 

1. Select a cell in your table. 

2. Select Cell Operations . 

3. Select a menu entry:  

•  Duplicate Column 

•  Duplicate Row 

The column or row is inserted next to the selected cell and contains the text and configuration of the source. 
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Deleting a column or row 

To delete a column or row, proceed as follows: 

1. Select a cell in your table. 

2. Select Cell Operations . 

3. Select a menu entry: 

•  Delete Column 

•  Delete Row 

The column or row of the selected cell is deleted. 

4.8.3.6.2.3 Editing Cells 

To edit cells, there are the following options: 

Updating a cell 

To update the parameters of a cell, proceed as follows: 

1. Select a table in your text. 

2. Select Cell Operations  -> Update Cell...  
The Update Cell dialog box is opened. 

3. Edit the following parameters: 

• Column Width: 
Enter a value and select percent % or pixel px as unit. 

• Row Height: 
Enter a value and select percent % or pixel px as unit. 

• Cell Background 
Select Choose Color... to open the Color Selection dialog box. Select Transparent to remove the color. 

• Horizontal Alignment: 
Select a horizontal text alignment. 

• Vertical Alignment: 
Select a vertical text alignment. 

4. Select OK. 

The cell is changed. 

Merging cells 

To merge cells, proceed as follows: 

1. Select two or more cells of a table. 

2. Select Cell Operations  -> Merge Cells  

The cells are merged to one cell. 
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Splitting cells 

To split a cell, proceed as follows: 

1. Select a merged cell of a table. 

2. Select Cell Operations  -> Split Cell  

The merged cell is separated into the original cells. 

4.8.3.6.3 Inserting Objects 

The Insert Object menu allows you to insert additional objects into your text. 

You can insert the following objects: 

•  Table 

•  Link 

•  Placeholder 

•  Image or screenshot 

•  Video 

4.8.3.6.3.1 Link 

You can insert a link into your text or for an object in order to call up a website or an object from your workarea. 

Inserting a link 

To insert a link, proceed as follows: 

1. Select a text or a position in the HTML editor. 

2. Select Insert Object  -> Insert Link... . 
The Insert Link dialog box is opened. 

3. Select one of the options: 

• Current Object 

• Workarea 

• Free 

4. Select an object from the workarea tree. 
or 
Enter a link in the Link Target text field. 

5. Enter a tooltip in the Tooltip text field, if required. 

6. Enter or change the Display Text, if required. 

7. Confirm with OK. 
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Editing a link 

To edit a link, proceed as follows: 

1. Select a linked text in the HTML editor. 

2. Select Insert Object -> Edit Link... . 
The Insert Link dialog box is opened with the linked object or the entered link. 

3. Edit the link. 

4. Confirm with OK. 

Inserting a link to a step 

If you are working within a project, you can insert a link within the project to jump to another step: 

1. Select Insert Object -> Insert Step Link... . 
A Select Step dialog box is opened. 

2. Select a step from the dropdown box. 

3. Confirm with OK. 

Removing a link 

To remove a link, proceed as follows: 

1. Select a linked text in the HTML editor. 

2. Select Insert Object -> Remove Link . 

4.8.3.6.3.2 Placeholder 

The placeholder inserts a variable that is dynamically assigned to specific content. This allows you to reuse 
available content and to change information centrally. The inserted texts can be individually formatted. 

The following placeholders can be inserted:  

• Object Type: Name 

• Object Type: Description 

• Object Type: Short Description 

• Macro: Object Image (within project) 

• Macro: Object Name (within project) 

• Macro: Hotkey (within project) 

• Macro: Input Text (within project)  

• Book Page: Text-to-Speech Text 

You can only insert content from the objects themselves or the objects at the next higher level in the content 
structure as placeholders in this case.  
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Inserting a placeholder 

To insert a placeholder, proceed as follows:  

1. Select Insert Object  -> Insert Placeholder... . 
The Select Placeholder dialog box with the available placeholders is opened. 

2. Choose a placeholder. 

3. Select Insert. 

 Note 
If no content can be assigned to a placeholder, no content is displayed in the HTML editor. In this case, check the 
selected placeholder and the desired content. 

Editing a placeholder 

To edit a placeholder, proceed as follows: 

1. Select a placeholder in the HTML editor. 

2. Select Insert Object -> Edit Placeholder... . 
The Select Placeholder dialog box is opened with the inserted placeholder. 

3. Edit the placeholder. 

4. Select Insert. 

Inserting dictionary texts 

Dictionary texts can be inserted from the recording dictionary as placeholders. The texts are displayed in the 
activated object language. 
The placeholders are to be entered manually in the Placeholder dialog box. You can find the respective dictionary ID 
in the dialog box for editing dictionary texts.  

A placeholder should be written as follows: 

• Pure text:  

• HTML text:  

Inserting individual content 

In addition to the standard placeholders, you can also specify placeholders for specific objects. The respective UID 
of the object and an exclamation mark are to be added to the displayed placeholder variables in the text box. This 
should have the following form: 

• Standard:  

• Extended:  

4.8.3.6.3.3 Image 

You can insert images into your text to extend the content with further information. The following options are 
available: 
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•  Insert Image File... 
Allows you to insert an image that will be imported into your workarea. 

•  Insert Image from Workarea... 
Allows you to insert an image that is available in your workarea. 

Inserting an image 

To insert an image, proceed as follows: 

1. Select a position in the HTML editor. 

2. Select Insert Object  -> Insert Image...  or Insert Image from Workarea . 

• Insert Image from Workarea 
The Insert Image from Workarea dialog box is opened. Select one of the options: 

• Current Object 
Select an image from the current selected object. 

• Workarea 
Select an image from the workarea tree. 

• Insert File... 
Use the option to import an image into your content object. 

• Insert Image 
The Insert Image dialog box is opened. 

1. Select an image file. 

2. Select Open. 

3. The Insert Image dialog box is opened. 
In the dialog box you can specify how the image is inserted. Change the following settings: 

1. Source: 
Shows a preview of the selected image. 
You can use the Replace Image button to select another image. 

2. Size: 
Shows the size of the image. 
You can change the size in pixel (px) or in percent (%) for Width and Height. 

3. Margin: 
You can enter a margin to add more space between the image and the text field border as well as the 
other content. You can enter a value in pixels for Top, Right, Bottom, or Left. 

4. Float: 
You can specify if the text floats around the image. Select the position of the image in the text, Left or 
Right. 

5. Alternative Text: 
You can enter an alternative text, that is shown if no image can be displayed, and is also used for screen 
readers. 

6. Show Border: 
Select the option to display a border around the image. 

7. Enable Zoom: 
Select the option to allow zooming of the image if the image is smaller than the original size. 

4. Select OK to insert the image. 
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Editing an image 

To edit an image, proceed as follows: 

1. Select an image in the HTML editor. 

2. Select Insert Object -> Edit Image...  
The Insert Image dialog box is opened with the current parameters of the image. 

3. Edit the image. 

4. Confirm with OK. 

4.8.3.6.3.4 Screenshot 

You can create screenshots from various views to insert them into your text. The following options are available for 
creating a screenshot: 

•  Insert Screenshot of Window: 
Allows you to create a screenshot of an application window.  

•  Insert Screenshot of Object: 
Allows you to create a screenshot of an application object, for example, a toolbar or control. 

•  Insert Screenshot of Area: 
Allows you to create a screenshot of a specific area of your screen. This can be used to create a screenshot of 
parts of an application or for multiple applications. 

Inserting a screenshot 

To insert an image, proceed as follows: 

1. Select a position in the HTML editor. 

2. Select Insert Object  -> Insert Screenshot...  

• Insert Screenshot of Window 
By moving the mouse over the screen display, specific areas will be recognized and outlined in red. 
Select the desired outlined area.  

• Insert Screenshot of Object 
By moving the mouse over the screen display, specific objects will be recognized and outlined in red. 
Select the outlined object. 

• Insert Screenshot of Area 
With the mouse, pull the red frame over the desired area and release the mouse button.  

3. The Crop Image window is opened. 
The window shows the made screenshot and you can adjust as needed. 

1. Change the size of the selection border to crop the screenshot. 

2. Select Confirm Selection . 

4. The Insert Image dialog box is opened. 
In the dialog box, you can specify how the image is inserted. Change the following settings: 
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1. Source: 
Shows a preview of the selected image. 
You can use the Replace Image button to select another image. 

2. Size: 
Shows the size of the image. 
You can change the size in pixel (px) or in percent (%) for Width and Height. 

3. Margin: 
You can enter a margin to add more space between the image and the text field border as well as the 
other content. You can enter a value in pixels for Top, Right, Bottom, or Left. 

4. Float: 
You can specify if the text floats around the image. Select the position of the image in the text, Left or 
Right. 

5. Alternative Text: 
You can enter an alternative text, that is shown if no image can be displayed, and is also used for screen 
readers. 

6. Show Border: 
Select the option to display a border around the image. 

7. Enable Zoom: 
Select the option to allow zooming of the image if the image is smaller than the original size. 

5. Select OK to insert the image. 

4.8.3.6.3.5 Video 

The option Insert Object allows you to insert videos from your workarea into your text. 

Prerequisite 

To use a video, import it into your workarea before inserting the video in your text. 

Inserting a video 

To insert a video, proceed as follows: 

1. Select a position in the HTML editor. 

2. Select Insert Object  -> Insert Video... . 
The Insert Video dialog box is opened. 

3. Select the video source from the following options and confirm: 

• Current Object 
Select a video from the current selected object. 

• Workarea 
Select a video from the workarea tree. 

• Embed 
Enter an embedded link from a video streaming platform with the desired configurations. 

4. Depending on your selection, the Insert Video dialog box may be opened. 
In the dialog box, you can specify how the video is inserted. Change the following settings:: 
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1. Source: 
Shows the file of the selected video. 
You can use the Edit Link... button to select another video. 

2. Preview Image: 
You can insert an image that is shown as a preview before starting the video. 

3. Size: 
Shows the size of the video. 
You can change the size in pixels (px) or in percent (%) for Width and Height. 

4. Margin: 
You can enter a margin to add more space between the video and the text field border as well as the 
other content. You can enter a value in pixel for Top, Right, Bottom, or Left. 

5. Play Automatically: 
Allows you to start the video automatically after the content has been loaded. Deactivate the option if the 
user has to start the video manually. 

6. Show Controls: 
Allows you to show controls for controlling the video. 

7. Enable Zoom: 
Select the option to allow zooming of the video if the video is smaller than the original size. 

5. Select OK to insert the video. 

Editing videos 

To edit a video, proceed as follows: 

1. Select a video in the HTML editor. 

2. Select Insert Object -> Edit Video...  
The Insert Video dialog box is opened with the current parameters of the video. 

3. Edit the video. 

4. Confirm with OK. 

4.8.3.6.4 Pasting Texts and Images 

When pasting copied text or images into the HTML editor, in some cases it may be possible that the formatting is 
displayed incorrectly. The HTML editor is equipped with several options to prevent this from happening. Copy your 
text or image and click on the right mouse button in the HTML editor. The context menu option Paste in Format will 
appear with the following options: 

For inserting text: 

• Formatted Text – the formatting will be preserved  

• Unformatted Text - removes any existing formatting  

For inserting images: 

• Formatted Text – the formatting will be preserved  

• Bitmap Image – inserts the image as a bitmap  
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 Recommendation 
Since the HTML Editor displays text in HTML coding, a new paragraph (<p>...</p>) will be created by clicking on 

the Enter key, which should normally give you larger line spacing. If, however, you would like to create a line break 

(<br />), then click on the keys Shift + Enter. 

4.8.3.6.5 Searching for Text Strings 

If there are longer and more complex text strings in the HTML editor, there is a text search function to facilitate 
finding specific text strings. Select Search text to open the Search dialog box.. 

Dialog box for searching text 

A text field appears where you can enter one or more words to search for. The search function has several options 
to choose from to quicken the search: 

• Match whole word only: 
If this option is deactivated, possible matches will be shown directly during the search. If this option is 
activated, the results will be displayed only when the entire word is found in the text.  

• Highlight all matches: 
If this option is activated, all the matches found will be highlighted. If this option is deactivated, only the first 
match will be highlighted.  

• Match case: 
This defines whether the search should be case sensitive. If this option is activated, the search function will 
only find exact matches. If this option is deactivated, capital or lowercase letters are irrelevant for the search. 

The buttons Next and Previous allow you to switch between the displayed results. If no matches are found, a 
message will appear at the bottom of the dialog box. 

4.9 Settings 

The Settings section enables you to edit your personal user information and your individual settings. You can switch 
between the tabs User Info, User Settings, and Personal Data 

User info 

View and edit your user profile.  

Setting  Description  

Last name  Your last name. 

First name  Your first name. 

Middle names  Any other first names. 
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Setting  Description  

Email  

Enter your e-mail address in this field or change it if so 
required. 

Note: Ensure to have a valid mail address entered, since 
you won't be able to get any email notification without. 

Phone  
Enter your telephone number in this field or change it if 
so required. 

Interface language  
In the drop-down menu, select the language in which 
you would like the application interface to be presented. 

Change Password...  Opens a dialog where you can change your password. 

User settings 

Define individual options for your user account in the User Settings area. 

General user settings 

You can delete all of the settings defined for your user account by clicking on the Clear All button. This affects all of 
the settings available that have been saved for your user account, e.g., the status of your most recently viewed 
pages, your filters saved in the task overview and more. 

Workarea options 

Setting Explanation 

Show Save dialog to switch objects with unsaved changes 

Defines whether the complete Save dialog is displayed 
when closing an object with unsaved changes or the 
content changes should be saved without having to 
reenter allocation, status, and comments. 

Automatically return write access to the superordinate 
object when deleting an object 

Defines whether the write access to this superordinate 
object should be automatically returned after the object 
is deleted. 

Automatically obtain write access to the superordinate 
object when deleting an object 

Defines whether the write access to the superordinate 
object should be automatically obtained for this action 
when deleting an object. 

Confirm your settings with Save. 

Personal Data 

This tab provides the overview of all changes made to your personal data. You also see the text of the Data 
Protection and Privacy Statement that you haver agreed to. 

You can export Lesson Data as XLS, which will show you the overview of your learning progress.   

You can also Withdraw Privacy Statement Consent. 
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5 Important Disclaimers on Legal Aspects 

This document is for informational purposes only. Its content is subject to change without notice, and SAP does not 
warrant that it is error-free. SAP MAKES NO WARRANTIES, EXPRESS OR IMPLIED, OR OF MERCHANTABILITY, OR 
FITNESS FOR A PARTICULAR PURPOSE. 

Coding Samples 

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are 
not intended to be used in a productive system environment. The Code is only intended to better explain and 
visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness 
of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless 
damages were caused by SAP intentionally or by SAP's gross negligence. 

Accessibility 

The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of 
the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software 
products. SAP specifically disclaims any liability with respect to this document and no contractual obligations or 
commitments are formed either directly or indirectly by this document. 

Gender-Neutral Language 

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed 
directly with "you", or a gender-neutral noun (such as "sales person" or "working days") is used. If when referring to 
members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not 
exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the 
documentation remains comprehensible. 

Internet Hyperlinks 

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint 
about where to find related information. SAP does not warrant the availability and correctness of this related 
information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages 
caused by the use of related information unless damages have been caused by SAP's gross negligence or willful 
misconduct. Regarding link classification, see: http://help.sap.com/disclaimer. 

http://help.sap.com/disclaimer
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